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Labs 

Lab 1.3.8:  Getting to Know Windows 

Estimated Time: 10 Minutes 

Objective 

Upon completion of this lab, the student will have been introduced to the proper way of 
shutting down Windows and navigating the Windows interface, as well as using Windows 
Help features. 

Equipment 

The following equipment is required for this exercise: 

• Lab computer with Windows 98 installed 

Scenario 

In order to help a friend out with Windows, the student will need to become more familiar 
with the Windows Graphical User Interface (GUI). 

Procedures 

Knowing how to use the Windows interface will help in nearly any job today. Most 
computers in the workplace have a version of Microsoft Windows installed on them. To 
work in a Windows environment, the user should have a firm grasp of several skills. 
Examples include resizing windows, creating and deleting icons, working with files and 
folders, and navigating the Start button (Shutdown, Run, Search, Settings, Documents, 
and Programs). 

Step 1 

If the lab computer is not already on, boot it up now. If you are prompted for a login name 
and password when Windows has booted, use the username and password assigned by 
the instructor. 

Step 2 

At the Windows Desktop, become familiar with the Windows interface in order to make 
troubleshooting faster and easier. Take a minute to click the Start button and look 
through the items that are listed in the menu. 

What options are listed under the Find menu?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Step 3 

Try running the Calculator program by selecting Start > Programs > Accessories > 
Calculator. Enter a few simple test calculations to see how it works. Try using both the 
mouse and the numeric keypad. When finished, click the X on the top right corner of the 
Calculator program to close it. 

Step 4 

Now try the help system that is built into Windows. Help is organized into separate books, 
and includes a search feature so that specific topics can be located quickly. To begin, 
click on the Start button and then click Help. This will open a window with a list of 
categories that outline the major areas that Help covers. 

Click on the Search tab, and enter one or more words relating to the topic that needs 
research. Do a search for the word “resize”. 

After completing a search for “resize”, what topics does Help display?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

There is also an Index tab, which lists all help items alphabetically. 

Step 5 

There are different ways of resizing a window in order to minimize it or maximize it. In 
order to see more of a help item in one screen, resize the window. The fastest way to 
view a window in full screen is to click the Maximize button. The Maximize button is the 
middle button on the top right corner of the window. 

To return the window to its original size, click the Restore button. The Restore button 
replaces the Maximize button when the window is in full screen. 

 

    
 

To resize the window to a custom size, grab the edges or corners of a window by first 
moving the mouse cursor to the edge or corner of the window. When the double-arrow 
appears, click and hold the mouse button and drag the window to the desired size.  
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Step 6 

To properly shutdown Windows, click the Start button, and select Shut Down from the 
menu. Select Shut Down from the list and click the OK button. The computer should 
always be shutdown using this method. Important data that is stored in memory while the 
system is running needs to be written to the hard disk before turning off the computer. Do 
not turn the computer off until a message displays indicating that it is safe to do so. 
Newer operating systems will automatically turn off power when the shutdown process is 
complete. 

Troubleshooting 

The Windows Help feature is a valuable tool when the technician needs information on a 
specific topic. If there is something in Windows that the user needs to research, using the 
Help feature can answer a lot of questions. 

Reflection 

What is the proper way to shutdown Windows?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

Why is it important to shutdown Windows properly instead of just pressing the power 
button? 

________________________________________________________________________ 

________________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 1.5.3:  Boolean Operations 

Estimated Time: 25 Minutes 

Objective 

Upon completion of this lab, the student will have been introduced to the AND, OR, NOR, 
and NOT Boolean operations. The student will also be able to calculate the output of 
different combinations of Boolean operations based on input. 

Equipment 

This is a written exercise. No equipment is necessary. 

Scenario 

The student is given a circuit board diagram. In order to figure out what each logic gate 
does, the student must understand how Boolean operations function. 

Procedures 

This lab will help the student learn to work with Boolean operations. Computers use 
Boolean operations to make calculations based on inputs of 0 (OFF) and 1 (ON). 0s and 
1s are represented in computer microchips and the bus on the motherboard by the 
presence or absence of voltage. The student will perform some basic calculations using 
the AND, OR, NOR, and NOT Boolean operations to get a better idea of how computers 
work internally. Complex combinations of these operations take place constantly in 
computers within millionths of a second. 

Step 1 

The Boolean operations of AND, OR, NOR, and NOT work as follows: 

0 OR 0 is 0 0 AND 0 is 0 0 NOR 0 is 1 NOT 0 is 1 

0 OR 1 is 1 0 AND 1 is 0 0 NOR 1 is 0 NOT 1 is 0 

1 OR 0 is 1 1 AND 0 is 0 1 NOR 0 is 0  

1 OR 1 is 1 1 AND 1 is 1 1 NOR 1 is 0  

 
The corresponding “truth tables” allow a compact way to represent these operations: 

OR 0 1 AND 0 1 NOR 0 1 

0 0 1 0 0 0 0 1 0 

1 1 1 1 0 1 1 0 0 

 

Note: AND, OR, and NOR are called binary operations (not to be confused with binary 
numbers) because the operations require two inputs. NOT is called a unary operation 
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because it has only one input. 

Look at the following combination of Boolean operations and determine the output. 

(1 AND 0) OR (0 AND 1) 

Compute the operations in parentheses first. 1 AND 0 is 0. 0 AND 1 is 0. So the solutions 
is 0 OR 0, which is 0. 

As a second example, try to compute the following Boolean operations. 

NOT [(1 AND 0) NOR (0 OR 1)] AND 1 

Work from the inner parentheses toward the outer parentheses. Also, the NOT applies to 
the expression that follows it (the NOT does not apply to anything that appears after the 
“]”). So, following these instructions, the result is NOT [0 NOR 1] AND 1, which is 
equivalent to NOT [0] AND 1, which is the same as 1 AND 1. This gives the result of 1. 

Step 2 

For each of the following combinations of Boolean operations, compute the final output 
based on the rules for AND, OR, NOR, and NOT. Refer to the truth tables above for help 
on how to compute any given Boolean operation. 

Solve for the output. The answer should be a 0 or a 1. 

Input:  NOT (1 AND 0) AND 1 

Output:  _________________ 

Input:  1 NOR {NOT [0 OR (1 NOR 1)]}  

Output:  _________________ 

Input: 0 AND {1 AND [1 OR (0 NOR 0)] AND 0} (Remember to work left to right through 
the expression.) 

Output:  _________________ 

Input: 1 AND NOT {[0 OR (1 OR 0)] NOR [1 AND NOT (0)]} 

Output:  _________________ 

Troubleshooting 

As a PC Technician, understanding how data is stored in a computer can be a great 
troubleshooting tool.  

Reflection 

How are Boolean operations used in computer systems? 

__________________________________________________________________
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Lab 1.5.9:  Converting Numbers Overview 

Estimated Time: 25 Minutes 
 
Objective 

Upon completion of this lab, the student will be able to identify the places in binary and 
decimal numbers and know the value of each. Also, the student will work with powers of 
ten and relate them to decimal places, as well as work with powers of two and relate 
them to binary places. Finally, the student will manually convert between simple binary 
numbers and decimal numbers and describe the differences between binary and decimal 
number systems. 

Equipment 

This is a written lab exercise. No equipment is necessary. 

Scenario 

Having sharp skills in number systems will aid in a career as an IT professional. With the 
ability to convert numbers without the use of a calculator, the student will be able to solve 
problems that may arise quickly and easily. 

Procedures 

This lab will help the student learn to work with the binary number system. The student 
will convert binary numbers (Base 2) to decimal numbers (Base 10) and then from 
decimal to binary. Computers and networking equipment, such as routers, use binary 
numbers. A binary number is a series of BITS (short for Binary Digits) that are either ON 
(a binary 1) or OFF (a binary 0). They are encoded internally in the PC on microchips and 
on the computer motherboard bus as electrical voltages. Understanding binary numbers 
and how they relate to decimal numbers is critical to understanding how computers work 
internally. 

Step 1 

The decimal number system is based on powers of ten. This exercise will help to develop 
and understand how the decimal number system is constructed. With Base 10, the right-
most place has a value of one (as with Base 2). Each place moving to the left is valued 
ten times more. Ten to the zero power is one ( 1100 = ), 10 to the first power is 10 
( 10101 = ), 10 to the second power is 100 ( 1001010102 =×= ), ten to the third power 
is 1000 ( 1000103 = ), and so on. Just multiply the number in each place with the value 
of each place (for example, 1004104400 2 ×=×= ). Remember that any number 
(other than zero) to the zero power is one. 

The following chart shows how the decimal number system represents the number 
352,481. This will help in understanding the binary number system. 
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Exponent 105 104 103 102 101 100 

Expanded 100000 10000 1000 100 10 1 
Numeral 3 5 2 4 8 1 
 3 x 100,000 5 x 10,000 2 x 1,000 4 x 100 8 x 10 1 x 1 
 

The number 352,481, if read from left to right in expanded decimal form, is (3 x 100,000) 
+ (5 x 10,000) + (2 x 1,000) + (4 x 100) + (8 x 10) + (1 x 1), for a total of 352,481 (a six-
digit number).  

Here is another way to look at it that makes it easier to add up the decimal number 
values: 

Position of digit 
(from right) 
 

Value of bit position 
(10^X or ten to the 
power of) 

Number 
value from 0 
to 9 

Calculation Decimal Value 

1st Decimal Digit 100 or 1 1 1 x  1 1 

2nd Decimal Digit  101 or 10 8 8  x  10 80 

3rd Decimal Digit 102 or 100 4 4  x  100 400 

4th Decimal Digit 103 or 1,000 2 2  x  1,000 2,000 

5th Decimal Digit 104 or 10,000 5 5  x  10,000 52,000 

6th Decimal Digit 105 or 100,000 3 3  x  100,000 300,000 

Decimal Value (Total 
of 6 digits)    352,481 
 
Step 2 

Binary means “two” and each digit in a binary number can only have two values (0 or 1). 
Understanding Binary numbers is key to understanding how computers work. The value 
of each binary digit, or bit, is based on powers of two. 

This exercise will help develop an understanding of powers of two, which is what all 
computers and data communications use. With Base 2, the right-most place has a value 
of 1 (as with Base 10). Each place moving to the left is valued two times more. Two to the 
zero power is one ( 120 = ), two to the first power is two ( 221 = ), two to the second 
power is four ( 422 = ), two to the third power is eight ( 823 = ), and so on. Just multiply 
the number in each place (either a 0 or a 1) by the value of each place (for example, 

8128 3 ×== ) and add up the total. Remember that any number (except zero) to the 
zero power is one. 

Binary Number Conversion Example 

The following table shows the detailed calculations (starting from the right side) to convert 
the binary number 10011100 into a decimal number. 
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Position of digit 
(from right) 

Value of bit position 
(two to the power of) 

Is bit a One (on) 
or a Zero (off) 

Calculation Decimal Value 

1st Binary Digit 20 = 1 0 0 x 1 0 
2nd Binary Digit  21 = 2 0 0 x 2 0 
3rd Binary Digit 22 = 4 1 1 x 4 4 
4th Binary Digit 23 = 8 1 1 x 8 8 
5th Binary Digit 24 = 16 1 1 x 16 16 
6th Binary Digit 25 = 32 0 0 x 32 0 
7th Binary Digit 26 = 64 0 0 x 64 0 
8th Binary Digit 27 = 128 1 1 x 128 128 
Decimal Value. 
(Sum total of 8 bits)    156 

 

Step 3 

Look at the binary number bit status. If there is a 1 in a given position add the value 
shown. If there is a 0 in a given position then do not add it. 

Solve for the decimal value. 

Exponent 27 26 25 24 23 22 21 20 

Bit Position 8 7 6 5 4 3 2 1 
Value  128 64 32 16 8 4 2 1 
Binary Number Bit 1 0 0 1 1 1 0 0 

 

Decimal Value:  _____________________________________________________ 

Exponent 27 26 25 24 23 22 21 20 

Bit Position 8 7 6 5 4 3 2 1 
Value  128 64 32 16 8 4 2 1 
Binary number bit status 1 1 1 0 0 0 1 1 

 

Decimal Value:  _____________________________________________________ 

Exponent 27 26 25 24 23 22 21 20 

Bit Position 8 7 6 5 4 3 2 1 
Value  128 64 32 16 8 4 2 1 
Binary number bit status 0 1 1 1 0 0 0 0 

 

Decimal Value:  _____________________________________________________ 
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Exponent 27 26 25 24 23 22 21 20 

Bit Position 8 7 6 5 4 3 2 1 
Value  128 64 32 16 8 4 2 1 
Binary number bit status 1 1 0 1 1 0 1 0 

 

Decimal Value:  _____________________________________________________ 

Step 4 

Convert the decimal values of 209, 114, 58, and 165 to the binary equivalents. To do this, 
look at the decimal value and then subtract binary values starting from 128 (the highest 
value binary bit for these number). If the number is larger than 128 then put a 1 in the 128 
(or 72 ) column. Subtract 128 from the number and then see if there is 64 or greater left 
over. If there is, put a one there. Otherwise, put a zero and see if there is 32 or greater 
left over. Continue until all eight bits are defined as either a zero or a one. 

 
Exponent 27 26 25 24 23 22 21 20 

Bit Position 8 7 6 5 4 3 2 1 
Value  128 64 32 16 8 4 2 1 
Binary number bit status         

 

Binary Value of 209: __________________________________________________ 

 

Exponent 27 26 25 24 23 22 21 20 

Bit Position 8 7 6 5 4 3 2 1 
Value  128 64 32 16 8 4 2 1 
Binary number bit status         

 

Binary Value of 114:  __________________________________________________ 

 

Exponent 27 26 25 24 23 22 21 20 

Bit Position 8 7 6 5 4 3 2 1 
Value  128 64 32 16 8 4 2 1 
Binary number bit status  

 

Binary Value of 58:  __________________________________________________ 
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Exponent 27 26 25 24 23 22 21 20 

Bit Position 8 7 6 5 4 3 2 1 
Value  128 64 32 16 8 4 2 1 
Binary number bit status  

 

Binary Value of 165: __________________________________________________ 

Step 5 

Check the answers by converting the numbers back to decimal. 

Troubleshooting 

Learning how to calculate binary numbers without the use of a calculator is an important 
skill in the IT Industry. The ability to perform number conversions can save time, 
especially in the field where calculators are not always available. 

Reflection 

Using the system learned to solve decimal to binary conversion, convert the decimal 
number 255 to binary. 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 2.3.6:  Motherboard Identification 

Estimated time: 30 Minutes 
 
Objective 

This lab will focus on identifying motherboards, removing motherboards, replacing 
motherboards, and using the motherboard manuals to identify a number of the system 
components. 

Equipment 

The following equipment is required for this exercise: 

• A system board (either mounted in a case or not) 

• Internet access 

• Motherboard manuals 

• ID software or local vendor contact 

Scenario 

A student has just been hired by a PC repair center and has begun your training. PC 
technicians need to be able to remove and replace motherboards either in an upgrade 
situation or due to a motherboard failure. 

Procedures 

If the system board has been diagnosed as needing replacement, there are a few 
guidelines that must be followed. Place the system on an antistatic mat and use an 
antistatic wrist strap. Verify that the system power cord is not attached. 

All necessary safety precautions need to be followed carefully concerning power supplies 
and electrostatic discharge. 

Step 1 

Gain access to the motherboard. If the motherboard is installed in a case, remove the 
case cover. 

Step 2 

If needed, remove components and/or cabling to gain access to the motherboard 
manufacturer's name and ID number. Be sure to carefully record these connections so 
they can be properly replaced. 

Note: These numbers may be difficult to find and hard to read, so look carefully. As the 
student become familiar with different manufacturers, it will become easier. 

Due to variations in motherboards, not all of the following information may be available. 
On others, additional information may be available. Check with the instructor about the 
system. 
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Step 3 

Record the following information from the motherboard of the computer. 

Components Available? 
(Y/N) 

Name/ Type (if applicable) 

1. Motherboard Manufacturer    
2. Motherboard Model Number    
3. Form Factor (physical size and layout)    
4. Type of CPU Installed    
5. Types of CPUs Supported (socket or slot)    
6. Chipset    
7. BIOS Manufacturer    
8. BIOS Battery    
9. ISA or EISA (number and type)    
10. PCI (number and type)    
11. AGP or AGP Pro (number and type)    
12. Jumpers    
13. DIP settings    
 

Troubleshooting 

A quick check on the motherboard manufacturer’s website will provide information 
regarding the motherboard BIOS and whether there is an upgrade available. 

Reflection 

The ability to properly identify all the components of a motherboard will prove to be very 
useful when troubleshooting in the field. 

Where is the first place to look to determine the manufacturer of a motherboard? 

___________________________________________________________ 
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Lab 2.3.8:  Identifying ROM and BIOS Chips 

Estimated time: 30 Minutes 
 
Objective 

This lab will focus on the student’s ability to locate and identify the ROM chip, BIOS chip, 
and BIOS manufacturer on a motherboard. 

Equipment 

The following equipment is required for this exercise: 

• A complete motherboard 

• Motherboard manuals 

• Internet access for research 

Note: A functioning system is not necessary to complete this lab. Be sure to observe 
proper care concerning power supplies and ESD. 

Scenario 

A client from a few months ago recently purchased a used computer. The client wants to 
install an expansion card into the machine to add some video editing capabilities. Before 
purchasing an expansion card, the client wants to make sure that the BIOS will support it. 

Procedures 

BIOS – The Basic Input-Output System is a ROM chip that has built-in commands, which 
allow the system to power-up and perform a self-test of its hardware before turning over 
control to the operating system. 

ROM – Read-Only Memory, as its name implies, can be read, but not changed. It is used 
to store basic information the computer needs to operate (for example, the BIOS). 

Determine the manufacturer and version number of the BIOS. Research the BIOS 
manufacturer’s website to see if there are newer versions available. Also, examine the 
physical ROM chip to help answer the questions below.  

Step 1 

Describe the physical appearance of the ROM chip and its location on the board: 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 
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Step 2 

What type of BIOS is used? 

 
Manufacturer:  
Version/Type:  
Battery Type:  
Rewrite-able?  

 

Step 3 

If an Internet connection is available, visit the manufacture’s website and list the version 
number and any new features that are supported. 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 
 

Step 4 

Can the BIOS be upgraded? 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 

Step 5 

What are the steps that must be taken to upgrade the BIOS? 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 

 

Troubleshooting 

Use extreme caution when flashing the BIOS. Make sure to use the correct file and that it 
is not corrupt. If the BIOS is flashed with the incorrect BIOS type or with a corrupt file, the 
board may be rendered inoperable. 
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Reflection 

1. How many BIOS manufacturers are in the list? 

___________________________________________________________ 

___________________________________________________________ 

2. Why is the BIOS needed? 

___________________________________________________________ 

___________________________________________________________ 
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Lab 2.3.9:  Identifying Computer Expansion Slots 

Estimated time: 20 Minutes 

Objective 

Upon completion of this lab, the student will be able to identify safety issues, 
specifications, and components relating to expansion slots. The student will also be able 
to list the advantages and disadvantages of each expansion slot. 

Equipment 

The following equipment is required for this exercise: 

• Motherboard and motherboard manuals 

• Expansion cards 

• Internet access for research 

Scenario 

Bob has purchased a used computer and is trying to determine what type of video card 
and other expansion cards can be installed. Help Bob figure out what is currently installed 
so that he can make an educated decision when he is ready to buy new expansion cards. 

Procedures 

An expansion slot is a long, thin, socket connection, located on a motherboard or riser 
board, which allows various cards to be added to a computer. These cards may include 
devices such as modems, sound cards, and network interface cards (NICs). Expansion 
slots allow the life of a computer to be extended, since new technology can be added as 
it becomes available. 

Verify that the power cord is disconnected and that the anti-static wrist strap is in place. 
Remove the system case from the computer. 

Step 1 

Locate the expansion slots on the motherboard (or riser card) and list them: 

1. 4. 

2. 5. 

3. 6. 
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Step 2 

Using the available resources, identify any expansion cards that are installed: 

1. 4. 

2. 5. 

3. 6. 

 
Troubleshooting 

Occasionally when a PC is shipped from one location to another, an expansion card may 
become unseated. Verify that all expansion cards are properly seated as well as all 
connectors properly plugged in before turning the unit on. 

Reflection 

What type of expansion cards would be installed in a PCI slot? 

___________________________________________________________ 

___________________________________________________________ 

What is the speed difference between PCI and ISA expansion slots? 

___________________________________________________________ 

___________________________________________________________ 
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Lab 2.4.2:  Identifying RAM and RAM Sockets 

Estimated time: 40 Minutes 

Objective 

This lab will focus on the identification of various types of Random Access Memory 
(RAM) and RAM sockets.  

Equipment 

The following equipment is required for this exercise: 

• A functioning computer system with two DIMMS installed and the proper tools to 
remove the computer cover 

• Manual for the motherboard used in the computer 

• (Optional) RAM Tester. If unsure of the operation of the RAM tester, ask the 
instructor for further instruction. 

Scenario 

Fred would like to upgrade the amount of RAM in his PC, but he is not sure how to locate 
it or how to determine how much RAM is installed. Help him determine how much RAM 
he has so he can figure out how much more to buy. 

Procedure 

Random Access Memory is memory used by the CPU to store open files and active 
applications temporarily. RAM is volatile, meaning that any information stored in it is lost 
when the system is powered-down. RAM comes in small expansion board forms with 
varying numbers of edge connectors. The RAM boards (also called sticks) are made in 
30, 72, 168, or 184 pin configurations. They are referred to as SIMMs or DIMMs, 
depending on the chip density. Many times, the only information to be gained visually is 
the manufacturer’s name. This is why a quality RAM tester is a critical piece of diagnostic 
equipment for PC repair shops. 

Observe proper care concerning power supplies and ESD 

Step 1 

Boot the system and record the POST amount of RAM. 
_______________________ 

Step 2 

Shut down the system and follow all the safety steps in removing the cover of the 
computer. 
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Step 3 

After gaining access to the motherboard, note the position of the RAM slots and whether 
they are in use, making notes in the journal. 

SLOT TYPE:  
TOTAL NUMBER OF SLOTS:  
NUMBER OF SLOTS OPEN:  
TOTAL RAM CAPACITY  

 
Step 4 

Record the information about the installed RAM sticks in the table below. 

MANUFACTURER:  
TYPE:  
CAPACITY: (each)  
SPEED:  
TOTAL CAPACITY INSTALLED:  
POSITION:  

 
Step 5 

Refer to the motherboard manual or search the Internet for the type and range of RAM 
chips that can be installed on this computer. 

Step 6 

If there are two sticks of RAM installed, remove one of the RAM sticks, noting the location 
and orientation of the stick. 

Step 7 

Put the cover of the computer back on the computer and plug in the power cords. Restart 
the computer system. Note the POST-test RAM amount. ________________ 

Step 8 

Shut down the system and follow all the safety steps in removing the computer cover.  

Step 9 

Reinstall the RAM stick that was removed in Step 6. 

Step 10 

Put the cover of the computer back on the computer and plug in the power cords. Restart 
the computer system. Note the POST-test RAM amount. ________________ 

Step 11 

Reflect in the journal about any special considerations to be aware of as the RAM 
memory is installed. 
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Attach copies of any additional research material used in completing this worksheet 
before handing in this assignment. 

Troubleshooting 

Take extreme caution when working with RAM. ESD is one of the most common 
problems when working on computers. Make sure to have an antistatic wrist strap on at 
all times, and make sure to be properly grounded. The chips on a RAM module are built 
for 3.3 volts. If a static discharge is large enough to see a spark, it is 3000 volts. 

Reflection 

Was an antistatic wrist strap use while working with RAM modules? 

___________________________________________________________ 

What other types of RAM are there besides the type installed in the PC worked on? 

___________________________________________________________ 
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Lab 2.5.2:  Video Card Identification 

Estimated time: 35 Minutes 

Objective 

The major features and specifications of different video cards will be discussed in this lab. 
After completion of this lab, the student will be able to identify the video card by any 
markings on the card. These markings may include a manufacturer’s name or part 
number. Some cards may be identified only by the physical layout of the card. 

Equipment 

The following equipment is required for this exercise: 

• ESD wrist strap 

• Standard tool kit 

• Lab workstation with AGP video card installed 

• Internet access 

• Manufacturer manuals 

Scenario 

The student is an avid gamer and wishes to compare the features of all the video cards 
available. Since the latest and greatest video card is needed for the latest and greatest 
games, special attention has to be paid to the manufacturer and performance 
specifications of each video card. 

Procedures 

A video adapter, or card, is an expansion card that allows the computer to display images 
on a monitor. It also determines the monitor depth and resolution. The need for the video 
card is determined by the intended use of the system. For example, a system used for 
gaming will need a much more advanced card than one used for word processing. 

Step 1 

After removing the system case, remove the video card from the expansion slot. When 
working with video cards, like any other component on the inside of a computer, take 
special care to be grounded and make sure to use an antistatic wrist strap. If the video 
card is damaged, the computer will be useless until a new video card is installed.  

Research and supply the following information: 

Manufacturer:  
Model number:  
URL site:  
Key features:  
System requirements:  
Cost:  
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Terms 

Research the following terms using these and other Internet resources: 

• http://www.techweb.com/encyclopedia 

• http://www.webopedia.com/ 

AGP port: 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 

EDO RAM: 

___________________________________________________________ 

___________________________________________________________ 

Pixel: 

___________________________________________________________ 

___________________________________________________________ 

Refresh rate: 

___________________________________________________________ 

___________________________________________________________ 

Resolution: 

___________________________________________________________ 

___________________________________________________________ 

Troubleshooting 

When working with video cards, like any other component on the inside of a computer, 
take special care to be grounded and make sure to use an antistatic wrist strap. If the 
only video card is damaged, the computer will be useless until a new video card is 
installed. 

http://www.techweb.com/encyclopedia
http://aol.pcwebopedia.com/
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Reflection 

Did any of the video cards that were worked with have a heat sink or a fan on the 
Graphics Processing Unit (GPU)? 

___________________________________________________________ 

___________________________________________________________ 

Are video cards with a heat sink or fan on the GPU available? 

___________________________________________________________ 

Why would having a separate processor on a video card help performance? 

___________________________________________________________ 

___________________________________________________________ 
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Lab 3.3.4:  The Computer Case and Power Supply 

Estimated time: 45 Minutes 
 
Objective 

In this lab, identify the type of computer case to be used, the form factor of the unit, and 
the voltage selector switch on the power supply. The inventory of all the components that 
will be installed in the computer case will also be discussed. Finally, motherboard 
standoffs will be installed to prepare the case for the installation of the motherboard. 

Equipment 

The following equipment is required for this exercise: 

• ESD wrist strap 

• Tool kit and screws 

• Computer case with power supply 

• Motherboard standoffs and screws 

• Motherboard & manual 

• Devices that will not be installed yet, but are referenced: 

o CD-ROM, Sound Card, Modem, NIC, RAM, Hard Drive with IDE Cable, 
Floppy Drive with Cable, Mouse, Keyboard, Monitor 

Scenario 

The student is assembling a personal computer for a friend, and is ready to prepare the 
case for the installation of the motherboard. 

Procedures 

Be sure to wear the antistatic wrist strap during the entire installation process. One end 
should be looped snugly around the wrist, with the other end attached to an unpainted 
metallic part of the computer case. This will prevent electrostatic discharge, which can be 
extremely hazardous to computer devices. 

Step 1 

The first step in the assembly process is to create an inventory of all computer 
components that will be installed into the computer. 

Lay out the computer components that will be used in the labs for this module. 

Gather all the information necessary to fill out the inventory sheet below. 
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Computer 
Identification 

Name: ______________________ 
Number: _____________________ 

Case Number of 3.5” bays _____5.25” bays _____ 
Manufacturer: __________________ 

Motherboard Manufacturer:  __________________ 
Model: ________________________ 
Bus Speed_________ MHz 
Form Factor _______AT _______ATX 
Chipset Manufacturer:_____________ Model: _______________ 
BIOS Manufacturer:_______________ Version: _______________ 

 Does the CPU use a socket or a slot? ________ 
How many CPU socket/slots are there? _______ 
How many ISA slots are there? ________ 
How many PCI slots are there? ________ 
How many EIDE connectors are there? _______ 
How many floppy connectors are there? _______ 
How many serial ports are there? _____ 
How many parallel ports are there? _____ 
Is there an AGP slot? ________ 
How many USB ports are there? ______ 
How many other ports or slots are there? _______ 
What kind(s) are they? _______ 

CPU Manufacturer: ______________ 
Model: ___________________ 
Speed ________________  MHz 

Memory ______ 30-pin SIMMs ______ 72-pin SIMMs 
______ 168-pin DIMMs _____ 160 pin RIMMs 
______ 184-pin RIMMs ______ Others: ___________ 
 

How many memory slots are there? _________ 
What is the fastest type of memory supported? ______ 
What is the maximum memory supported? _______ 

Hard Drive Manufacturer: __________________ 
Model: _________________ 
Size _______ Cylinders _________ Heads _________ SPT _______ 
Interface Type ________ IDE ________ SCSI 
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CD-ROM Manufacturer: ___________________ 
Model: _________________ 
Speed: _________________ 
Interface Type __________ IDE ___________ SCSI 

Floppy Disk 
Drive 

Manufacturer: ___________________ 

Monitor Manufacturer: _______________ 
Model Number: ______________ 

Video Card Manufacturer: _______________ 
Model: ____________________ 
Memory ___________ MB 
ISA _____________ 
PCI _____________ 
On Board______________ 

Sound Card Manufacturer: __________ 
Model: _______________ 
ISA ____________ 
PCI ____________ 
On Board _____________ 

Mouse Type __________ PS/2 __________ Serial _______________ USB 

Keyboard Connector _______ 5-pin DIN or ________ 6-pin mini DIN _______ 
USB (Make sure it matches the connector on the Motherboard). 

Power Supply AT __________ 
ATX _________ 
Other _________ 
Power Supply Wattage _______ 

 

Step 2 

Examine the screws that will be used for the case. 

Are the screws Phillips, Flathead, Posidriver, or Torx? _________________ 

Examine the computer case. Is it an AT or ATX case? _________________ 

Briefly describe the difference between an AT and an ATX case: 

__________________________________________________________________ 

__________________________________________________________________ 
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Is the case a desktop, mini-tower, mid-tower, or a full tower?  

__________________________________________________________________ 

Step 3 

Most computer cases come complete with a power supply. However, not all cases are 
built for the United States market and therefore may not be set for the correct voltage. 
Look in the back of the case for the voltage selector switch. If in the United States, make 
sure that the switch is set to 115 volts. Adhere to the local power requirements when 
selecting the voltage for the power supply. 

Step 4 

Power supplies are rated by wattage, which is usually between 250 and 300 watts. What 
is the power supply rating for the case? _________ 

Step 5 

Attach the motherboard standoffs to the case. Standoffs are small pegs made of a non-
conductive material that helps avoid short circuits by preventing the motherboard from 
touching the case. Look at the holes on the motherboard to help place the standoffs in 
the proper locations.  

Troubleshooting 

An equipment list can help solve problems before they start. If there is an item missing, it 
will be discovered before the job is half done.   

Reflection 

Were all areas of the inventory list able to be filled out? ____________________ 

Explain any difficulties with the installation.  

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 3.5.3:  Motherboard Installation 

Estimated time: 45 Minutes 

Objective 

Upon completion of this lab, the motherboard will be placed into the case and secured. 
The CPU, the heat sink, the LEDs, and the memory will also be installed. 

Equipment 

The following equipment is required for this exercise: 

• ESD wrist strap and antistatic mat 

• Tool kit and screws 

• Motherboard & manual 

• CPU with fan and heat sink 

• Thermal grease 

• RAM (use the appropriate type for the motherboard) 

Scenario 

The case for a friend’s computer should be ready for the next step. Continue to work on 
installing the CPU and RAM. 

Procedures 

Be sure to wear an antistatic wrist strap for this lab and use extreme care. One discharge 
of static electricity could render a motherboard useless. In this lab, continue to work on 
the PC that is being built and properly install the motherboard, CPU, heat sink, CPU fan, 
and RAM. 

Step 1 

Lay the motherboard down on the antistatic mat. Identify the CPU socket on the 
motherboard.  The CPU socket is keyed so that the CPU may only be inserted one way. 

What CPU type does the motherboard support? _____________________________ 

Step 2 

Pick up the CPU and locate pin one.  Note that the CPU may only be inserted one way 
into the CPU socket. 

Install the CPU into the CPU socket. If the CPU is being installed into a Zero Insertion 
Force (ZIF) socket, no force is necessary. If any force has to be applied, the CPU is not 
lined up correctly. 

After the CPU is seated, adjust the CPU socket lever until it is in the locked position. 
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When the lever is locked the CPU is secure. 

Who is the manufacturer of the CPU? _______________________________ 

Step 3 

Attach the cooling fan to the heat sink. Use the four screws that came with the cooling fan 
to attach the fan securely to the top of the heat sink. 

Note: Some heat sinks are already equipped with a fan and will not need to be secured 
with screws.  

Is the heat sink being installed attached with screws? ________________________ 

Step 4 

To attach the fan-heat-sink assembly to the CPU, lay the heat sink down on the CPU and 
align the heat sink clips to their correct positions on the CPU socket. If necessary, rock 
the heat sink into position until one side of the heat sink is locked down to the outside of 
the CPU socket. Next, push down the other clip until it locks. After both sides of the heat 
sink are clipped, the heat sink will be secured to the CPU. 

Caution: Using a screwdriver may be necessary to secure the heat sink clips, but do not 
apply excessive force. If the screwdriver slips off the clips, it may damage the 
motherboard. 

Step 5 

Attach the power connection for the heat sink fan to the motherboard. Use the 
motherboard manual to identify the fan power pins on the motherboard. Connect the fan 
power leads to these pins and making sure they are secure and in the correct orientation. 

Step 6 

Install the memory. When installing the memory, the first step is to identify the memory 
sockets. Use the motherboard manual to identify the memory sockets. 

Examine the memory sockets and the memory chip(s). Memory and associated sockets 
are keyed to ensure proper installation. Take the memory and line it up with the socket. 
Slowly seat the memory into socket one. It may help to rock the memory into the socket 
until secure by gently pushing alternately on the ends of the chip. Remember, just as with 
the installation of the CPU, if too much force is exerted the motherboard can be damaged 
or destroyed. 

If more than one memory chip is to be installed, follow the instructions in the manual for 
the motherboard to add more. It is common for the next memory chip to be placed in 
socket two. Refer to the motherboard manual for specific information. 

Step 7 

Install the motherboard. Align the motherboard with the standoffs and set it in the case. 
The motherboard may have to be pushed back slightly against the I/O plate to get it to 
line up correctly. Once the motherboard is seated, use the proper screws to secure it to 
the case. Do not over-tighten the screws or the board may be damaged.  
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Step 8 

Connect the front panel LEDs to the motherboard. The motherboard connects to the 
LEDs on the front panel of the computer case to give the operational status of the 
computer. For example, a green LED on the front panel indicates that the computer is 
running. 

Use the video demonstration and the  manual for the motherboard to identify all of the 
LED pin outs. 

Connect each LED wire to the appropriate pin outs. 

Troubleshooting 

Proper installation of the cooling fan is absolutely necessary with newer processors. 
Newer processors run at very high temperatures that can cause diminished performance 
or be destroyed if not cooled properly. 

Reflection 

What would happen if the CPU fan stopped during normal computer operations? 

__________________________________________________________________ 

__________________________________________________________________ 

What was the most difficult component to install? Why? 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 3.6.4:  Floppy Drive, Hard Drive, DVD, and CD-ROM Installation 

Estimated time: 45 Minutes 

Objective 

In this lab, the student will install the floppy drive, hard drive, and CD-ROM drive. The 
student will also install the ribbon cables for each drive and the audio cable for the CD-
ROM. 

Equipment 

The following equipment is required for this exercise: 

• The same computer case which has been worked on 

• ESD wrist strap 

• Safety glasses 

• Tool kit and screws  

• Floppy drive with ribbon cable 

• Hard drive with ribbon cable 

• CD-ROM with ribbon cable and audio cable 

• DVD-ROM  

Scenario 

Continue to install the components necessary to complete a friend’s computer. 

Procedures 

When installing devices that use ribbon cables to communicate with the motherboard, 
such as hard drives and floppy drives, it is important to note the location of pin one. 
Examine the ribbon cable and find the red stripe on one side of the cable. Pin one is 
found on the side of the ribbon with the red stripe. The motherboard documentation 
should show the location of pin one for each connector, and pin one is also usually 
labeled on the motherboard for each connector. 

Step 1 

Locate a 3.5” bay which is accessible from the front of the computer case. This is where 
the floppy drive will be installed. If there is a cover for this 3.5" bay, reach inside the case 
and push out the cover. 

Step 2 

Install the floppy drive and line it up with the 3.5" bay. Slide it in until the front of the drive 
lines up with the front of the computer case, and the screw holes on the floppy drive line 
up with the side rails on the case. Use the proper screws and secure the floppy drive to 



32 - 228 IT Essentials I v3.1 - Lab 3.6.4 Copyright © 2004, Cisco Systems, Inc. 

the case. A long screwdriver may be needed to reach the backside of the floppy drive. 

Step 3 

Install the hard drive.  

Note: The 3.5” cover for the hard drive bay does not have to be removed. Line up the 
hard drive with the lower 3.5” bay. Slide the hard drive in until the screw holes line up with 
the case rails. Use the proper screws and secure the hard drive to the case. 

Step 4 

Install the CD-ROM into any of the 5.25” bays. In most computer cases the 5.25” bays 
are the upper bays.  

Locate the 5.25” bay that will be used for the CD-ROM. If there is a cover for this bay, 
reach inside the case and push out the cover. Retrieve the CD-ROM from the parts 
inventory and slide it in from the front of the case. Push it back until it is flush with the 
case and the screw holes line up with the case rails. Use the proper screws and secure 
the CD-ROM to the case. 

Step 5 

The floppy drive is connected to the motherboard with a thirty-four pin, two-connector 
ribbon cable that has a twist in it. The twist identifies one of the floppy drives as drive 
"A:\". Only one floppy drive will be used during this installation. A second floppy drive 
could be connected to the second connector on the ribbon cable and it would be 
assigned as the “B:\” drive. 

Select the proper ribbon cable for the floppy drive. Take one end of the ribbon cable and 
connect it to the back of the floppy drive. Take the other end and connect it to the floppy 
connector on the motherboard. Do not use excessive force when inserting the ribbon 
cable. Also, make sure the plug is oriented correctly according to pin one. 

Step 6 

The CD-ROM is attached using an IDE, forty-pin, forty-conductor ribbon cable. The CD-
ROM cable typically has three connectors. One for the motherboard and the other two 
are for devices. 

Select the proper ribbon cable for the CD-ROM. Take one end of the ribbon cable and 
connect it to the back of the CD-ROM. Take the other end and connect it to the IDE2 
connector on the motherboard. Do not bend the motherboard with excessive force when 
inserting the ribbon cable. 

Step 7 

Connect the audio cable that came with the CD-ROM. Attach one end of the cable to the 
CD-ROM and the other end to the motherboard. Usually, the audio cable connectors are 
notched and will plug-in only one way. If this is not the case, simply insert the connectors 
whichever way they can go in.  

If no sound comes out after the computer is powered up and the CD-ROM is tested, 
make sure that the volume is turned up on the speakers; otherwise, simply go back in the 
box, pull out the audio cable and reverse the sides. Always consult the manuals that 
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come with components for additional direction on installations. 

Step 8 

The DVD-ROM is also attached using an IDE, forty-pin, forty-conductor ribbon cable. 
Using the same cable as the CD-ROM connect the DVD-ROM using the last connection 
on the IDE cable available. 

 Step 9 

The hard drive is attached using an IDE, forty-pin, eighty-conductor ribbon cable. The 
hard drive ribbon cable looks similar to the CD-ROM cable. However for each conductor 
it has an associated ground wire, which is why it has 80 (instead of 40) conductors. This 
cable can fit into a CD-ROM and visa versa, but the hard drive will not work properly if 
they are switched. The easiest way to tell the difference between the CD-ROM ribbon 
cable and the hard drive cable is to feel them. Since the hard drive cable has eighty-
conductors it is not as coarse as the CD-ROM cable. 

Select the proper ribbon cable for the hard drive. Take one end of the ribbon cable and 
connect it to the back of the hard drive. Take the other end and connect it to the IDE1 
connector on the motherboard. Do not bend the motherboard when inserting the ribbon 
cable. 

Step 10 

The power cables are attached to the motherboard and each drive. Examine the power 
cables that extend from the power supply. There will be one large connector and several 
smaller connectors. The large 20-pin (ATX 1) attaches to the motherboard, the smaller 
connectors attach to the drives. 

Most power supplies support four IDE drives and two floppy drives. The connectors for 
the floppy drives and for the IDE drives (CD-ROM, DVD-ROM and hard drive) are 
different. Examine the back of each drive. Find the power connectors on the back of each 
drive and connect the correct power cable to each one. 

Next, connect the ATX power connector. Use caution when attaching the ATX cable. Do 
not bend the motherboard. 

Troubleshooting 

If the floppy ribbon cable is keyed (can plug in only one way), but the floppy drive does 
not have a keyed slot, check for a punch-out on the drive that can be removed to make 
room for the keyed slot. Otherwise, a non-keyed floppy ribbon cable will be necessary 
and can be purchased at a local computer supply store. 

Reflection 

Briefly summarize the differences between the floppy drive and hard drive ribbon cables:  

__________________________________________________________________ 

__________________________________________________________________ 
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Write one tip that was learned from the material or in class that helped with the 
installation of the components in this lab.  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 3.7.1:  Video Card Installation and System Booting 

Estimated time: 30 Minutes 

Objective 

Upon completion of this lab, the student will have installed the video card. The student 
will also have connected the mouse, keyboard, and monitor. If everything is installed 
properly, the student should be able to turn on the computer at the end of this lab. 

Equipment 

The following equipment is required for this exercise: 

• ESD wrist strap 

• Tool kit and screws  

• Video card 

• PS/2 mouse 

• PS/2 Keyboard 

• 15” monitor 

• 3.5” DOS boot floppy 

• Motherboard manual 

Scenario 

A friend cannot wait any longer for the computer to be finished. It is time to put the 
finishing touches on the machine and start it up. 

Procedure 

Before powering up a computer, it is extremely important to properly seat all of the 
expansion cards. If a card is not properly seated when the computer is turned on, it will 
malfunction. Also, excessive force when seating an expansion card can damage the 
motherboard, so the job must be done carefully. 

Step 1 

Recall from chapter two that video cards are built for either the PCI slot or the AGP slot. 
Check the video card that is included in the equipment inventory. In the space below 
describe the video card. Include how much video RAM is on the card and whether it is a 
PCI or an AGP card. 

__________________________________________________________________ 

__________________________________________________________________ 

To install the video card, first remove the slot protector from the back of the computer 
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case. Locate the AGP slot or an available PCI slot. Remove the slot protector by 
removing the screw that holds it in place. 

Step 2 

Insert the video card into the AGP or PCI slot. If necessary, rock it gently until it is seated 
on the motherboard. After the video card is seated, line up the hole in the video card 
bracket with its corresponding hole in the computer case. Use a case screw to secure the 
video card to the computer case. 

Note: Never leave a slot open without a card in it. Leaving a slot open will cause poor air 
circulation in the case and some components may overheat. 

Step 3 

Before closing the computer case, review the following checklist: 

Are there any loose screws in the computer case? 

Have all tools have been removed from the computer case? 

Is the voltage selector switch in the correct position? 

Is the CPU seated completely? 

Is the fan secured? 

Is the fan plugged in? 

Is the memory in the correct slot, and is it fully seated? 

Are all of the drives in the correct position and secured to the chassis? 

Are the ribbon cables fully seated and connected to the correct drives?   

Is the audio cable connected to the CD-ROM drive correctly? 

Is the ATX 1 power cable in the right position and has it been latched down? 

After completing the checklist, put the computer case together. Attach all of the case 
panels and secure them with the appropriate screws. 

Step 4 

Locate the two PS/2 ports on the back of the computer. One port is designated for the 
mouse and the other for the keyboard. Look closely at these ports. On newer 
motherboards there is an icon for the mouse and keyboard. Also, each port may be color-
coded. It is purple for the keyboard and green for the mouse. Plug the mouse and 
keyboard into their respective ports by lining up the pins and pinholes and pushing on the 
connections. Do not push too hard, but make sure they are inserted all the way. 

Step 5 

Locate the monitor and place it near the computer. Examine the video card adapter that 
was installed in Step 1. It will be a 15-pin female connector. Examine the monitor 
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connector. It will be a 15-pin male connector. Line up the pins to the pinholes and 
connect the monitor cable to the video adapter. Most cables come with monitor screws 
already attached. Tighten these screws evenly until the monitor cable is attached to the 
video card. 

Step 6 

Now plug in the computer power cable. On ATX models there will be a power switch on 
the back of the computer and a power button on the front. Turn on the power switch first. 
The computer will not power up unless both the switch and the button are on. 

Now, push the power button on the front panel of the computer. This will power-up the 
computer. Some front panel LEDs will turn on, and the power supply fan will start 
spinning. 

Step 7 

Press the appropriate key to cause the computer to go into the BIOS setup mode. Some 
BIOS manufacturers use a different key, or key combination, to enter BIOS configuration 
mode. When first powering up the computer, a message displays that says something 
similar to “Press F3 to enter Setup”. If this message does not display, consult the manual 
for the motherboard for the correct button or sequence of keys to push. 

When the computer goes into BIOS setup, the main menu screen displays. Run through 
the BIOS settings below and then boot the computer from a bootable floppy disk. 

Move around the screen using the arrow keys until the Standard CMOS menu item is 
highlighted. Press the Enter key to open the Standard CMOS features screen. In this 
screen the time, date and the type of drives this computer will recognize can be change.  

Check to see if the BIOS recognizes Drive A. Does it show Drive A as a 1.44M, 3.5” 
floppy? _______ 

Check to see if there is a Drive B. Since a second floppy drive was not connected when 
the system was built, you should not find one.  

To leave the BIOS setup, hit the Esc key. A prompt will come up that asks, "Do you want 
to quit without saving?" Press the Y key for yes. 

Step 8 

In this step, the computer is booted from a floppy disk. Restart the computer and insert 
the 3.5” bootable floppy disk. If the standard BIOS settings have not been altered, the 
computer will look for the operating system in the following order:  

1) Removable media 

2) Hard drive  

3) CD-ROM 

During normal operations the computer is booted without a floppy disk. Therefore, the 
computer will skip the floppy drive and find the operating system on the hard drive. 

Recall from chapter two that DOS is a command line operating system. After the 
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computer boots, the screen will display an "A:\>" prompt. There will not be any windows 
or icons visible.  

Use the DOS boot disk to check some basic functions of the computer. Run the following 
DOS commands and write out the results of each: 

Type “dir”, then press Enter. 

What are the results of typing this command? 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

Troubleshooting 

Did the computer boot correctly? _______ 

If not, go over the checklist again. Have the instructor or lab aide look over the system.  

How many beeps were heard? 

__________________________________________________________________ 

__________________________________________________________________ 

If the computer did not boot correctly, what steps were taken to troubleshoot it? 

__________________________________________________________________ 

__________________________________________________________________ 

Reflection 

Did everything go as expected? If not, why not? 

__________________________________________________________________ 

__________________________________________________________________ 

What would have made the construction of the computer easier? Describe a tip or 
technique that you learned when building this computer that could be used in the future.  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________
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Lab 4.2.3:  Basic DOS Commands 

Estimated time: 30 Minutes 

Objective 

Upon completion of this lab, the student will be able to navigate the DOS command line. 
The student will also be able to perform basic file management tasks such as creating 
directories and files, navigating through directories, displaying content of directories, and 
displaying and changing file attributes. 

Equipment 

The following equipment is required for this exercise: 

• A computer with a version of DOS running 

Scenario 

A manager has asked the student to create a directory structure using the DOS 
command line. The manager wants a directory created in which documents for the 
upcoming inventory will be kept. The directory structure the manager wants created is 
C:\IT\pcs. The manager has also asked that a read-only test file be created. 

Procedures 

The following steps detail the process of managing files by using the DOS command line. 
Basic DOS commands will be used to carry out the task presented by the manager. At 
the end, the newly created directories and files that have been created will be safely 
deleted. 

Step 1 

There are a few different ways to access the DOS prompt (command line). The most 
common way is to boot into a version of Windows, press Start > Run > then type 
“command”. It can also be accessed by pressing Start > Programs > Accessories >and 
selecting Command Prompt. If Windows will not load, the DOS prompt can be accessed 
by pressing F8 during the boot process and then selecting “Safe mode with command 
prompt”. 

As illustrated in Figure [1], when DOS is accessed, the window displays the “C” prompt 
(C:\>). 

 
Figure [1] DOS prompt 
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Step 2 

At the “C” prompt, type in “dir” to show a list of the directories located on this drive. 

 
Figure [2] Using the dir command 

As seen in Figure [2], the dir command will list directories and various files. Directories 
are specified with the <DIR> notation that precedes the file/directory. The dir command 
also displays the volume name, free space, and total files and directories present. 

Step 3 

To create directories in DOS, use the md directory_name or mkdir 
directory_name command. Type “md IT” to create the IT directory. 

C:\>md IT 

Step 4 

Next, display the IT directory using the dir command at the root (C:\>). Figure [3] shows 
the newly created IT directory. 
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Figure [3] Creating a Directory in DOS 

 
Step 5 

To change directories use the cd directory_name or chdir directory_name 
command. For example, to access the “IT” directory, type in “C:\>cd IT”. Typing this 
command will change the “C” prompt to C:\IT>. 

Step 6 

The command prompt should now be C:\IT>. The next task is to create another directory 
called “pcs”. 

What command should be used to make this directory?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 7 

Navigate to the newly created “pcs” directory. 

What command would be used to change to the “pcs” directory?  

__________________________________________________________________ 

__________________________________________________________________ 
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What will the command line look like?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 8 

To create a file in DOS, use the copy con filename command. This command will 
copy a file from the console (con) and place it in the directory. The console in this case is 
the screen. After this command is type, there will be a blank line on the command 
prompt. Next, type in text that will be saved in the newly created file. When finished 
typing in the message, hold down the Control key (<Ctrl>) press the Z key and then 
press the Enter key. This key combination will end the message and DOS will display “1 
file(s) copied”. 

C:\IT\pcs>copy con sample.txt  

This is an inventory test document 

<Ctrl>+Z 

<Enter> 

1 file(s) copied 

Step 9 

Display the contents of the “pcs” directory. The newly created sample.txt in the directory 
will be displayed. Figure [4] shows the DOS output for dir command in the “pcs” 
directory. 

 
Figure [4] dir command showing the newly created file. 

 
Step 10 

Next, display the attributes for the sample.txt file. In order to display the attribute(s) of a 
file, type in attrib filename. Valid attribute values are: 

• R – Read Only file attribute 

• A – Archive file attribute 

• S – System file attribute 
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• H – Hidden file attribute 

What command would be typed in to order display the attributes of sample.txt?  

__________________________________________________________________ 

What are the attribute(s) of sample.txt?  

__________________________________________________________________ 

Step 11 

To change, or remove an attribute use the attrib [-/+] attribute_value 
filename command. The minus (-) option will remove an attribute value from a file and 
the plus (+) option will add an attribute value to a file. As discussed early, valid attribute 
values are R (read-only), A (archive), S (system), and H (hidden).  

What command would change the attribute value of the sample.txt file to a read-only file? 

__________________________________________________________________ 

Troubleshooting 

If a command is unclear or forgotten, DOS can provide useful command information.  
DOS can provide general command syntax or detailed information about a specific 
command. The command to list all available commands is c:\>help. This command 
can be used at any level within the DOS structure. To find specific information about a 
command, including proper syntax and optional parameters, use the c:\>command /? 
command. 

Reflection 

What is the command to make a directory?  

__________________________________________________________________ 

What is the command to delete or remove a directory?  

__________________________________________________________________ 

List the four different attributes a file can be assigned?  

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 4.2.4:  Creating a DOS Boot Disk 

Estimated time: 25 Minutes 

Objective 

Upon completion of this lab, the student will know which files are necessary to make a 
floppy disk bootable. The student will also learn the commands necessary to create a 
boot disk. 

Equipment 

The following equipment is required for this exercise: 

• Operational computer with Windows 98 or earlier installed 

• A blank floppy diskette 

Note: This lab will not work with Windows ME, Windows 2000, or Windows XP. 

Scenario 

As a computer technician, the student will need to create a boot disk in order to prepare a 
computer for installation. This disk will include utilities such as fdisk and format so that a 
hard drive can be prepared for an operating system. 

Procedures 

Formatting prepares the disk for use. For DOS, make a bootable disk using the same 
version of DOS that is on the hard drive. 

Note: Use caution to not accidentally format the hard drive. 

Step 1 

If the computer is not already booted and at a DOS prompt boot it now. Put a floppy 
diskette into the drive and format the floppy diskette using the following command: 

C:\> format A:/ 

Which three files are necessary in order to make the disk bootable? 

___________________, _____________________, ______________________ 

Step 2 

Leave the diskette in the drive and reboot the system. This process will test the disk to 
make sure it is bootable. 

Did the system successfully boot to a prompt? _____________ 

What does the prompt look like? __________________ 
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Step 3 

When the system boots using Microsoft’s DOS, the five files involved are autoexec.bat, 
command.com, config.sys, io.sys, and msdos.sys.  

Assuming all five files are available on a bootable disk, what order are these files 
accessed when the system is booted? 

1. __________________ 

2. __________________ 

3. __________________ 

4. __________________ 

5. __________________ 

Step 4 

In addition to the five files mentioned above, there are certain utilities that can be helpful 
when working with a computer that does not have an operating system: 

• DEFRAG.EXE 

• EDIT.COM (which may also require QBASIC.EXE if using an older version of 
DOS) 

• FDISK.EXE 

• FORMAT.COM 

• MEM.EXE 

• SCANDISK.EXE 

• SYS.COM 

• UNDELETE.EXE 

Troubleshooting 

A computer is often restarted without removing the floppy disk from the floppy drive. If the 
disk is not bootable (does not have io.sys, msdos.sys, and command.com), then an error 
message is displayed that says “Non-System disk or disk error. Replace and strike any 
key when ready”. It is possible that the user did not use the /S switch if this message is 
received after formatting a disk. Double-check that the disk has the proper files on it to 
make it bootable. 
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Reflection 

List any other utilities that would be useful on a boot disk: 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 5.1.6:  Changing File Views in Windows (showing file extensions) 

Estimated time: 20 Minutes 

Objective 

Upon completion of this lab, the student will be able to change the file view based on 
needs or preferences. 

Equipment 

The following equipment is required for this exercise: 

• A computer running Windows (95,98, 2000, or XP) 

Scenario 

While navigating through some folders, the student realizes that the files and sub-folders 
could be arranged better. It is decided that the default display is not the best visual 
display for the files. In this lab, the student will change the File view to the preferred view.  

Procedures 

Changing the file view in Windows can reveal important information about files and sub-
folders. Users can find information on file size, file type, and time and date of the last 
modifications. Also, the view can be configured based on personal preferences. View 
preferences include thumbnails, list, and large or small icons. Configuring the file view is 
especially helpful when a folder contains numerous files and/or sub-folders. Folder 
contents can be neatly displayed according to preference or needs, making navigation 
easier. 

Step 1 

Start the computer into the Windows desktop environment. 

Step 2 

Double-click on the My Computer icon on the desktop to open the window.  

Step 3 

While the cursor is pointed at a blank space in the My Computer window, right-click and 
then select the View option. Figure [1] displays the right-click menu.  
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Figure [1] Selecting the View Option 
 

When selecting the View option, what parameters are available?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 4 

Next, select the View parameter for the files. Notice how icons in the folder change. 

What information is displayed when the Details option is selected?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 5 

After selecting the View option, set this view for all folders. To do this, select Tools > 
Folder Options. Figure [2] displays this process. 

 
Figure [2] Selecting the Folder Options 

 

After you select Folder Options from the Tool menu, the Folder Options display box will 
appear. Figure [3] shows the Folder Options display box.  
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Figure [3] Folder Options display box 
 
Step 6 

Next, select the View tab. What options are available in the View tab? 

__________________________________________________________________ 

__________________________________________________________________ 

Step 7 

From the View tab, select the Like Current Folder command button. Selecting this 
button will make the view in the current folder universal throughout the drive. 

 
 

Figure [4] Folder Options display box 
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Troubleshooting 

Changing a file view customizes the preferences. Also, important details and system files 
can be viewed using advanced options in the Folder Options window. System files are 
usually hidden to protect against accidental deletion, but there will be times when it will 
be necessary to configure these files. 

Reflection 

How can files in a folder be rearranged? 

__________________________________________________________________ 

__________________________________________________________________ 

Why would a user want to change the folder view settings?  

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 5.1.7:  Text Editing and File Management 

Estimated time: 30 Minutes 
 
Objective 

In this lab, the student will be introduced to creating a file in Notepad, saving it to the hard 
drive, then creating a folder on a floppy disk and moving the file from the hard drive to the 
floppy disk. 

Equipment 

The following equipment is required for this exercise: 

• Lab Computer with Windows 98 or earlier installed 

• 3.5 inch floppy disk 

Scenario 

A text file needs to be edited for testing a floppy drive that has been installed. To do this, 
a file will need to be created, edited, and moved from one location to another. 

Procedures 

Users manage and create files with an operating system. Some of these tasks include 
updating, renaming, moving, and deleting files. 

Step 1 

From the Windows desktop, click on the Start button, then move the cursor to Programs 
> Accessories and then click Notepad. 

Step 2 

Once Notepad is open and on the desktop, type any message within the editing area. 
Type just a few sentences and then click on the File menu and select Save As. This will 
open a new window, which will allow the user to choose the location of the text file. 

The default location is My Documents. If the My Documents folder is not the default, use 
the “Save In” drop-down box to choose My Documents. With My Documents as the 
folder, type “testfile.txt” within the “File name” text box and then click the Save button. 

Step 3 

The file is now saved on the computer. Notepad can be closed without losing any data. 

To manage files on the computer, open a file manager application such as Windows 
Explorer. This application can be found in the programs menu by clicking on the Start 
button and then selecting Programs and then Windows Explorer. 

Note: An alternate way to open Windows Explorer is to right-click on the Start button and 
choose Explore. 
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Step 4 

Using the left windowpane in Windows Explorer, locate the My Documents folder where 
the text file “testfile.txt” is saved. 

Locate the My Documents folder and click on it to display the contents on the right 
windowpane. As with most things in Windows, there is more than one way to rename a 
file.  

The more conventional way to rename a file is to select the file by clicking on it once. 
Then, with the file “testfile.txt” selected, go to the File menu of Windows Explorer and 
select Rename. This will outline the filename with a box and highlight the name of the 
file. Now type a new file name for the file, such as “newname.txt”. After the file is 
renamed, press the Enter key to complete the changes. 

The other way to rename a file in Windows is to right-click on the filename itself and 
select Rename from the drop-down menu. Use this method to rename the file back to the 
original name “testfile.txt”. 

Both methods work equally well. It is a matter of personal preference as to which way is 
used. 

Step 5 

Insert a formatted floppy disk into the floppy drive. Navigate Windows Explorer to the 3.5-
inch floppy drive icon in the left windowpane. When selected, the contents of the floppy 
disk will display in the right windowpane. There are two ways to create a new folder on 
the floppy disk. 

The first way is to go to the File menu, select New, and then in the submenu that 
appears, click Folder. This will create an empty folder that will need to be named. In the 
same way that the text file was renamed, name the folder “my test folder” and press 
Enter to complete the process. 

The second way to create a folder is to right-click in the right windowpane, select New, 
and then select Folder. 

Step 6 

To move a file from one location to another is a simple process. There are several ways 
to accomplish this. 

To move the text file that was created earlier to the folder that was created on the floppy 
disk, navigate Windows Explorer to the My Documents folder on the computer. From 
there, select the “testfile.txt” file and then go to the Edit menu and select Cut. 

Now navigate Windows Explorer to the folder that was created on the 3.5 inch floppy. 
Highlight the folder that was created, then go to the Edit menu and select Paste. 

The file will be moved from the My Documents folder to the floppy disk. To verify that it 
was moved, navigate Windows Explorer back to the My Documents folder to make sure 
that the file is not there anymore. Then navigate back to the floppy and make sure that 
the document “testfile.txt” appears on the floppy. 
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Troubleshooting 

Knowing how to cut, copy, and paste quickly will save a lot of time when working within 
the Windows environment. There are shortcuts to many of the commands within 
Windows. To cut a file without clicking on the Edit menu or right-clicking, simply select a 
file and type the key combination Ctrl-X. Holding the Ctrl key and pressing X when a file 
is selected does the same thing as selecting Cut from the Edit menu. 

Try this with all of the shortcut commands. 

Reflection 

List a method used to copy or move files from one location to another by using the mouse 
only:  

__________________________________________________________________ 
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Lab 5.4.2:  Hard Drive Preparation Using FDISK and FORMAT 

Estimated time: 30 Minutes 
 
Objective 

Upon completion of this lab, the student will be able to partition the hard drive. The 
student will also be able to install the three system files onto the hard drive to make it a 
bootable drive. 

Note: This procedure will erase any current information on the hard drive of the lab 
computer. Before proceeding, make sure to use only components that can be erased and 
copied to. 

Equipment 

The following equipment is required for this exercise: 

• A lab computer 

• Bootable floppy disk with DOS FDISK and FORMAT files 

Scenario 

A new hard drive has been installed and it needs to be prepared for the operating 
system. In order to do this, the DOS FDISK and FORMAT commands will need to be 
used. 

Procedures 

After installing a hard drive into a computer, it must be prepared in order for the computer 
to communicate with it during the boot process. Using the DOS commands FDISK and 
FORMAT, the hard drive can be partitioned and prepared for communication and usage. 

Step 1 

Boot up the computer using a bootable floppy disk with the FDISK and FORMAT files on it. 

Step 2 

To create and remove partitions, first start the FDISK program. Type FDISK at the 
prompt and then press Enter. Once the application starts, select option 4 to check and 
verify current partitions before attempting to delete any partitions.  

Now select the partition type to delete from the menu that displays. They are Primary 
DOS partition, Extended DOS partition, Logical DOS drives in the Extended partition, and 
a Non-DOS partition. 

If there are logical drives defined in the Extended partition, they need to be removed 
before the Extended partition is removed. To delete any partition, simply select the option 
that correlates with the partition to be removed and follow the directions on the screen. 
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Step 3 

Once all the partitions have been removed from the drive, return to the main menu and 
select option 1 to create a DOS partition. Then from the next menu, select option 1 to 
create a Primary DOS partition. From there, follow the on-screen directions to finish 
creating the Primary DOS partition. 

At this point, exit FDISK and then restart the computer with the floppy disk still in the 
drive.  

Note: Make sure to set the Primary drive to “Active”. 

Step 4 

Once the computer has restarted, it is time to format the partition that was just created.  
To do this, type “format C: /s” from the command prompt. This tells the format program to 
make the C drive usable for DOS. The “/s” copies system files to the hard drive during 
formatting, so that it is bootable. 

The program will give the option of formatting the drive. This will erase anything that is on 
the drive.  Since the drive is empty, type “Y” for “Yes” and press Enter to continue. 

Step 5 

When the format is complete, enter the student’s name when asked to enter a “volume 
label”. When the format is complete and the command prompt is returned, restart the 
computer without the bootable floppy inserted to make sure that the computer will boot 
from the hard drive. 

Troubleshooting 

Sometimes a third party formatting application is necessary when dealing with certain 
partition types. If a hard drive will not let a partition be removed, consider purchasing a 
third party product such as Power Quest’s “Partition Magic”. It is available in most 
computer software stores. 

Reflection 

List the three files required for booting a DOS formatted disk: 

______________, _______________________, __________________________ 

What other DOS commands will transfer these system files from one drive to another?  

__________________________________________________________________ 
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Lab 5.5.5:  Windows OS Installation 

Estimated time: 60 Minutes 

Objective 

Upon completion of this lab, the student will be able to install Windows 98. 

Equipment 

The following equipment is required for this exercise: 

• A computer with a partitioned and formatted hard drive 

• A bootable floppy disk with CD-ROM drivers or a bootable CD-ROM drive 

• Windows 98 Second Edition Install CD 

Scenario 

A friend has a computer, and is not sure how to install an operating system. 

Procedures 

In order for a computer to be useful, it needs an operating system installed. The most 
commonly used operating system is Microsoft Windows. This exercise will take about an 
hour to complete. Follow the steps below to install Windows 98. 

Note: The same procedures may be used to install other versions of Windows. However, 
there may be some significant differences during the setup process. 

Step 1 

Depending on whether or not the computer supports bootable CDs, a bootable floppy 
disk with CD-ROM support will need to be inserted in order to get started. If the computer 
supports bootable CDs, simply insert the Windows 98 Installation CD and boot the 
computer. If a message displays prompting to press any key in order to boot from the CD, 
press any key to get started. 

Step 2 

If the computer needs to be booted from a floppy disk, insert the disk and turn the 
computer on. Once the computer has booted, there should be a DOS prompt that looks 
like “A:\>”. To begin the installation, change the directory to the CD-ROM drive by typing 
“D:” and then pressing Enter. Then type “setup” and press Enter to begin the installation.  

Note: The CD-ROM drive letter might be different depending on the computer, so make 
any necessary adjustments. 

Step 3 

The Microsoft Windows 98 Setup screen will display a few different options: 

• To set up Windows now press Enter. 
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• To learn more about Setup before continuing, press F1. 

• To quit Setup without installing Windows, press F3. 

• Press Enter to install Windows 98. 

Step 4 

Prior to the installation, Windows Setup needs to run Scandisk in order to make sure that 
there are not any problems with the hard drive. Press Enter to continue and wait for the 
graphical setup interface to display. 

Once the Windows 98 Setup screen displays, most of the installation will be automated. 
However, the following steps will walk the student through the areas that will require 
information to be gathered. 

Step 5 

After Windows Setup runs Scandisk, a series of prompts will be presented that lead the 
user through the installation process. When the Windows 98 Setup Wizard displays 
select the directory where Windows 98 is installed. Select the checkbox that says, 
“C:\WINDOWS”. 

Windows will then prepare this directory. 

Step 6 

Next, a series of Setup Options will be prompted for the installation of Windows 98.  

What are the available options available for installing Windows 98? 

______________ 

______________ 

______________ 

______________ 

For the purpose of this lab, select Typical and then press Next. 

Step 7 

Windows will then prompt the user with options for installing system components. Select 
the check box to install the most common components and then press Next. 

Step 8 

Setup will then give the option to identify the computer.  

What parameters can be defined to identify the computer?  

__________________________________________________________________ 
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__________________________________________________________________ 

__________________________________________________________________ 

The user can either leave the default computer identification or enter custom information. 

Step 9 

The Windows 98 Setup Wizard will then ask for the location. Make the appropriate 
selection and continue.  

Step 10 

Setup will then prompt to Start Copying Files. Press Next to continue. 

Step 11 

At this point, a bar graph will appear and begin to count up to 100 percent. Speed will 
vary with system hardware. Carefully read the software license. Select Yes to agree with 
the license. Windows Setup will then prompt for the CD-KEY. This information will be with 
the Certificate of Authenticity on the CD case.  

Enter the key exactly and click Next to continue. Click Finish to start using Windows 98. 

Step 12 

Windows will run through a series of automatic hardware detection features. This process 
of detecting hardware will usually take a few minutes. When Windows finishes detecting 
your hardware, select date and time properties. Continue through the Setup and when 
prompted reboot the machine. 

Step 13 

This should successfully complete the installation of Windows 98. 

Troubleshooting 

It is possible for Windows Setup to not finish the installation properly. If for some reason 
there is a problem, try running setup again. Additional help and resources are available 
on Microsoft website at http://www.microsoft.com/. 

Reflection 

Did the Windows installation complete successfully? _____________________ 

Make note of any tips or tricks learned during the installation: 

 

 

http://www.microsoft.com/
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Lab 5.6.1:  Troubleshooting 101 

Estimated time: 20 Minutes 

Objective 

Upon completion of this lab, the student will have learned some basic troubleshooting 
skills. 

Equipment 

This lab requires a pen or pencil. 

Scenario 

The questions below will assist with problem solving. 

Procedures 

Troubleshooting is an important part of a technician’s job. Troubleshooting must be 
approached in a systematic way. One way to do this is by looking at the most obvious 
things first. Overlooking the obvious can cost time and money. Remember that every time 
a technician goes into the computer, there is a risk of damaging the computer. 

Step 1 

Write down the steps a technician should take if a printer is not printing. Put them in 
order, starting with what a technician should check first.  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

Step 2 

Write down the steps a technician should take if a file cannot be saved onto a floppy 
diskette. Put them in order, starting with what a technician should check first.  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Step 3 

Write down the steps a technician should take if a monitor is not displaying anything. Put 
them in order, starting with what a technician should check first.  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

Step 4 

Write down the steps a technician should take if the computer will not turn on. Put them in 
order, starting with what a technician should check first. 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

Troubleshooting 

When approaching a computer that is reportedly broken, try to rule out the obvious first. 
Make sure the unit is turned on and that all components are plugged in properly. Also, it 
may help to ask the user of the system what the last thing being done on the computer 
was before it failed. 

Reflection 

Troubleshooting requires a systematic approach to solve problems. Choose a problem 
that is not computer related. An example might be the toaster does not toast bread. List 
the steps that should be taken to solve this problem. Is a systematic approach useful in 
solving non-computer related problems?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________
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Lab 5.6.4:  Installing a Driver 

Estimated time: 20 Minutes 

Objective 

Upon completion of this lab, the student will be able to install the driver for a rollerball 
mouse. The same process is used when installing any new device on a system. 

Equipment 

The following equipment is required for this exercise: 

• Lab computer with Windows 98 or earlier operating system 

• A rollerball mouse with the driver disk 

Scenario 

A new rollerball mouse has been purchased and needs to be installed. 

Procedures 

Make sure that the proper drivers for the operating system being used have been 
installed. Drivers built for Windows 95 may install properly on a Windows 98 platform, but 
could cause undesirable results. 

Step 1 

From the Windows 9x Desktop, go to Start > Settings > Control Panel. 

Step 2 

On the Control Panel, double-click on the Add New Hardware icon. This will start the 
Add New Hardware Wizard. Read the onscreen display and click the Next button to 
continue. 

Step 3 

The Hardware Wizard will search for Plug and Play devices. Click the Next button to 
continue. When the search is complete, the Wizard will ask if it can search for devices 
that are not Plug and Play compatible. Select “No, I want to select the hardware from a 
list” and then click Next. 

Step 4 

A list of hardware devices to choose from will display. Select the device that most closely 
matches the device being installed, which would be a “Mouse” in this exercise. Once the 
device is selected, click Next. 

Step 5 

If the latest driver is on a CD-ROM or floppy disk, insert it into the computer. Click the 
Have Disk button and then either type the path to the driver or click the browse button to 
find the exact location of the driver. Once the driver is selected, click the OK button to 
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continue. 

At this time, the Wizard will display a list consisting of any number of devices, which 
should match the device being installed. Select the one that the device most closely 
matches, then click Next. 

Step 6 

Follow the rest of the onscreen instructions in order to complete the installation process. 
When the driver has been installed, Windows will need to be restarted for the changes to 
take effect. If a dialogue box displays to restart, click Yes. Otherwise, click the Start 
button, select the Shut Down option, and then shutdown the computer. 

Step 7 

Once the computer has been shut down, remove the current mouse and plug the new 
rollerball mouse into the PS/2 port. When it has been plugged in properly, turn on the 
computer. Test the new device at the Windows desktop. If the device does not respond, 
see the troubleshooting section of this lab. 

Troubleshooting 

It is important to use the correct driver when installing a device. For example, a new 
sound card will most likely not work, or will work improperly. If the wrong drivers are 
installed. 

Also, using the latest driver is a good practice to follow. When installing a new device, 
check the manufacturer’s web site for the latest drivers available for their product. 

If there are problems with the mouse pointer, verify that it is properly connected and the 
mouse pointer is clean and free of any dust or debris.  If the problem still exists after 
verifying the connection and cleaning, try restarting the machine. Rebooting the machine 
will refresh and reload the mouse pointer drivers. This should resolve most problems 
associated with the mouse pointer devices. However, if the problem still exists, the driver 
might need to be updated. To update the driver, simply repeat the steps outlined in this 
lab with the latest driver found on the Internet.  

Reflection 

Were there any problems installing the drivers for this device? __________________ 

If so, explain how the problem was solved:  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 5.6.5:  Create a Startup Disk 

Estimated time: 15 Minutes 

Objective 

Upon completion of this exercise, the student will be able to create a Windows startup 
disk. 

Equipment 

The following equipment is required for this exercise: 

• Computer with Windows 98 or earlier installed 

• One 3.5 inch blank diskette 

Scenario 

The Windows operating system has been installed, but a Windows startup disk was not 
made during the installation. 

Procedures 

Once the operating system is up and running, create a Windows 98 startup disk. If for 
some reason Windows will not load, the boot disk may be necessary to begin the 
troubleshooting process. 

Note: In this lab, use the built-in functionality of Windows to create a Windows startup 
disk. A boot disk can be made by copying the necessary startup files on to a floppy disk.  

Step 1 

From the Windows desktop, go to Start > Settings > Control Panel. 

What is the general purpose of the Control Panel?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

Step 2 

Once the Control Panel displays, double-click on the Add/Remove Programs icon. In 
the Add/Remove Programs Properties window, select the Startup Disk tab. 

Step 3 

Click the Create Disk button. A status bar will display indicating it is preparing the files 
needed for the startup disk. If the cab files are not available, Windows will prompt for the 
Windows Installation CD. 
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Step 4 

When the files for the startup disk have been collected, Windows will prompt the user to 
label a disk and insert it into the drive. Click the OK button. 

Step 5 

Once the startup disk has been created, write-protect the disk by moving the switch to the 
open position. The switch is located on the back of the disk at the top left corner. 

Why is it important to write-protect a bootable floppy disk?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 6 

To finish the process, reboot the system to make sure the diskette works. 

Troubleshooting 

A bootable floppy disk is often needed while working on computers. If the operating 
system will not start, a floppy disk will be used to view the contents of the hard drive and 
begin the troubleshooting. 

Reflection 

What three files are needed in order for a floppy disk to boot properly?  

____________________ 

____________________ 

____________________ 
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Lab 6.2.1a:  Creating Users Accounts in Windows 2000 

Estimated time: 30 Minutes 
 
Objective 

Upon completion of this lab, the student will be able to create users and groups as well 
as assign properties to each. 

Equipment 

The following equipment is required for this exercise: 

• A computer with Windows 2000 Professional installed 

Scenario 

A coworker needs to use a shared computer that contains sensitive files. In this case, it is 
a good idea to set up a user account for her. 

Procedures 

Being able to create users and then organizing those users into groups is an essential 
task when working with Windows 2000. A user account enables a system administrator to 
log in and access the resources of the computer as well as have a custom environment 
to work in. A group is simply a collection of users. In this lab, both users and groups will 
be created. 

Step 1 

From the Control Panel, select the Users and Passwords applet. Click on the Advanced 
tab, and then click on the Advanced button. What is the title of the window that just 
opened? 

__________________________________________________________________ 

Step 2 

In the Local Users and Groups window, select the Users folder in the left pane. From the 
Action menu, select New User. 

What options are available in the New User dialog box?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Step 3 

In the New User dialog box, fill out the information for a new user named LocalUser. For 
the password, just use the word “password”. Uncheck the box that says, “User must 
change password at next logon”, and then click the Create button. 

Using the same process, create a second user named LocalUser2. When finished, click 
the Close button. 

Step 4 

Test the user account by logging off the current user and then logging back in using the 
username that was just created. 

Did the user account work properly? __________________________________________ 

If the user account did not log in properly, see the troubleshooting section. 

Troubleshooting 

If the user account was not created or if it is disabled, retrace the steps necessary to 
create a new user account and double-check that everything is setup properly. 

Reflection 

Why is it necessary to have separate user accounts on a local machine?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 6.2.1b:  Assigning Permissions in Windows 2000 

Estimated time: 30 Minutes 

Objective 

In this exercise, the student will learn how to assign NTFS permissions to folders. 

Equipment 

The following equipment is required for this exercise: 

• A computer running Windows 2000 formatted with NTFS 

Scenario 

The boss needs a folder structure created and permissions assigned to the folders. 

Procedures 

The ability to manage folders and assign access rights is an important capability of 
operating systems. This capability helps ensure data integrity by defining the level of user 
access.  

Step 1 

First, create a folder and name it Chemistry. Within the Chemistry folder create an 
Experiments and a Laboratory folder. Within the Chemistry\Experiments folder create a 
Week3 folder. Refer to lab 6.2.1 to create the LocalUser1 and LocalUser2 user accounts. 
In the first part of the lab, assign permissions to folders based on these folders, users, 
and groups that are created. In the second part of the lab, log on to the system as one of 
the users and test these NTFS permissions. 

The following table shows the final structure that will be created.  

Folder Name and Path Groups Permissions 

Users group Read & Execute 
Chemistry 

Administrators Group Full Control 

Users group Read & Execute 
Chemistry\Experiments 

Administrators Group Full Control 

Users group Read & Execute 

Administrators Group Full Control Chemistry\Experiments\Week3 

LocalUser2 Modify 

Users group Read & Execute 
Chemistry\Laboratory 

Administrators Group Full Control 
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Step 2 

Log on with the administrator account or with an account that has administrator rights, 
and navigate to the folders that were created according to the scenario. 

When at the folder, right-click the folder that permissions need to be modified on, and 
then clicks Properties. The Properties box should be displayed for the folder with the 
“General” tab view. 

Click on the Security tab. 

Step 3 

Next click the Add button to add permissions to user accounts or groups. The Add button 
window will display the Select Users, Computers, or Groups window. Verify that the 
correct computer name is entered.  

In the name box, select the name of one of the user accounts or groups that was listed in 
the scenario, and then click the Add button. This process will need to be repeated for 
each user account and group that is listed (for the appropriate folder) in the previously 
mentioned table. 

Step 4 

Click OK when finished. The Properties dialog box for the folder will redisplay. 

If the Properties box contains user accounts and groups that are not listed in the scenario 
they will need to be removed by selecting them and then clicking Remove. 

Step 5 

This step will specify the permissions for the folders in the scenario. For all user accounts 
and groups that are listed for the folder in the scenario, select the user account or group 
that corresponds to the folder under Name. Then under Permissions, select the Allow 
box or the Deny box next to the appropriate permissions that are listed for that folder in 
the scenario. 

Click OK to save the changes and close the Properties box. 

Repeat this procedure and continue to assign permissions for each folder listed in the 
scenario. 

Close all the boxes and log off of Windows. 

Step 6 

Log on as LocalUser1 and navigate to the Chemistry\Experiments\Week3 folder. Try to 
create a file in the Week 3 folder.  

Could this file be created? __________________________________________________ 

Log off of Windows and log back on as LocalUser1, then navigate to the 
Chemistry\Experiments\Week 3 folder. Try to create a file in the Week 3 folder. 

Could this file be created? __________________________________________________ 
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Log off of Windows and log back on as Administrator, and then navigate to the 
Chemistry\Experiments folder. Try to create a file in the Experiments folder. 

Could this file be created? __________________________________________________ 

Log off Windows and log back on as LocalUser, then navigate to the 
Chemistry\Experiments folder. Try to create a file in the Experiments folder. 

Were you able to create this file? _____________________________________________ 

Log off of Windows and log back in a Local User2, then navigate back to the 
Chemistry\Experiments folder. Try to create a file in the Experiments folder. 

Could this file be created? __________________________________________________ 

Troubleshooting 

Assigning NTFS permissions can be a confusing task when dealing with large amounts of 
data that can be spread out over large volumes. It is a good idea to keep the process as 
simple as possible. When a drive or volume is formatted with NTFS, the Full Control 
permission is assigned to the Everyone group. Change this default permission and 
assign other appropriate NTFS permissions in order to control access to the folders and 
files on the network. 

Reflection 

Why would permissions be used on a computer?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 6.2.4:  Creating an Emergency Repair Disk in Windows 2000 

Estimated time: 20 Minutes 
 
Objective 

In this lab, the student will learn how to create and use an emergency repair disk. 

Equipment 

The following equipment is required for this exercise: 

• A computer system running Windows 2000 

• A blank 3.5 inch floppy disk 

Scenario 

An emergency repair disk needs to be created so that it can be used in the event of a 
computer malfunction. The disk will also have to repair the file systems if they become 
damaged. 

Procedures 

In the first part of this lab, the emergency repair disk will be created. In the second part of 
the lab, the emergency repair disk will be used.  

Step 1 

Run the Backup program. Go to Start > Programs > Accessories > System Tools > 
Backup. Click the Emergency Repair Disk button on the Welcome tab. 

Insert a blank formatted disk into Drive A. 

Check the box labeled “Also Backup The Registry To The Repair Directory”. 

Click OK. Remove the disk and label it “Emergency Repair Disk” and include the current 
date. 

Step 2 

Insert the Windows 2000 CD and boot from the CD. 

Press R to use the Emergency Repair Disk. 

When presented with a Fast or Manual option, press F to select the Fast option. Press 
Enter to use the emergency repair disk. Insert the emergency repair disk and press 
Enter. 

Once the files have been repaired, reboot the operating system. 

Troubleshooting 

If the disk is not the proper type, there might be some difficulty during the emergency 
repair disk creation process. Make sure to use a 3.5-inch HD formatted floppy disk. 
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Reflection 

Why is the Emergency Repair Disk important in the troubleshooting process?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 6.4.3:  Installation Demonstration of Windows 2000 

Estimated time: 90 Minutes 

Objective 

In this exercise, the student will learn how to install the Windows 2000 operating system. 

Equipment 

The following equipment is required for this exercise: 

• A computer with a blank hard disk 

• Windows 2000 installation CD 

Scenario 

The computer file system has become corrupt because the user installed software that 
was infected with a virus. During installation of the software, the virus deleted all of the 
files on the hard drive. The operating system will need to be reinstalled. 

Procedures 

In this lab, the student will learn how to install the Windows 2000 Professional Operating 
System.  

Step 1 

Insert the CD into the CD-ROM drive. 

Next, configure the system BIOS boot sequence to boot from the CD-ROM first. Keep the 
CD in the drive and restart the computer. 

When the system starts up, watch for the message “Press Any Key to Boot from CD”. 
When the message appears, press any key on the keyboard and boot the system from 
the CD. 

The Windows 2000 Setup Screen will display and load the necessary files. 
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This screen will display for a few minutes while the files are copied to the hard drive. 
The Welcome to Setup screen displays next. Press Enter to proceed with the installation. 

 
 

The Welcome to Windows screen will display. Press F8 to agree with the Licensing 
Agreement. 

The next step is to partition and format the drive if needed. This step is not always 
required. For this lab, create a small partition (2 GB) for installing Windows 2000. This will 
make the installation a faster process.  

Select the option to partition the drive first, and then select the option to format the drive 
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with NTFS. 

Setup will begin formatting the partition. 

When partitioning and formatting is complete, the Windows 2000 Professional Setup 
screen will display and start copying the system files to the hard drive.  

 

The system will restart automatically when the files have been copied. When the system 
restarts, the message “Press Any Key to Boot from CD” will display again. Do not press 
any keys at this time.  

The Windows 2000 splash screen will then display. 
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The Welcome to Windows 2000 setup screen will display. Click Next to proceed to the 
Installing Devices screen. 
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When the system is done installing the devices, setup will proceed to the Regional 
Setting screen.  

These settings can be change if required. However, for the purposes of this lab, press 
Next. 

On this screen enter the user name and the name of the company. Click Next. 

Enter the Microsoft product registration key when prompted. Click Next to continue.  

The “computer name and administrator” password screen displays next. Enter the 
computer name and the administrator password. 
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Accept the name suggested by setup, or enter the name assigned to this computer by the 
network administrator. Enter the word “password” for the password. Click Next. 

Enter the appropriate date and time settings for the region. Click Next. 

Setup will now proceed to the Network Settings screen.  
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The networking components will be installed during this phase of setup. When complete, 
click Next, to proceed to the next step. 
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Select the Typical Settings radio button to install the default network settings and then 
click Next. Custom Settings allows other network components to be installed that are not 
used in this lab.  
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The Workgroup or Computer Domain screen allows the user to join a domain. This is 
important when the computer is on a network and requires a domain name and 
password. 

For this lab, select the “No, this computer is not on a network, or is on a network without 
a domain” radio button. Click Next.  

The Performing Final Tasks screen is next. 
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This is the final step of the setup process. This step will take the longest to complete. 
Once it has finished, click Next. 

The computer will automatically restart. Ignore the “Press any Key to Boot from CD” 
message and do not boot from the CD  

The Windows 2000 splash screen will display and the Network Identification Wizard will 
start.  
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Select the “Users must enter a username and password to use this computer” radio 
button.  

This will require all users to have an account created on the computer before they will be 
allowed to log on. Click Next. 

To complete the Network Identification Wizard, click Finish. 

The log on box will display. Log on with the administrator account and password that was 
created during setup.  

The system will now log on and launch the Windows 2000 desktop. 
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Windows 2000 has now been successfully installed.  

Troubleshooting 

Before doing the installation, confirm the proper hardware requirements on the system. 
Also make sure that the operating system is being installed on a blank partition or hard 
drive that has enough space. If the hardware is compatible and there is sufficient space 
on the drive or partition there should not be any problems with the installation. 

Reflection 

Did the Windows installation complete successfully? _______________________ 
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Lab 7.3.2:  Installation Demonstration of Windows XP 

Estimated time: 90 Minutes 

Objective 

In this exercise, the student will learn how to install the Windows XP Professional 
operating system. 

Equipment 

The following equipment is required for this exercise: 

• A computer with a blank hard disk. 

• Windows XP Professional installation CD. 

Scenario 

The IT department has decided to do an upgrade of all the end-user computers to 
Windows XP Professional. The operating systems will need to be reinstalled. 

Procedures 

In this lab, the student will learn how to install the Windows XP Professional operating 
system.  

Note: Some system hardware will require that you use a manufacturer supplied recovery 
disk and procedure for installing the operating system. Refer to manufacturer supplied 
documentation for specific instructions. 

Step 1 

Insert the CD into the CD-ROM drive. 

Next, configure the system BIOS boot sequence to boot from the CD-ROM first. Keep the 
CD in the drive and restart the computer. 

When the system starts up, watch for the message “Press Any Key to Boot from CD”. 
When the message appears, press any key on the keyboard to boot the system from the 
CD. The system will now begin inspecting the hardware configuration.  
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Next, the Windows XP Setup Screen will display and prepare the installation program to 
load the necessary files. 
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These screens will display for a few minutes while the files are being copied to the hard 
drive. 
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The Welcome to Setup screen will display next. Press Enter to continue with the 
installation. 

 
 

After the Windows XP Licensing Agreement screen displays, press F8 to agree with the 
Licensing Agreement and continue with the installation. 
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The next step is to partition and format the hard drive. This step is not always required. If 
you have a partition already created, use the arrow keys to scroll to that partition. Then 
press Enter to install the operating system on that partition. If a partition does need to be 
created, create a small partition (4 GB) to install Windows XP. This will make the 
installation process faster.  

To begin the partition setup process, press C to create a new partition in the 
unpartitioned space.  
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In the space provided, type 4087 to create a 4GB (4087B) partition. Then, press Enter to 
continue with the installation.  

 

For the next step, press Enter to select the option to install the operating system on the 
partition that was just created, this should be the C drive.  
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Next, select the option to format the partition using the NTFS file system. Do not use the 
quick method.  

 

Setup will begin formatting the partition as shown below. 
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When partitioning and formatting is complete, the Windows XP Professional Setup 
screen will display and start copying the system files to the hard drive. 

 

 

The system will restart automatically when the files have been copied. When the system 
restarts, the message “Press Any Key to Boot from CD” will display again. Do not press 
any keys at this time.  
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The Windows XP splash screen will then display. 

 

The Windows XP installation screen will display and begin installing the operating 
system. 
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The next step of the installation will begin installing the hardware devices. Setup will 
proceed to this screen. 

 

Once the devices have been initialized and installed, setup will proceed to Regional and 
Language Options screen. This is where the user can customize the installation based on 
which country they live in or language they speak.  
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After making the proper selections, press Enter and proceed to the Personalization 
screen. 
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When this screen appears, type in the user name on the first line and the organization in 
the second line. Check with the instructor when this point is reached. They may have a 
specified name and organization for you to type in.  

Press the Next button when finished. The next page to appear will be the Product Key 
page. 

Enter the Windows XP product key that came with the installation CD. Then, press the 
Next button to continue.  
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The next screen to appear is the Computer Name and Administrator Password page.  

 

Enter the computer name on the top line and the administrator password on the bottom 
two lines. Click Next. 

The next page to appear is the Date and Time Settings page. 
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Enter the correct date and time. Then, select the correct time zone. 

Click Next to continue.  

The next screen will automatically install the networking components. The setup process 
will first install the network. 
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Next, it will prompt the user to choose the Typical or Custom settings.  

 

For the purposes of this lab select Typical settings. This is the most common selection 
and automatically configures the network settings. If the Custom setting is chosen the 
user must manually configure the networking components. Click Next to continue to the 
next step.  
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The last part of the network configuration in the installation process involves assigning 
workgroup or domain membership. 

 

The Workgroup or Computer Domain screen allows the user to join a domain. This is 
important when the computer is on a network and requires a domain name and 
password. 

Select the “No, this computer is not on a network, or is on a network without a domain” 
radio button. Then, click the Next button.  

This completes the user involvement in the setup of the installation process. This is the 
final step of the setup process. This step will take the longest to complete. Once it has 
finished, click Next. 
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The next steps are all automated and proceed through Copying files: 

 

Completing the installation process: 
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Installing Start Menu items: 

 

Registering Components: 
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Finalizing the installation and saving the configuration settings: 

 

At this point, the computer will automatically restart. Ignore the “Press any Key to Boot 
from CD” message. Do not boot from the CD again. 

The log on box will display. Log on with the administrator account and password that was 
created during setup.  
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The system will now log on and launch the Windows XP Professional desktop. 

 

Windows XP has now been successfully installed.  
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Troubleshooting 

Before beginning the installation, confirm the proper hardware requirements of the 
system. Also, make sure that the operating system is being installed on a blank partition 
or hard drive that has enough space. If the hardware is compatible and there is sufficient 
space on the drive or partition there should not be any problems with the installation. 

Reflection 

Did the Windows installation complete successfully? _______________________ 
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Lab 7.5.2:  Using Simple File Sharing to Share Files 

 
 

Estimated time: 30 Minutes 

Objective 

In this lab, the user will use the simple file sharing techniques and tools that are new to 
Windows XP. This will help a user become familiar with the easy and simplified method 
for sharing resources in a Windows XP network. 

Equipment 

The following equipment is required for this exercise: 

A computer with Windows XP Professional installed 

Scenario 

The IT department has purchased some computers with Windows XP Professional as the 
operating system on the machines. They want you to learn how to share files in the file 
system so you can help other employees.  

Procedures 

Sharing files in the Windows XP Professional file system can be done the same way as 
with Windows 2000, however, Windows XP Professional has added a few extra features 
for file sharing that can be used to make this process a little easier, faster, and more user 
friendly. This lab will show how to use these new features. 

Step 1 

The first step of this lab will show how to turn on the file-sharing feature. File sharing is 
turned on by default in Windows XP.  

1. First, click on Start (Start Menu) and then click on My Documents to open the 
window.  

2. Next, click on the Tools button on the menu list at the top on the screen. Then, 
scroll down and select folder options. This will open the folder options dialog 
box.  

3. Now, click on the View tab. This will allow the user to select various advanced 
folder settings. Scroll through these options and read them to become familiar with 
some of the options that are available and what they do. At the bottom the user 
will see the “Use simple file sharing (recommended)” setting.  
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4. The “simple file sharing” radio button should be checked being that this is the 
default setting. If the user decides at a later date that they did not want to use 
simple file sharing then they would uncheck this radio box to disable it.  

5. Click the OK button to close the folder options box.  

Step 2 

For this step, leave the My Documents window open. Create a new folder called Shared 
Files within My Documents. This will use simple file sharing to enable a folder to be 
shared with other users who have local user accounts on that computer. 

1. Right-click on an open area of the My Documents window and select New > 
Folder. The new folder will appear in the My Documents window. Rename it 
Shared Files.  

2. Next, right-click on the Shared Files folder and select Properties. This will open 
the properties dialog box for the Shared Files folder. Choose the Sharing tab. 
Read through the entire dialog in both the local sharing and security and Network 
sharing and security sections to understand the available options.  

3. Do not choose the “Make this folder private” radio box because this will disable 
access to the folder. Instead, drag this folder to the Shared Documents folder in 
order to share the Shared Files folder.  

4. Click OK to close the properties box of the Shared Files folder. Now, locate the 
Shared Documents folder on the left panel of the My Documents folder. To drag 
the Shared Files folder to this folder, left-click on the Shared Files folder and 
hold it down while dragging it over to the Shared Documents folder. 

5. Now, click on the Shared Documents link on the left side panel. Once this folder 
opens, the Shared Files folder will be in there. Other users who have local 
accounts on this computer will be able to access any files that are put into the 
Shared Files folders.  

6. If it is decided that the folder or files are not to be shared, simply delete them 
from this folder.  

Step 3 

For this step leave the My Documents window open. Use the existing Shared Files folder 
to share.  

1. First, right-click on the Shared Files folder and select Properties. This will open 
the properties dialog box for the Shared Files folder. Choose the Sharing tab. 
Read through the entire dialog in both the Local sharing and security and 
Network sharing and security sections to understand the options.  

2. On the Network sharing and security section, click on the link that states that you 
understand the implications of sharing this on the network. Then, select the “Just 
enable file sharing” radio box. Sometimes this step will be necessary. If a Share 
this folder on the network dialog box is presented, then select this box and 
click Apply.  

3. Next, click on the OK button. Now other users who have access to the network 
workgroup or domain will be able to access files located within this folder.  

4. Now, look at the Shared Files folder. There should be a little hand holding the 
folder. This indicates that the folder is being shared on the network.  
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Reflection 

You have just learned how to use Windows XP simple file sharing tool to share files 
locally on the computer and across the network. In what ways is this easier or better 
than the more traditional way of doing it Windows 2000? How may it be worse? What 
are some of the advantages of using the traditional way of sharing files? 
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Lab 7.5.3a:  Remote Desktop Connection  

 
 

 
Estimated time: 30 Minutes 

Objective 

In this lab, Windows XP Remote Desktop Connection will be used in order to establish a 
remote connection to another computer. 

Equipment 

The following equipment is required for this exercise: 

• Two computer systems with Windows XP Professional installed 

Scenario 

You are the system administrator for the XYZ Company. You have just upgraded some of 
the client PCs on the network to Windows XP Professional. You want to set up the client 
PC for Remote Desktop Administration. This will enable the IT department to provide 
desktop support remotely. 

Procedures 

The instructor will have set up two computers using a cross over cable so that they are 
connected and configured with usable IP addresses and subnet masks. Make sure that 
the computers can communicate using the ping command. Gather the IP configuration 
data from both PCs. The first part of the lab shows how to set up the remote computer 
which will be monitored. The second part of the lab shows how to set up the client 
computer which is the computer which makes the remote connection. 

Step 1: Setting Up the Remote Computer 

First, enable Remote Desktop on the remote computer. The Remote Desktop Connection 
software is pre-installed with Windows XP. To run it, click Start, click All Programs, click 
Accessories, click Communications, and then click Remote Desktop Connection. This 
software package can also be found on the Windows XP Professional and Windows XP 
Home Edition product CDs and can be installed on any supported Windows platform. To 
install from the CD, insert the disc into the target machine's CD-ROM drive, select 
Perform Additional Tasks, and then click Install Remote Desktop Connection.  Next, 
gather the IP information for both computers and record it for Step 2. 

1. Log on with the administrator account or as a user that is a member of the 
Administrator’s group. 
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2. Click Start, click Control Panel, and then double-click on the System icon. In the 
System Properties dialog box, click on the Remote tab. 

3. Under the Remote Desktop section, select Allow users to connect remotely to 
this computer. 

• Note here, that as long as an account has a logon password and that 
account is logged on they can remotely connect to the computer. The 
Administrator or any user that is a member of the Administrator or local 
Remote Desktop Users group can remotely connect to the computer as well. 

4. Click on the Select Remote Users button to change the person who has 
permission to remotely connect to the computer. 

5. Next, select Add. In the empty box, type the username of the account that is 
used to log into the computer and select OK. 

6. Now, gather the IP information. To do this, click on the Start menu. Then, click 
on the Run button. In the blank space, type cmd and then click on OK. This will 
bring up the DOS prompt. At the prompt, type ipconfig/all. This will display the IP 
configuration for the computer. Write down the Host Name and IP Address. Keep 
this information for Step 2. 

7. At this point, the remote computer is set up to receive incoming remote 
connections. 

Step 2: Setting up the Client Computer, when the client computer is running Windows XP 

It is important to note that a user does not have to be using Windows XP Professional on 
the client computer in order to remotely connect to the Remote Computer. However, the 
Remote Computer must be running Windows XP Professional, regardless of what version 
of Windows the client computer is running. In some cases, such as when the Remote 
Computer is running Windows 2000 Server or Advanced Server, terminal services can be 
turned on in order to remotely administer the Server. For purposes in this course, 
Windows 2000 Professional does not have terminal services and therefore cannot be the 
remote computer.  

1. Open the Start menu and select All Programs > Accessories > 
Communications > Remote Desktop Connection. 

2. In the space, type in the IP address of the Remote Computer that you recorded 
in Step 1. Then click the Options tab.  

3. In the user name space, type the username of the account, which has 
administrative access to the remote computer.  

4. Next, click on Connect. At this point, the client computer will attempt to make a 
connection. When a connection is made, a logon screen will appear. The 
username should be there. Type in the password, and then click the OK button.  

Step 3: Setting Up the Client Computer, when the client computer is running Windows 

2000 

1. If the client computer is using a different operating system other than Windows XP 
Professional, it still can be used to remotely connect to a Windows XP system. To do 
this, install the files from the Windows XP Professional installation CD.  

2. Insert the CD into the CD-ROM drive. When the XP menu appears, select Perform 
Additional Tasks, and then select Set Up Remote Desktop Connection.  
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3. The necessary files will be copied to the harddrive and the setup process will be 
complete. 

4.  To make the remote connection, simply follow the steps in Step 2 of this lab. 

Troubleshooting 

For the computers to be able to connect to each other, they must be able to establish 
contact and be able to communicate and find each other on the network prior to running 
the Remote Desktop Connection. This can be done by gathering and recording the IP 
configurations for both computers by typing ipconfig/all at the command prompt. Use the 
ping command to establish that the computers will be able to connect when using the 
Remote Desktop Connection.  

Reflection 

Use the Remote Desktop Connection utility to connect to your work computer from home 
or visa versa. This requires a more advanced knowledge of computer networking 
because it involves establishing a Virtual Private Connection (VPN) through the Internet 
and you must configure the routers and firewalls on both ends to open the proper port 
numbers to allow a Remote Desktop Connection to be established. Windows XP also 
provides a means of making a Remote Desktop Connection to your PC through the 
Internet over the web connection.  

1. What are some advantages of using the Remote Desktop Connection? 

___________________________________________________________________________ 

2. What are some disadvantages or security concerns when using the Remote 
Desktop Connection? 

___________________________________________________________________________ 
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Lab 7.5.3b:  Internet Connection Firewall  

 
 
Estimated time: 30 Minutes 

Objective 

In this lab, you will learn how to use the integrated firewall that is now included with the 
latest releases of Microsoft’s operating systems including Windows XP. You will select 
the proper settings, which allows a user or administrator to secure the integrity of the 
operating system from intruders.  

Equipment 

The following equipment is required for this exercise: 

• A computer system running Windows XP 

Scenario 

The IT department has purchased some new computers with Windows XP installed on 
them. These new computers are going to be used by people in the finance and 
accounting departments of the company. It is important that these computers be as 
secure as possible and that all of the data be protected from intruders. Although proper 
firewalls, filters, and access-lists have been placed on the corporate network incoming 
gateways, these computers need to be secure from internal threats and intruders who 
may reside within the network boundaries. The IT department manager has instructed 
you to implement Windows XP’s integrated firewall on these computers in order to block 
them from intruders.  

Procedures 

Before beginning this lab you also need to be logged in as the administrator or a member 
of the administrators group. It is also important to understand that the management tasks 
we will be covering in this lab apply to other computers that are part of the network and 
these settings affect only the individual computer which these settings are configured on.  

Step 1 

The first step in configuring the Windows XP integrated firewall is to locate and open the 
Network Connections settings located in the Control Panel. 

1. Open the Control Panel using the Start menu. Left-click on the Start button located in 
the lower left side of the screen. Then click on the Control Panel button to open the 
control panel. 
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2. Locate the Network Connection icon in the control panel. Once you have located it, 
double-click on it to open the dialog box. 

3. At this point you should see a Local Area Connection icon. Left-click on this icon 
once to reveal the list of network tasks on the left side of the network connection 
screen. 

Step 2 

In Step 2 we will learn about these various settings and how to open the Internet 
Connection Firewall settings dialog box. 

1. First, left-click once the View status of this connection. 

2. On the General tab you can see the various status settings related to the network 
connection such as status, duration, and speed. You can also disable the network 
connection by clicking the Disable button, however do not so this in this lab. 

3. Next, click on the Support tab. This will show you useful information about the 
network connection such as the address type, IP address, subnet mask, and default 
gateway. Using this information and the information from the previous step will help in 
determining what sort of firewall settings to select, which will be done in the next 
section of this lab. 

Step 3 

In this step we will configure the proper Internet Connection Firewall settings for this 
computer. 

1. First, click back on the General tab and then click the Properties button. This will 
bring up the local area connection properties dialog box where various configurations 
and settings can be made on the network connection.  

2. Next, click on the Advanced tab in the Local Area Connection Properties dialog 
box. At this point you should see the Internet Connection Firewall settings. The first 
thing you may want to do is to click on the Learn more about Internet Connection 
Firewall link. 

3. After reading though the material, close that page and return to the Local Area 
Connection Properties dialog box. Click the check box, next to the Protect my 
computer and network by limiting or preventing access to this computer from 
the Internet settings. 

4. This will make a Settings button appear in the bottom right-hand corner of the Local 
Area Connection Properties dialog box. Click on this Settings button to bring up 
the ICF advanced settings screen. 

5. There are three tabs on this screen. First, we will configure the Services tab. 

6. Click on the Services tab. Select all the boxes that you see. As you select each one, 
a popup box will appear which will allow you to select the name or IP address of the 
computer which is hosting these services on the network. If this were an actual 
production environment instead of a lab, you would need to put the correct 
computer/hostname of the computer that is hosting these services on the network. 
Also note the internal and external port number on these popup windows. These are 
the actual ports numbers that will be closed when you click these boxes. By clicking 
all these boxes you are essentially closing most of the well-known or popular ports 
that intruders can use to access the computer. If this computer were acting as a 
gateway to which other computers used to gain Internet access, closing these ports 
would also disable the access to the other computers that use this computer as a 
gateway. 
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7. Next, click on the Security Logging tab. This tab will allow you to log events such as 
attempts or connections made to the computer.  

8. Click on both the Log dropped packets and Log successful connections boxes to 
enable security logging. 

9. Next click on the ICMP tab. ICMP is commonly used to for error checking and testing 
connectivity of remote computers. Sometimes intruders or hackers use ICMP to 
access or do damage to remote computers. Using this tab, it is possible to disable 
ICMP events or connections from being received and interpreted by this computer.  

10. Select all the boxes in the ICMP tab window. Notice as you select them a description 
of what these various ICMP tasks do appears on the bottom of the ICMP tab window. 
Read these as you select down through them to become more familiar which what 
each one does.  

11. Once you have selected all of these, click the OK button to save these settings and 
close the Advance Settings box. Then click OK on the Local Area Connection 
Properties dialog box to save the settings and close that box. Also click on the 
Close button on the Local Area Connection Status dialog box to close it. Close the 
Network Connection window that was opened in the control panel. 

12. You have now successfully configured the Internet Connection Firewall in Windows 
XP.  

Troubleshooting 

Sometimes when these settings are configured they actually tighten or shut off too much 
access and sometimes actually prohibit the user from doing their job or accessing 
network resources that they otherwise need. In this case it may be necessary to “tweak” 
these ICF settings to that the user has the proper access they require. For this reason, 
careful attention should and must be taken whenever configuring any type of firewall or 
security settings.  

Reflection 

1. What other security tasks would you have to be responsible for implementing in order 
help protect a computer besides using the Internet Connection Firewall? 

___________________________________________________________________________ 
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Lab 7.5.5:  Using the Windows XP Start Menu and Windows Explorer 

 

 
 

Estimated time: 30 Minutes 

Objective 

To explore the basic features of the Windows XP Start menu and Windows Explorer 
Navigation tools. 

Equipment 

The following equipment is required for this exercise: 

• A computer system with Windows XP Professional installed 

Scenario 

The IT department of XYZ Company has installed a computer with Windows XP 
Professional. The company has asked you to run a few tasks to explore the features of 
the new Start menu to ensure that it is running properly. They also want you to learn to 
navigate the file system so that you can help other employees.  

Procedures 

Before beginning this lab, make sure that the Windows XP Professional machine is 
powered on and you can log in. There are many new features that are included in 
Windows XP Professional. Some features such as the Start menu and Control Panel 
have undergone some drastic changes. These changes might make it difficult to use the 
first time using the Graphical User Interface (GUI). Navigating the Windows XP 
Professional file system will be done almost the same as with Windows 2000, however, 
Windows XP Professional has added a few extra features that will help in navigating the 
file system easier and faster. This lab will show how to use the new features of Windows 
XP to navigate the file system.  

Part 1: Using the Windows XP Start menu 

Step 1 

Once the system boots, the Windows XP Welcome Screen will appear. Click on the 
proper username, and then log in with the password.  

When finished entering the password, press Enter. If the password is typed correctly, the 
system will authenticate the user and grant them access. 
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Step 2 

After the system authenticates the user, the desktop environment appears.  

 
 
Notice that the Windows XP Professional desktop environment is different from Windows 
2000. By default, the My Computer, My Documents, My Network Places, and Internet 
Explorer icons do not appear on the desktop. The user can enable these icons to appear 
on the desktop if they wish. This will be done later in the lab.  

Step 3: Using the new Windows XP Start menu 

Using the new XP Start menu can be a little confusing when using it for the first time. 
However, once a user becomes familiar with the new Start menu they will see the 
changes that Microsoft made will help them navigate through the Graphical User 
Interface (GUI) easier. The following tasks will help a user to become familiar with the 
new Start menu. 

1. To get an idea of what the new Start menu looks like, click on the Start menu 
icon located in the bottom left corner of the screen. Notice that the icons that are 
missing from the desktop are now located in the Start menu. The user will also 
see that the Start menu is now divided into two parts. The left side shows a list of 
the programs that are used frequently. The right side shows what is in My 
Computer and My Network Places. It also contains the Control Panel, Printers 
and Faxes, and the search and run function icons. 

2. Click on a few of the programs and open up a few windows to simulate a typical 
environment that a user would have when working on the computer.  
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3. Now, access My Computer by using the Start menu. Click the Start icon, and 
then click on the My Computer icon. Instead of having to close all the windows 
and then clicking on the icon on the desktop, it has been placed in the Start 
menu so that a user can have access to it much quicker.  

4. Now, examine some of the various options that are available to customize the 
Windows XP Start menu. First, right-click on the Start menu icon in the lower left 
bottom of the screen and select Properties.  

5. Next, click on the Taskbar tab. There will be several options to choose from in 
order to change how the Start menu and Taskbar work. Click on some of the 
radio boxes to select or deselect certain options until the Start menu is the way 
you like it. When finished, click the Start menu tab. 

6. Notice that Windows XP provides the option of using the Classic Start menu that 
came with previous releases of Microsoft Windows operating systems. Now, click 
the Customize button. This button provides a new interface to manipulate the 
Start menu. First, change the setting to use Small Icons rather than the large 
ones. Second, deselect the Internet and E-mail radio buttons located on the 
bottom of the dialog box. They will no longer appear in the Start menu. 
Remember, the user can always go back and select these boxes if they would 
like them to be quickly available in the Start menu.  

7. Next, look at the Programs section of this screen the user will see that it is 
possible to change how many programs that are available for quick selection on 
the Start menu. Change the amount to 11, and then click OK. The first box 
should disappear. Click the Apply button and then the OK button. You should 
see the new changes on the Start menu.  

8. Keep in mind that the more a user uses Windows XP; they will learn that the 
majority of the Graphical User Interface (GUI) operations performed will involve 
the Start menu as the starting place. Users will quickly learn that there is really 
no need to have any icons on the desktop. For those who like the icons shown 
on the desktop, Step 4 of this lab shows how to add the icons to the desktop. 

Step 4: Enabling the My Computer, My Documents, My Network Places, and Internet 

Explorer icons 

1. Locate the mouse pointer on the desktop and right-click the mouse. Scroll down 
and click on the Properties button. This will display the system Display 
Properties dialog box. 

2. Next, select the Desktop tab. This will bring you to the menu that will allow a 
user to change the desktop feature.  

3. Now, click on the Customize Desktop button located in the bottom left corner of 
the properties box. This will bring up a dialog box that will allow a user to make 
further adjustments to the desktop. From this point a user can select which icons 
they want to display on the desktop. They may also change what the icon looks 
like or run the desktop cleanup tool. The Web tab allows web pages to be 
displayed on the desktop. A user may also lock the desktop items to prevent 
moving or resizing of web items on the desktop. 

 



118 - 228 IT Essentials I v3.1 - Lab 7.5.5 Copyright © 2004, Cisco Systems, Inc. 

Part 2: Using the Windows XP Windows Explorer navigation tool 

Step 1 

The first feature that a user will want to become familiar with is how to navigate to any 
window without having to close windows or even using Windows Explorer.  

1. Click on the Start menu and then click on My Computer. Notice how the icons 
are arranged differently?  

___________________________________________________________________________ 

2. First, click on the Tools menu on the top of the screen and select Folder options. 
After the Folder Options box opens select the View tab. Then, scroll down until 
you come to the Show Control Panel in My Computer box and make sure it is 
checked. If it is not selected, select it because it is not checked by default. Next, 
click the Apply button. This will allow the user to have the control panel icon in 
the My Computer window.  

Step 2 

1. For this step, leave the My Computer window open. Look down the left side of 
the screen to see the Other Places menu. This shows the other directories that a 
user can navigate to from this window without having to close the current 
window.  

2. First, click on the My Documents icon in the Other Places menu. It will take a 
user to the My Documents window. Do the same thing to navigate back to the My 
Computer window or change to a different window from here as well.  

3. Double-click on the C: drive and open a folder. Use the Other Places menu to 
navigate to different folders and back again, all from one window. 

4. Open the Control Panel from the Start menu. This done by clicking on the Start 
menu icon, and then, click on the Control Panel icon. By default, the icons are 
grouped together by categories.  

5. Now, choose an item from the Control Panel list such as Performance and 
Maintenance. The user will have the option of selecting one of the tasks from the 
list or they can select one of the icons below to compete a specific task. 

Reflection 

In what circumstances might this way of navigating the file system be easier? 

___________________________________________________________________________ 
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Lab 8.2.3:  Upgrading the Video Accelerator 

Estimated time: 30 Minutes 

Objective 

Upon completion of this lab, the student will be able to install a video card with advanced 
capabilities such as 3D, more memory, or AGP (Advanced Graphics Port). Also, the 
student will remove the old video drivers and install new ones. 

Equipment 

The following equipment is required for this exercise: 

• ESD wrist strap 

• The lab computer with Windows 98 installed 

• Standard Phillips-head screwdriver that is not magnetic 

• AGP Video card and driver installation software 

• Motherboard manual 

Scenario 

A computer has limited video capabilities built onto the motherboard or has a very basic 
video card installed. An advanced graphics board must be installed to use 3D graphics, 
or to use a larger desktop, or to use programs that require more video memory. 

Procedures 

This lab involves working with delicate components inside the computer case that are 
very sensitive to static electricity. Once the computer cover has been removed, touch an 
unpainted metal part of the chassis. Before touching ANYTHING else inside the case, be 
sure the ESD wrist strap is on. If the motherboard has video capabilities built in, be sure 
to consult the motherboard manual for instructions on disabling this feature in the BIOS. 
Jumpers on the motherboard may need to be manipulated before proceeding. 

Step 1 

Before installing a new adapter, it is typically necessary to change the current video card 
drivers to basic Windows drivers. To accomplish this, go to Start > Settings > Control 
Panel. Double click System, click the Device Manager tab and locate the video adapter. 
Click the + next to the item to show the name of the device. Next, double-click the device 
to show its properties and click the Driver tab and Update Driver. When prompted, click 
Display a list of all the drivers in a specific location, so you can select the driver 
you want, click Show all hardware locate [Standard Display Adapters], and install 
[Standard VGA 640x480]. Close any open windows and shut down the computer by 
clicking Start, then click Shut Down, then select the Shut Down option and click OK. 

Next, unplug the computer from the wall outlet to make sure it will not be turned on by 
accident. Finally, unplug the monitor cable from the computer. 
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Step 2 

Open the computer case and lay it on its side and locate the expansion slots. 

Step 3 

Remove the screw holding the expansion card access cover in place. Remove the cover 
and set it aside. 

Step 4 

Remove the existing video card from the expansion slot and place it either in an antistatic 
bag or on an antistatic mat. Next, remove the replacement card from its antistatic bag. 
Hold the card by the edges, being careful not to touch any of the components on the 
card. 

Step 5 

With one hand, grasp the top of the card by the metal end that will be attached to the 
chassis by a screw and use the other hand for the top corner of the circuit board. Next, 
place the card edge connector into the PCI or AGP expansion slot, depending on the 
type of video card that you have. Be sure to line up the metal guide on the bottom of the 
card with the small opening where the expansion card access cover was removed. 

Step 6 

Using a back and forth rocking motion and a little bit of pressure, the card should seat 
into the socket fairly easily. Do not use too much force to insert the card edge connector. 
If the card will not seat correctly, remove it and make sure to align everything correctly. 
Then try again. When the card is properly seated, the metal tab will line up perfectly with 
the screw hole. In addition, notice that the card is evenly seated in the expansion slot. 

Step 7 

Either secure the tab with the screws from the access cover or with the screws provided 
with the card. Remove the ESD strap from the computer and fit the case back together. 

Step 8 

Once the computer is back together, plug the monitor cable into the new graphics card. 
Next, plug the computer back into the power outlet and make sure all connecting cables 
are secure. 

Step 9 

Turn on the computer and follow the onscreen instructions. The Windows 9x operating 
system should find New Plug & Play Hardware and try to install the device drivers for it. 
When prompted, insert the disk that came with the video card to complete the software 
installation. Click Yes when prompted to reboot the computer for changes to take effect. 
For video cards that come with a manual, follow the installation instructions of the 
manufacturer. 

Step 10 

Once the computer has rebooted, the video card should be ready for use. Test the card 
by changing the resolution of the monitor or run a 3D application.  
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Troubleshooting 

If the resolution cannot be changed to the expected range, or a 3D application will not 
run, check the device manager to make sure there is no conflict with the new adapter. 
Reinstall the standard VGA driver, reboot, and reinstall the new drivers for the video card. 

Reflection 

What was the most challenging part of this exercise? Why? 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 
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Lab 8.3.4:  Sound Card Installation 

Estimated time: 30 Minutes  

Objective 

Upon completion of this lab, the student will be able to install a sound card in a computer, 
attach the speakers and microphone, and install the proper drivers. 

Equipment 

The following equipment is required for this exercise: 

• ESD wrist strap 

• Your lab computer with Windows 98 installed 

• Standard Phillips-head screwdriver that is not magnetic 

• Sound card and driver installation software 

• Speakers 

• Microphone 

• Motherboard manual 

Scenario 

The computer either has sound capabilities built onto the motherboard or has no sound 
ability at all. The student would like to add a sound card to enjoy the full capabilities of the 
computer’s multimedia files. 

Procedures 

This lab involves working with delicate components inside the computer case that are 
very sensitive to static electricity. Once the computer cover has been removed, touch an 
unpainted metal part of the chassis. Before touching anything else inside the case, be 
sure you are using your ESD wrist strap. If the motherboard has sound capabilities built 
in, be sure to consult the motherboard manual for instructions on disabling this feature in 
the BIOS (or a jumper on the motherboard) before proceeding. 

Step 1 

Shut down the computer by clicking Start > Shut Down, then select Shut Down and 
click OK. Next, unplug the computer from the wall outlet to make sure it will not be turned 
on by accident. Also, unplug any speakers or microphone from the motherboard if it is 
equipped with on-board sound.  

Step 2 

Open the computer case and lay it on its side, locating the expansion slots. The sound 
card can now be installed. 
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Step 3 

Locate an empty expansion slot, and using a screwdriver, remove the screw holding the 
expansion card access cover in place. Remove the cover and set it aside. 

Step 4 

The next step is to remove the sound card from the antistatic bag. Hold the card by the 
edges, being careful not to touch any of the components on the card. 

Step 5 

Grasp the top of the card by the metal end that will be attached to the chassis with one 
hand and the top corner of the circuit board with the other hand. Next, place the card 
edge connector into the expansion slot chosen. Be sure to line up the metal guide on the 
bottom of the card with the small opening where the expansion card access cover was 
removed. 

Step 6 

Using a back and forth rocking motion and a little bit of pressure, the card should seat 
into the socket fairly easily. Do not use too much force to insert the card edge connector. 
If the card will not seat correctly, remove it and make sure to align everything correctly. 
Then try again. When the card is properly seated, the metal tab will line up with the screw 
hole. In addition, notice that the card is evenly seated in the expansion slot. 

Step 7 

Secure the tab with the screw used to remove the access cover. If the CD audio cable 
has not been installed yet, attach it at this time.  

Step 8 

Remove the ESD strap from the computer and fit the case back together. 

Once the computer is back together, plug the speakers into the sound card in the port 
labeled “speakers” or labeled with a small picture of a speaker. Next plug the microphone 
into the port labeled “mic” or labeled with a small picture of a microphone. Now plug the 
computer back into the wall socket and make sure all connecting cables are secure. 

Step 9 

Turn on the computer. The Windows 9x operating system should find New Plug & Play 
Hardware and try to install the device drivers for it. When prompted, insert the disk that 
came with the sound card to complete the software installation. The sound card should 
now be ready to use. 

Step 10 

To test the sound card, click Start > Control Panel. Once the control panel appears, 
double-click the Sounds icon. Click on any sound that has a small speaker icon next to it 
and click the small “play” button next to the preview speaker. If sound is audible, the card 
was installed correctly. If the sound was not heard, double-click the System icon in the 
control panel and click the Device Manager tab.  
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Search for the sound card in the hardware list. Make sure the sound card is listed and 
does not have any conflicts. 

Troubleshooting 

Double check all connections to the sound card making sure the plugs are inserted all the 
way. If the speakers are powered externally, make sure they are plugged into the wall 
and turned on. Double-click the speaker icon on the right-hand side of the task bar to 
bring up the operating system’s volume controls. Make sure the controls are turned up 
and that none of them is muted. If there is a problem in the device manager, remove the 
sound card from the list and restart the computer. This will force Windows to re-install the 
sound card into the list and re-install the drivers. Also, if the speakers are not self-
powered, a jumper on the sound card may need to be set to the amplified position. 

Reflection 

What was the most challenging part of this exercise? Why? 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 
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Lab 9.1.2:  Basic Disk to Dynamic Disk Conversion 

Estimated time: 20 Minutes 

Objective 

Upon completion of this lab, the student will be able to convert a hard drive from a basic 
disk to a dynamic disk. 

Equipment 

The student will need the following items in order to complete this lab: 

• A PC with Windows 2000 Professional installed 

Scenario 

RAID 0 is being set up on the newly purchased home server. Windows 2000 Professional 
is being run as the operating system. There is a 20 GIG hard drive and another one is 
being purchased to set up RAID 0. 

Procedures 

In this lab, the student will convert the hard drive from a basic disk to dynamic disk this 
will enable configuration of RAID 0 striping on the PC. 

Step 1 

Right-click on My Computer and click Manage. 

What window opens up when Manage is clicked? 

__________________________________________________________________ 

Step 2 

In the left windowpane click Storage. In the right windowpane double click the Disk 
Management (local) snap in. 

How many disks does the computer have? _____________________________ 

How many partitions and what are they named? ______________________________ 

What other devices appear in the window? __________________________________ 

Step 3 

Right-click on the local disk (Disk 0) and click Upgrade to Dynamic Disk. In the window 
Upgrade to Dynamic Disk, put a check in the box next to Disk 0, if there is not already 
one and click OK. 

Step 4 

In the window Disk to Upgrade verify that it is Disk 0 and where it says “Will Upgrade” 
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there is a Yes underneath it. 

Step 5 

In the same window click Details in the lower left corner. What does it say? 

__________________________________________________________________ 

Are any volumes contained on Disk 0? 

__________________________________________________________________ 

Step 6 

Click OK to return to the Disk to Upgrade window. Now click Upgrade. A warning window 
will appear asking if the user is sure, click Yes. Now the last warning window will appear 
read it and click Yes also. 

Step 7 

A window will appear saying a reboot will take place to finish, click OK. 

Step 8 

Once the computer reboots it will say “Windows 2000 has finished installing new devices. 
The user must restart their computer before the new settings will take effect.” Click Yes. 

Step 9 

Right-click My Computer and click Manage. Click Storage and then Disk Management 
(local). 

Did it convert to dynamic disk? __________________________________________ 

Troubleshooting 

Click Action in the upper left corner and click Restore Basic Disk Configuration. A 
warning will appear click Yes. 

Can someone convert back to Basic Disk without losing any information? Why? 

__________________________________________________________________ 

__________________________________________________________________ 

Reflection 

Can someone convert back to Basic Disk without losing any information? Why? 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________
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Lab 10.3.1:  NIC Installation 

Estimated time: 30 Minutes 

Objective 

In this exercise, the student will install a Network Interface Card into a PC. The student 
will also configure that NIC to use an IP address. 

Equipment 

The following equipment is required for this exercise: 

• PC with Windows 98 or earlier 

• Network Interface Card with appropriate drivers 

• Anti-static wrist strap 

• Tool kit 

• Windows 98 installation CD-ROM or cab files  

Scenario 

The boss has decided to install a network using the existing company PCs. The 
necessary hardware must be installed on each computer in order for them to be 
networked. 

Procedures 

A PC technician is responsible for upgrading and maintaining PCs for the company. As 
part of this job, a technician often upgrades existing PCs with new hardware to fit the 
company’s changing needs. In order to allow a PC to be networked, one of the first things 
a technician must do is install a Network Interface Card (NIC). A NIC allows a PC to 
access the networking media (cabling, wireless) and communicate with other PCs. 

Step 1 

In order to properly install a NIC, it is important to note several items. First, to prevent the 
NIC from being damaged by electro-static discharge (ESD), it is important to ensure that 
the technician is properly grounded. Wear an ESD wrist-strap that is fastened to the 
metal frame of the PC whenever handling computer components. Also, when handling 
the NIC, only hold it by the edges, and do not touch the gold metal contacts along the 
bottom of the card. 

Examine the NIC. Who manufactured the card?  

__________________________________________________________________ 

Can a model number be identified?  If so, what is it?  

__________________________________________________________________ 
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Can the speed(s) that the NIC operates at be determined? If so, what speed?  

__________________________________________________________________ 

Looking at the end of the card, what type of media connects to it?  

__________________________________________________________________ 

What slot type does the NIC fit into?  

__________________________________________________________________ 

Step 2 

Now that the NIC has been examined, it is time to proceed with the installation. Make 
sure that the PC is shut down and unplugged. 

Remove the cover from the PC. Choose a slot on the motherboard to install the NIC. A 
small metal cover may need to remove from the back of the expansion slot in order for 
the NIC to install properly. The NIC will only install one way. Make sure it is lined up 
properly. Remember that it is possible to damage the NIC or the motherboard if too much 
force is used when pushing the NIC into place. 

After the card is installed, secure the card with a screw and ensure that the card does not 
dislodge when plugging a patch cord in. When finished with the card, replace the cover 
and plug the machine back in. 

Step 3 

Now that the hardware is installed, it is time to install the software. This step will require 
the correct driver for the NIC. A driver is a piece of software that allows an operating 
system to access a piece of hardware, such as the NIC. Depending on the age of the 
NIC, Windows may already have a driver for the NIC. If not, go to the NIC manufacturer’s 
website and download it. Use the information found in Step 1 to ensure the right driver is 
being used. 

Boot the PC. 

Did Windows find new hardware? If no, refer to the troubleshooting section for 
suggestions. _________________________________________________ 

Once Windows finds new hardware it will bring up the “Add New Hardware Wizard” 
screen. Click on Next. Windows will now ask to search for the best driver, or have 
Windows display a list of drivers that it includes. Go ahead and choose “Search for the 
best driver for your device” and click Next. Now specify where the driver is located. If it 
on CD then click CD-ROM drive, or if it is on a floppy disk then click on Floppy disk 
drives. If the exact location is known click on Specify a location and type in the path to 
the driver, or click on Browse and highlight the folder the driver resides in. Once a 
selection has been made, click on Next. Windows will now show the name of the device 
and where the driver is located. Click Next and Windows will then install the driver and 
will display when it has finished installing the software. Then click on Finish, and 
Windows will prompt to reboot. Select OK to continue. 

Note: Windows may require the Windows 98 installation CD-ROM to complete the 
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installation. 

Step 4 

Once the driver has been installed, verify that the NIC was properly installed. To do this, 
use the following directions: 

Right-click over the My Computer icon on the desktop. 

Click on Properties. 

Click on the Device Manager tab. 

Click on the + sign next to Network Adapters. 

Is the name of the adapter listed here? _____________________________________ 

Is anything else listed here? If so, what?  

__________________________________________________________________ 

Step 5 

Now that the NIC is installed it is time to setup TCP/IP. To do this, complete the following 
steps: 

Right-click on Network Neighborhood. 

Click on Properties. 

Where “The following network components are installed” is displayed, scroll down to 
TCP/IP. If TCP/IP is not listed it will need to be installed by following the directions below. 
Otherwise, skip to Step 6. 

Click on the Add tab. 

Click on Protocol and Add. 

Click on Microsoft and then scroll down and highlight TCP/IP. 

Click OK. 

There may be a prompt for the location of Windows setup files. If you are unsure of their 
location, ask the instructor for directions. 

Once TCP/IP has been installed, return to the Network Neighborhood properties and 
configure the IP address. 

Step 6 

Double-click on the TCP/IP listing that also has the NIC listed next to it. 

Make sure that the IP address screen is displayed, and then click on Specify an IP 
address. 
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Enter an IP address and subnet mask that will work within the network. Ask the instructor 
for directions as to which addresses will be used. 

Once the IP address and subnet mask have been entered, click on OK. 

Click on OK on the Network screen, and when Windows prompts to restart, clicks on 
Yes. 

Troubleshooting 

Sometimes Windows will not detect a new hardware device. If that happens the device 
will have to be installed manually. To do this, complete the following steps: 

Click on Start > Settings > Control Panel 

Double-click on Add New Hardware. 

Click Next to begin installing software for the device. 

Click Next to let Windows search for new hardware. 

If Windows still does not detect the new device, it will ask to search for a non plug-and-
play device. Either choose to let Windows search, or choose the hardware from a list. 

Select “No, I want to select it from a list”. 

Click Next. 

Select Network adapters. 

Click Next. 

Select Have Disk and specify the location of the driver. 

If a problem still exists, shut the computer off and make sure that the NIC is physically 
installed correctly. 

A common mistake made by many technicians is accidentally installing the wrong device 
driver. If this happens, the device will usually not work. The easiest solution is to do the 
following: 

Right-click on My Computer. 

Click on Properties. 

Click on Device Manager 

Click on the + sign next to network adapters and highlight the NIC. 

Click on Properties. 

Click on the Driver tab at the top of the screen. 

Click on Update Driver. 
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Follow the prompts in order to install the correct driver. 

Reflection 

As a group, research and list as many NIC card manufacturers and their websites as 
possible. 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

As a group, research and discuss how a subnet mask is used within a network. 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 10.3.3:  Configuring the NIC to Work with a DHCP Server 

Estimated time: 10 Minutes 

Objective 

Upon completion of this lab, the student will be able to configure a Network Interface 
Card (NIC) to utilize Dynamic Host Configuration Protocol (DHCP). 

Equipment 

The following equipment is required for this exercise: 

• Network created from the previous sections in this chapter with Windows 98 or 
earlier and TCP/IP enabled. 

• A DHCP server accessible on the network 

Scenario 

The company wants to expand the number of users they currently have. The company 
will be changing to a dynamic addressing scheme, and will need to begin making the 
necessary changes to the host computers. 

Procedures 

There is a choice between two types of address management within a network. The 
types are static or dynamic. 

Static addressing requires an administrator to physically enter a unique IP address into 
each host on the network. The larger the network becomes the more difficult it may be to 
keep track of assigned addresses. This is especially true if hosts are changing to new 
subnets periodically. 

DHCP is used to automatically assign IP addresses to hosts within the network. A DHCP 
server is configured to automatically assign an address from a range of addresses known 
as a scope. The hosts will request an IP address from the DHCP server, which will then 
assign a unique address. This enables PCs to move around within a network and have 
their addresses changed automatically as needed. It also allows the administrator to 
manage thousands of addresses in the network. 

Step 1 

View the Network Neighborhood properties as described: 

Right-click on Network Neighborhood. Click on Properties. 

Is TCP/IP listed as an installed component? If so, what is the name and model number of 
the NIC it is bound to? 
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Is TCP/IP listed with any other items? If so, list those items. 

__________________________________________________________________ 

__________________________________________________________________ 

Step 2 

View the settings of TCP/IP as described. 

Highlight TCP/IP (make sure it is the one listed with the NIC). 

Click on Properties. 

Is an IP address currently assigned? If so, write down the address along with the subnet 
mask. 

__________________________________________________________________ 

__________________________________________________________________ 

Step 3 

Follow the instructions to change the address from being static to dynamically assigned. 

Click on the radio button labeled “Obtain an IP address automatically”. 

Did anything change on the TCP/IP screen? If so, what? 

__________________________________________________________________ 

__________________________________________________________________ 

Step 4 

Follow these instructions to save the new configuration. 

Click OK on the TCP/IP properties page. 

Click OK on the Network Properties page. 

Click on Yes when prompted to restart the computer.  

If asked to insert a Windows disk in order to install files, ask the instructor for further 
directions. 

Step 5 

After rebooting the machine, follow these instructions to verify the new IP address: 

Note: Check the lights on back of the card. These lights will blink when there is 
network activity taking place. Blinking lights on the NIC is an indication that the 
computer is successfully establishing network connection. 
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Click on Start > Run. 

Type the command winipcfg and click OK. 

Click on the arrow next to NIC adapter. 

Highlight the NIC and Click on the tab that says More Info. 

What is the new IP address and subnet mask? 

__________________________________________________________________ 

__________________________________________________________________ 

What is the IP address of the DHCP server? 

__________________________________________________________________ 

__________________________________________________________________ 

What date was the lease for the address obtained and when does it expire? 

__________________________________________________________________ 

__________________________________________________________________ 

Troubleshooting 

When configuring DHCP on a client computer, the computer might display an error 
stating that the server is unavailable. Should this happen, the easiest solution is to finish 
rebooting the machine and then follow these instructions: 

Click on Start. 

Click on Run. 

Type the command “winipcfg” and click OK. 

Click on the arrow and choose an adapter. 

Click on the Release, which clears an address. 

Click Renew, which requests a new address. 

The machine should now be able to join the network after rebooting. 

Reflection 

As a group, try to think of situations where static addressing would be preferred over 
DHCP. 

Determine any other commands that would show the IP address under Windows 98 or 
Windows NT when using DHCP. 
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A network or PC technician may be required to manage a company’s addressing 
scheme. Static addressing requires a great deal of management on the technician’s part. 
The technician will have to keep track of what addresses are available and which ones 
are in use. Depending on the size of your network, this could become very complicated 
and time consuming. DHCP allows the creation of a range of addresses, and allows a 
server to determine which address a host receives. Should a host be moved to a new 
network, DHCP will assign a new address without the administrator’s intervention. 
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Lab 10.7.2:  Troubleshooting a NIC Using the Ping Command 

Estimated time: 15 Minutes 

Objective 

Upon completion of this lab, the student will be able to use the ping command to test 
connectivity and troubleshoot problems based on ping command results. 

Equipment 

The following equipment is required for this exercise: 

• Several Windows 98 or earlier PCs with networking installed and configured 

• One hub or switch 

• One PC with Internet access 

Scenario 

A PC technician often receives calls from users with complaints about the network. One 
morning a user calls and complains that they are unable to reach anything on the 
network. Because the user is in an office in another building, it is decided to try 
troubleshooting the problem remotely before visiting their office. 

Procedures 

When working with computers that have networking installed, technicians will be asked to 
troubleshoot a variety of problems. Depending on the size of the company, this can 
become quite challenging. If the users are spread out across multiple floors, buildings, or 
even cities, it can become extremely time consuming to visit every office for every 
problem. Luckily, there are utilities that allow a technician to begin troubleshooting a 
problem without leaving the office. 

There are a wide variety of troubleshooting tools available to a technician. Many of these 
tools can be expensive to purchase. However, there are a few utilities that are free and 
come with almost every operating system. One of the most commonly used utilities is the 
Packet Internet Groper (Ping) command. The ping command is used to test connectivity 
between two hosts (PCs). When a device is pinged, a signal is being sent to the device, 
which will then reply back. If the ping is successful, then the connection between the two 
devices is good. If the ping fails, then there is a problem between the devices. 

Step 1 

Open a command prompt as described below. 

Click on Start > Run 

Type the word “command” and click OK  

Type the command ping a.b.c.d (where a.b.c.d is the IP address of the NIC.) 

Was a reply received? _______________________________ 
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How many times did the NIC reply back? ___________________________________ 

How many bytes were used? ____________________________________________ 

How much time did it take to receive a reply? ________________________________ 

What was the maximum Time To Live (TTL)? ________________________________ 

Step 2 

The NIC in a workstation may be pinged by using its IP address, or something called the 
loopback address. The address 127.0.0.1 is reserved as the loopback address and is not 
used on the Internet. Instead, the loopback is an address that pings the NIC installed in 
the workstation you are currently using. 

Type the command ping 127.0.0.1. 

Did you receive a reply back?  

Are the values for bytes, time, and TTL the same as last time? If not, what has changed? 

__________________________________________________________________ 

Step 3 

If the technician can successfully ping the PC address, and the loopback, then the NIC 
and TCP/IP have been successfully installed. Now it is time to test whether or not the 
other hosts within the network can be reached. 

Type ping A.B.C.D (This time A.B.C.D is the address of another workstation within the 
network.) 

Was a reply received a reply back? If not, what was the error message? 

__________________________________________________________________ 

__________________________________________________________________ 

Are the values the same for bytes, time, and TTL, as they were in Step 1? If not, what 
has changed? 

__________________________________________________________________ 

__________________________________________________________________ 

Step 4 

If the technician is able to successfully ping another workstation that means there is a 
good connection between the two machines. However, there are times when using the 
ping command will result in a problem.  

 



138 - 228 IT Essentials I v3.1 - Lab 10.7.2 Copyright © 2004, Cisco Systems, Inc. 

Type the command ping A.B.C.D. (A.B.C.D is an IP address for a workstation outside 
of the network.) 

What message was received? 

__________________________________________________________________ 

__________________________________________________________________ 

What might this message mean? 

__________________________________________________________________ 

__________________________________________________________________ 

Now using a PC with an Internet connection, open a DOS prompt and type ping 
1.1.1.1 

What message was received this time? 

__________________________________________________________________ 

__________________________________________________________________ 

What might this message mean? 

__________________________________________________________________ 

__________________________________________________________________ 

Troubleshooting 

If there is trouble pinging the IP address of the workstation, or if the technician is unable 
to ping the loopback address, then the TCP/IP settings need to be checked. If the TCP/IP 
was not set properly, then the ping function will not work. Check to make sure that the 
protocol is correctly installed and bound to the NIC. 

If there is trouble pinging other hosts within the network, then check the cable and make 
sure that it is correctly plugged into the hub or switch. Check the IP address and the 
subnet mask to make sure they have been entered correctly. 

Reflection 

Once a PC is installed on a network, much of a technician’s time will be spent 
troubleshooting network problems. It is important that a technician try to save as much 
time as possible. Ping is a great utility to begin troubleshooting a problem. Ping will help a 
technician determine whether the network problem is related to a bad cable, an incorrect 
TCP/IP setting, or a problem with a remote device. Make sure to be comfortable using 
the Ping command and its responses. 
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Lab 11.3.7:  Adding an Inkjet Printer to a Computer 

Estimated time: 30 Minutes 

Objective 

In this lab, the student will connect a printer to a PC, install the correct printer driver, and 
verify communication between computer and printer by printing a test page. 

Equipment 

The following equipment is required for this exercise: 

• A computer with Windows 98 installed 

• Inkjet printer with ink cartridges installed 

• Communication cable (USB or parallel) 

• Printer driver(s) 

Scenario 

A PC technician is responsible for the installation of printers throughout an organization. 
The goal is to properly install and configure an inkjet printer with the proper drivers. 

Procedures 

A printer is one of the essential components of a computer system. Whether it is a laser 
printer for high quality text printouts or an inkjet printer for publishing digital camera 
photographs, it is important to know how to install a printer. 

Step 1 

Connect the communication cable to the printer. 

What type of cable will be used to connect the printer to the PC (USB or parallel)? 

__________________________________________________________________ 

Which end of the cable was connected to the printer (USB-A, USB-B, DB-25, or 
Centronics)? 

__________________________________________________________________ 

Step 2 

Connect the communication cable to the computer. 

Which end of the cable was connected to the computer (USB-A, USB-B, DB-25, or 
Centronics)? 

__________________________________________________________________ 
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Step 3 

Power on the printer and make sure it is functioning properly. Turn the computer power 
on and login to Windows. 

Step 4 

After initial logon, Windows should detect the printer. If the computer does not find the 
printer, start the Add Printer wizard by going to Start > Settings > Printers. Double-click 
the Add Printer icon. 

If Windows finishes loading the Desktop and does not detect new hardware, what might 
be the cause?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 5 

Begin the Found New Hardware wizard by clicking Next at the bottom of the window. 
This wizard will lead the technician through the entire printer installation process.  

The next screen in the wizard asks whether the printer is a local or network printer. Select 
local and click Next. 

This will open a window with a list of printer manufacturers and devices. If the drivers for 
the printer are in possession, click the Have Disk button and browse for the location of 
the drivers.  

What type of media contains the printer driver?  

__________________________________________________________________ 

__________________________________________________________________ 

Why are printer drivers rarely located on a floppy disk?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 6 

Windows searches the selected medium for appropriate printer drivers. Driver files found 
will show up in the Driver File Search Results screen. From this screen, select the proper 
driver for the printer and choose Next. 

Why do manufacturers usually include multiple printer drivers on a single CD-ROM?  

__________________________________________________________________ 

__________________________________________________________________ 
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Windows is now installing the printer driver files. An installation progress message might 
be displayed during this phase.  

What are common device driver file extensions?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 7 

The next window will prompt for the port that the printer is connected to. If a parallel cable 
was used, select LPT1. 

What ports are listed other than LPT?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 8 

The Add Printer wizard will now prompt for the printer name. Use either the default name 
suggested by the system or another name to help identify the printer. The name may 
identify the type of printer, the printer location, or anything else that helps to identify the 
printer on the local system. 

Choose whether or not to make this printer the default printer. If more than one printer is 
in used, the default printer should be the one used most often. 

What name was given to the printer?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 9 

The final step is to print a test page. Click Yes to print a test page and then click Finish. 
Depending on the printer being installed, a printer initialization program may run. These 
programs are used to set the print orientation, check to see the type of ink cartridge(s) 
that are installed, and so on. 

Step 10 

Click Finish or Close if the wizard has not already closed. When the test page finishes 
printing, a dialog box will appear asking if the test page printed properly. If it did, click 
Yes. If the results are not readable, click No and follow the printer troubleshooter to help 
solve the problem. 

Step 11 

Check to be sure the printer is installed on the computer. From the Windows Desktop, 
choose Start > Settings > Printers. This will open the Printers folder. 
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Is an icon for the printer just installed visible? If not, see the troubleshooting section of 
this lab.  

__________________________________________________________________ 

__________________________________________________________________ 

Which printer is set as the Default Printer? How can this be checked?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 12 

Double-click on the printer icon. This will open up the print queue. 

Are any print jobs listed in the print queue? Why not?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 13 

Right-click on the printer icon and choose Properties. The printer properties dialog box 
will open.  

What “tabs” are available?  

__________________________________________________________________ 

List two user-selectable options from a tab:  

__________________________________________________________________ 

Step 14 

Click on the General tab. The Print Test Page is near the bottom of the page. Click the 
Print Test Page button. 

After clicking the Print Test Page button, what question did Windows ask? How was it 
answered?  

__________________________________________________________________ 

Step 15 

The inkjet printer has been successful installed on the Windows computer. If not able to 
print a test page, see the troubleshooting section of this lab. 
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Troubleshooting 

If Windows begins the Found New Hardware wizard, but is unable to locate a suitable 
device driver, check the printer driver media. Also, a newer, updated printer driver may 
need to be downloaded from the manufacturer web site. 

If able to install the printer but unable to print a test page using either method in the lab, 
check the communication cable. The cable may be in sufficient condition to allow the 
computer to know it is connected to a printer, but may not be good enough to pass printer 
data. 

The technician may also need to configure the BIOS for the printer to function correctly. 
Some computers will require the parallel port to be set to EPP. To accomplish this, the 
BIOS will need to be configured.  

Reflection 

What is an advantage of a laser printer over an inkjet printer?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 11.4.4:  Setting Up Print Sharing Capabilities 

Estimated time: 20 Minutes 
 
Objective 

Upon completion of this lab, the student will be able to verify communication between the 
server and the client, setup the print server, configure the client, and test the client’s print 
capability. 

Equipment 

The following equipment is required for this exercise: 

• A functional network with at least two computers running Windows. 

• A printer installed on one Windows computer. 

Scenario 

The sales department in a small company currently has a single printer connected to one 
computer. Since the other sales reps need access to a printer, the manager has asked 
the PC technician to make the printer available to the entire sales department. 

Procedures 

The strength of a computer network is the ability to share resources. An example of a 
resource is a printer. Windows allows users to connect and install a printer on one 
computer (the print server) and share it with the other computers (clients) on the network. 
This lab will detail the steps followed to set up print-sharing using Windows. 

Step 1 

On the computer with the printer attached (the server), click Start and Run. In the Run 
dialog box, type Command and press Enter. This will open a Command Line session 
window. 

Step 2 

Type IPCONFIG if running Windows 2000. Type WINIPCFG if running Windows 98. This 
command will present information about the IP address of the computer. 

What is the IP address of the server?  

__________________________________________________________________ 

Step 3 

On the client computer, click Start > Run, type Command and press Enter. At the 
command line prompt ping the server IP address (example: ping 192.168.10.1). 

What is the purpose of using the ping command?  

__________________________________________________________________ 
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Were the ping attempts successful? If not, ensure that both computers are properly 
configured and connected to the network.  

__________________________________________________________________ 

Step 4 

It is important to know the network identification information for the server. To see this 
information, right-click on My Computer, choose Properties, and select the Network 
Identification tab. 

What is the Full Computer Name of the server?  

__________________________________________________________________ 

What is the Workgroup of the server?  

__________________________________________________________________ 

Step 5 

In order for several computers to use the same printer, print-sharing software needs to be 
installed on the server. To do this, return to the Desktop, right-click on Network 
Neighborhood, choose Properties, and then click the File and Print Sharing button. 
Make sure there is a check next to the “I want to be able to allow others to print from my 
printer(s)” option. Once that is checked, click the OK button. Then click OK on the 
network properties window. The computer will prompt the user to restart the machine. 
Click Yes. 

Step 6 

Now that the print sharing software is installed, it is time to configure the particular printer 
for print sharing. From the Desktop, click Start > Settings > Printers to open the Printers 
folder. 

Is the printer available in the folder? _______________________________________ 

Step 7 

Right-click on the icon of the printer to be shared with the client computer. Choose 
Properties, and select the Sharing tab. 

Step 8 

The sharing options are used to make the printer available to clients and give the printer 
a unique name on the network. Choose Shared as and then type in a unique name for 
the printer. 

Why must the name for the printer be unique to the network?  

__________________________________________________________________ 
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What name was the printer given?  

__________________________________________________________________ 

Step 9 

When finished with the sharing options, click OK. 

After clicking OK and returning to the Printers folder, what has changed regarding the 
look of the printer icon and what does this change signify?  

__________________________________________________________________ 

Step 10 

The technician is now ready to begin installing the printer on the client. On the client 
computer, click Start > Settings > Printers to open the Printers folder. 

Step 11 

Double-click the Add Printer icon to begin the Add Printer Wizard. This wizard will walk 
the technician through the process of selecting the shared printer. 

Step 12 

Click Next to get to the printer type screen. On this screen choose Network Printer and 
click Next. This will lead to the wizard that allows the technician to browse the network for 
the printer, or to enter the path to the printer. 

Step 13 

On this screen, type in the path to the printer and choose Next. The path is formatted like 
this: \\server_name\printer_name where the server_name is the Full Computer Name of 
the server and printer_name is the name given to the printer. 

What is the path to the printer?  

__________________________________________________________________ 

After clicking the Next button and returning to the Printers folder, is there an icon for the 
printer?  

__________________________________________________________________ 

Step 14 

The printer has been installed on the client computer. Now, test the communication 
between the client and the printer. 

What are two methods for printing a test page from the client computer?  

__________________________________________________________________ 
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Troubleshooting 

If the computer that a printer is connected to is turned off or is removed from the network, 
the resources that are being shared from that computer will no longer be available. Many 
times it is necessary to have a dedicated print server so that anyone can print to a 
computer at anytime. 

There are various ways of setting up a print server. Some network-capable printers have 
print servers built into them. Other print servers available are very small and can be 
easily hidden between the printer and a desk or wall. 

Reflection 

Why would a company install a network printer instead of purchasing a printer for every 
end user?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 11.5.4:  Managing Files in a Printer Queue 

Estimated time: 20 Minutes 
 
Objective 

Upon completion of this lab, the student will be able to: 

• Open up the printer queue 

• Add jobs to the printer queue 

• Delete a job from the printer queue 

• Rearrange jobs in the printer queue 

• Purge all jobs held in the printer queue 

Equipment 

The following equipment is required for this exercise: 

• A computer with Windows 98 installed 

• An installed printer 

Scenario 

If a document does not immediately print, many computer users will click the print button 
again. They keep clicking the print button until the document prints. This can lead to 
massive amounts of wasted resources. 

Procedures 

In this lab, the student will learn how to manipulate print jobs held in a printer queue. After 
placing jobs in the queue, this lab will cover how to delete single jobs, prioritize jobs, and 
purge the entire printer queue. These skills become necessary when a print job is sent to 
the queue, but is not the correct document that needs to be printed. 

Step 1 

Each installed printer uses a queue to hold print jobs. This is an area of memory and hard 
drive that is used to feed information to the printer. Click Start > Settings > Printers, to 
open the Printers folder. Double-click on the printer being used in this lab. This will open 
up the queue. 

Which printer will be used for this lab?  

__________________________________________________________________ 

What jobs are currently in the printer queue?  

__________________________________________________________________ 
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Step 2 

In the printer queue menu bar, click File and choose Pause Printing. This will cause the 
printer queue to hold all print jobs without sending any information to the printer. Minimize 
the printer queue window. 

Step 3 

To add jobs to the printer queue, create some documents to print. Click Start > 
Programs > Accessories and choose Notepad. 

Step 4 

Using Notepad, type in “Document 1” and save it to the Desktop as “low.txt”. 

Step 5 

Add this document to the printer queue by choosing File > Print. Open the printer queue 
window (it is minimized and available on the Taskbar). 

Is the print job listed in the printer queue?  

__________________________________________________________________ 

Who is the owner of the print job?  

__________________________________________________________________ 

What is the progress of the print job?  

__________________________________________________________________ 

How long will this job stay in the queue?  

__________________________________________________________________ 

Step 6 

Use Notepad to create and print two more documents. Type in “Document 2”, save it to 
the Desktop as “medium.txt”, and print the document. Type in “Document 3”, save it to 
the Desktop as “high.txt”, and print the document. 

How many jobs are now being held in the printer queue?  

__________________________________________________________________ 

Step 7 

Sometimes it is necessary to cancel print jobs while they are being held in the printer 
queue. In the printer queue window, right-click on medium.txt.  

What options are available in the context-sensitive wmenu?  

__________________________________________________________________ 
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Step 8 

Choose Cancel Printing.  

How many jobs are now being held in the printer queue?  

__________________________________________________________________ 

Step 9 

By default, the printer queue handles jobs using first in, first out (FIFO). Sometimes it is 
necessary to give priority to certain print jobs. In the printer queue window, drag low to an 
area below high and release it. 

What is the order of the print jobs held in the printer queue?  

__________________________________________________________________ 

When the printer is set to resume printing, which print job will the printer queue release 
first?  

__________________________________________________________________ 

Step 10 

To delete all jobs held in the printer queue, either delete each single job or choose to 
purge the entire queue. To purge the printer queue, open the printer queue window, 
choose Printer from the menu bar, and click Purge Print Documents.  

How many jobs are now being held in the printer queue?  

__________________________________________________________________ 

Step 11 

Choose the Printer menu and click Pause Printing to release the printer from its paused 
state. Close the printer queue window and delete the low, medium, and high documents 
from the Desktop. 

Troubleshooting 

If unable to place jobs in the printer queue using Notepad, check to ensure that the 
printer queue being viewed is the queue for the current default printer. Notepad is a 
simple application and will only print to the default printer. 

Reflection 

As a network administrator, how would being able to control the print queue help with the 
conservation of resources?  

__________________________________________________________________ 

__________________________________________________________________
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Lab 12.1.2:  Using a Digital Multimeter 

Estimated Time: 30 Minutes 

Objective 

This lab will concentrate on the ability of students to identify and record power supply 
specifications and connecter types. It will also, focus on the use of a multimeter to safely 
test and record voltage readings. 

Equipment 

The following equipment is required for this exercise: 

• Personal computer (no peripherals will be needed) 

• PC hand tool kit 

• Multimeter 

Scenario 

The student is an On-Call Help Desk Engineer for a small computer sales store. A client, 
who purchased a computer from the XYZ company, as well as an extended warranty, is 
having problems with their PC. Based on their description of the behavior of the PC, the 
power supply is suspected. 

Procedures 

For this lab, students will need to compile power supply information as well as test 
procedures. Observe various types of power supply form factors and characteristics. If at 
any time a student is unsure of the procedure, ask the instructor. 

Note: This lab deals with electrical power supplies. Proper care should be taken 
whenever working with a power supply. Also, students should not wear a grounding strap 
when testing the power supply.  

Step 1 

Remove the cover of the computer and properly store the screws. 

Review the precautions and directions on the side of the air can. Use the air sparingly to 
blow the dust out of the power supply and off of all visible surfaces inside the case. Once 
all surfaces are clean, reattach the case cover. 
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Step 2 

Record the following power supply information (found on the power supply label). 

Manufacturer  

Model Number  

Operating Range  

Current at 115 V  

Current at 230 V  

Wattage Rating  

 

Step 3 

Sketch the power supply and identify the 4 main external components of a power supply 
by labeling them on your drawing. 

Step 4 

Name the specific type of Motherboard connector that the power supply is using. 

Step 5 

How many large drive connectors are available on your power supply? 

Step 6 

How many small drive connectors are available on your power supply? 

Step 7 

Identify the large drive connector leads, and then measure their voltage values (ask the 
instructor, if there are any questions related to how to proceed with voltage 
measurements). 

Lead Color Expected Voltage Actual Voltage 
1.    
2.    
3.    
4.    

 

Step 8 

Identify the small drive connector leads, and then measure their voltage values (ask the 
instructor, if there are any questions related to how to proceed with voltage 
measurements). 
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Lead Color Expected Voltage Actual Voltage 
1.    
2.    
3.    
4.    

 

Step 9 

Reflection: Why is it important for a technician to know the different colors and their 
values? 

Step 10 

With the multimeter, measure the voltage on each colored wire of the motherboard 
connectors. Most motherboard connectors will have either two connectors or one long 
connector.  

Use the Table below to record the lead color and their measured voltage  

Note: Do not measure the black leads because they are ground. 

Note the meter lead polarity: Red is positive (+) and Black is negative (-). 

1. Lead Color  Voltage Reading 

2. Lead Color  Voltage Reading 

3. Lead Color  Voltage Reading 

4. Lead Color  Voltage Reading 

5. Lead Color  Voltage Reading 

6. Lead Color  Voltage Reading 

7. Lead Color  Voltage Reading 

8. Lead Color  Voltage Reading 

9. Lead Color  Voltage Reading 

10. Lead Color  Voltage Reading 

11. Lead Color  Voltage Reading 

12. Lead Color  Voltage Reading 

13. Lead Color  Voltage Reading 

14. Lead Color  Voltage Reading 

15. Lead Color  Voltage Reading 

16. Lead Color  Voltage Reading 

17. Lead Color  Voltage Reading 

18. Lead Color  Voltage Reading 

19. Lead Color  Voltage Reading 

20. Lead Color  Voltage Reading 
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Step 11 

Check the continuity from the ground of the power cord socket to the metal base of the 
computer. 

Step 12 

Check the continuity of all three conductors of a power cord from the plug end to the 
female end. 

1. Neutral   _______________ 

2. Hot   _______________ 

3. Ground  _______________ 

Step 13 

Reflection Question: Why measure voltage when troubleshooting a Power Supply? 

Troubleshooting 

One way to determine if a power supply is not functioning properly is to compare the test 
results from what the connector should be reading. A malfunctioning power supply should 
not be opened. Replace the component with a new one of the same power capacity. 

Reflection 

What was learned from this lab that was not known before? 

__________________________________________________________________ 

How can the knowledge from this lab help in the future? 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 12.3.5:  Cleaning Computer Components 

Estimated Time: 25 Minutes 

Objective 

Upon completion of this lab, the student will know the proper procedure to clean 
computer components. 

Equipment 

The following items are needed in order to complete this lab: 

• A computer with a keyboard, mouse, and monitor 

• Mild detergent (a little soap, a lot of water) 

• Cleaning rag 

• Container for the detergent (bucket or spray bottle) 

• Can of compressed air 

• Tool kit 

• Keyboard cap puller (optional) 

Scenario 

As a PC repair technician, the student has been sent to fix a computer that has stopped 
working. A good practice to follow when repairing PCs is to clean the computer before 
leaving it.  

Procedures 

When cleaning electrical components, it is critical to unplug the device before working 
with it. If there is power running to a computer system and a damp cloth is run over it, the 
results could be deadly. 

Step 1 

The first thing that should be cleaned is the inside of the computer case. To begin, unplug 
the power cord if it is not already unplugged. Next, remove the case cover either by 
removing the appropriate screws or latch. When the case is open, it is a good idea to 
keep the case standing vertical or even angled so that when the dust is blown out, it does 
not settle back inside. 

Review the precautions and directions on the side of the air can. Use the air sparingly to 
blow the dust out of the power supply and off of all visible surfaces inside the case. Once 
all surfaces are clean, reattach the case cover. 

Has the inside of the case been thoroughly cleaned? __________________________ 

 



156 - 228 IT Essentials I v3.1 - Lab 12.3.5 Copyright © 2004, Cisco Systems, Inc. 

Step 2 

When cleaning the monitor, the first and most important step is to turn off the unit and 
unplug it from the wall. Once unplugged, it is safe to clean the surfaces with a cloth that is 
dampened with a mild detergent. If the cloth leaves streaks on the screen, there is too 
much liquid. A damp or moist cloth has only enough cleaner to help remove dust and 
clean the surface. Using a dry cloth, wipe down the screen and sides to remove any 
residual cleaning fluid. 

When all sides of the monitor have been cleaned, it is a good idea to let it sit and dry for 
at least a half hour, just in case something may have dripped inside. 

Has the monitor been thoroughly cleaned? __________________ 

Step 3 

The keyboard is the component that has the most physical contact with the user. The two 
areas of the keyboard that should be cleaned are the surface of the keys and the area 
below the keys. 

The fastest way to remove dust and other loose objects from below the keys is to blow it 
out with a can of air. Start at one side of the keyboard and work toward the other side 
until the dust buildup is removed.  

Step 4 

If a liquid such as soda was spilled on the keyboard, the keys will need to be removed in 
order to clean it out. Using a keyboard cap puller, remove the keys in the area where the 
spill occurred and use a cloth to clean up the mess. When thoroughly cleaned, the keys 
can be replaced by positioning them in the correct spot then pressing them down. 

Has the keyboard been thoroughly cleaned? ________________ 

Step 5 

The mouse is one of the most frequently cleaned components on a computer. An optical 
mouse requires less cleaning than a mechanical mouse. 

To clean a mechanical mouse, remove the locking ring on the bottom. The proper 
direction to turn the ring should be indicated by an arrow. Once removed, turn the mouse 
over and catch the ring and ball. 

Observe the two posts that are inside the mouse, which are the x-axis and the y-axis. If 
there is a buildup of dirt on either one of these, use a Q-Tip and some alcohol to remove 
the dirt. 

Step 6 

Once the dirt is removed from the posts, inspect the ball to make sure it is clean. If it 
needs to be cleaned, use a mild cleanser and a clean lint-free rag to clean off the dirt. 
Once the ball is clean and dry, put the ball back into the mouse and return the ring to the 
locked position. 

Has the mouse been thoroughly cleaned? _________________ 
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Troubleshooting 

If dust builds up in a power supply, it could cause the system to malfunction or shut 
down. If the fans stop and the system overheated, internal components can be damaged 
as well. Preventive maintenance can prolong the life of not only the power supply, but 
also the entire system.  

Reflection 

How often should a computer system be entirely cleaned?  

__________________________________________________________________ 

Why should computer systems be cleaned?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 12.4.1:  Using the Scandisk and Defrag Utilities 

Estimated Time: 30 Minutes 
 
Objective 

Upon completion of this lab, the student will be able to scan a hard drive, defragment the 
drive to check for errors, and defragment files using the Scandisk and Defrag utilities. 

Equipment 

The following equipment is required for this exercise: 

• A computer with Windows 98 or 2000 Professional installed 

Scenario 

As a system administrator, the manager expects routine maintenance to be performed on 
all computer systems as necessary. Run the Scandisk and Defrag utilities on the 
appropriate machines to keep them running smoothly. 

Procedures 

If a computer is used on a regular basis and system maintenance is not performed, 
system stability will decrease. As files are created, used, and deleted, the media they are 
stored on may become fragmented. Also, if a file is not properly closed it may leave 
corrupted pieces of data behind. To resolve these problems, the two utilities Scandisk 
and Defrag are included with the Windows operating system. 

Step 1 

The first utility to run is Scandisk. This utility will ensure that any problem files will be fixed 
before the Defrag utility organizes the drive. To start the Scandisk utility, open My 
Computer and right-click on the drive to be checked and choose Properties. Select the 
Tools tab and then click the Check Now button. This will start the Scandisk utility 
(referred to as Error-checking in Windows 2000).  

What types of tests are available in the Scandisk program?  

__________________________________________________________________ 

Which test type is the default? ___________________________________________ 

Step 2 

To begin the scanning, click the Start button. When it is finished, click the Close button. 
If there are errors, see the troubleshooting section of this lab.  

Step 3 

Once Scandisk has completed successfully, the Defrag utility can be run to reorganize 
the files on the disk. To start the Defrag utility, open My Computer and right-click on the 
drive to be defragged and choose Properties. Select the Tools tab and then click the 
Defragment Now button. This will start the Defrag utility. 



159 - 228 IT Essentials I v3.1 - Lab 12.4.1 Copyright © 2004, Cisco Systems, Inc. 

Note: Make sure that the screensaver and any other programs that automatically start 
are temporarily disabled or they can interrupt the defragmenting process. 

Troubleshooting 

If Scandisk reports a cross-linked file or fragments of a file, it may ask how it should 
resolve the problem. There is an option to convert recovered data to a text file. However, 
this will clutter the drive with many text files of garbled information. Select the option to 
discard the information and continue. 

Reflection 

List any other utilities that come with Windows that can help in the preventative 
maintenance of a system: 

__________________________________________________________________ 
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Lab 13.1.7:  The Steps of the Troubleshooting Cycle 

Estimated Time: 25 minutes 

Objective 

Upon completion of this lab, the student will be able to describe the importance of, and 
identify the steps involved in, the troubleshooting cycle. 

Equipment 

This is a written lab. No equipment is necessary. 

Scenario 

The student has just started a new job, as a computer technician, with a small consulting 
group. The company has approximately 50 employees with varying levels of computer 
expertise. As a computer technician, the student’s primary responsibility is to provide 
desktop support to these employees.  

The student has recently gone through job orientation and has received training on the 
procedures for responding to computer problems. The training included an introduction to 
the hardware and software in use, common errors, common symptoms, and using the 
troubleshooting cycle to effectively solve problems.  

The end user is complaining that their computer has stopped responding. It is the 
student’s responsibility to troubleshoot and resolve this problem. 

Procedures 

The troubleshooting steps can be very useful in solving computer problems. Sometimes a 
problem will require common sense and the solution is straightforward. Other times, the 
solution will require a broad level of technical knowledge. In this lab, the student will 
follow the troubleshooting cycle as an example of solving computer problems. The lab will 
begin with step one, which is identifying the problem from the end user. 

Step 1 

After arriving on scene, begin the troubleshooting cycle by defining the problem. Start by 
identifying the general symptoms and then determine the possible causes for the existing 
problem. 

For future references, the student has brought along a notebook to document the 
findings.  

Upon arrival, what environmental factors can be assessed? How is an assessment of the 
environment beneficial?  

__________________________________________________________________ 

__________________________________________________________________ 

Step 2 

The next step is to gather pertinent information from the end user. Initially, ask general 
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questions with the goal of obtaining a broad idea about the computer problem. Questions 
should gain focus as information is obtained from the end user.  

What questions could be asked to obtain a broad idea about the problem?  

__________________________________________________________________ 

__________________________________________________________________ 

After questioning, it is learned that the computer is not producing any sound. Everything 
else appears to be functioning correctly.  

The student can now assume the problem is related to the multimedia (sound) 
capabilities of the computer. What questions could be asked or actions taken to better 
define the problem?  

__________________________________________________________________ 

__________________________________________________________________ 

During questioning, it is determined that the end user has been having problems ever 
since a recent sound card upgrade. The student attempts to reproduce the error by 
playing an audio file. The audio file does not produce any sound. The student inspects 
the audio player and it appears to function correctly. Then, the student visually inspects 
the speaker cables and verifies that the speakers are turned on. The student sees no 
apparent problems with the connected devices and the speakers are turned on. 

Gathering information is by far the most important step of the troubleshooting cycle.  

Step 3 

Given the above scenario, what are the most likely causes of the malfunctioning 
soundcard?  

__________________________________________________________________ 

__________________________________________________________________ 

The user has stated that he is having problems producing sound from his machine and 
there has been a recent upgrade performed on his soundcard. From this information, the 
student can infer the problem is related to the recent upgrade of the sound card. 

It has also been verified that both the audio player and speakers are functioning properly. 
The student has also verified the speakers are connected correctly. Since verifying the 
speakers and audio player are working, the student concludes it is unlikely they are 
causing the problem. The student continues the troubleshooting cycle by creating 
solutions for the apparently bad sound card installation. 

Step 4 

Effectively developing a solution involves gathering correct information, knowledge of the 
computer components, and the ability to recognize symptoms. 

The problem has been isolated to a bad installation of the sound card. 



162 - 228 IT Essentials I v3.1 - Lab 13.1.7 Copyright © 2004, Cisco Systems, Inc. 

Give an example of a solution that might solve this user’s problem:  

__________________________________________________________________ 

__________________________________________________________________ 

The solution should focus around the different aspects of the sound card installation. 
Based on experience, the student is aware that most sound card problems result from a 
bad or outdated driver, improperly installed sound card, or system resource conflicts. 

For example, one solution might be verifying the proper installation of the sound card in 
the PCI slot. If the problem still exists, check for system resource conflicts. Finally, update 
or reinstall the driver. 

Step 5 

The first aspect of the solution involves simply checking the installation of the soundcard.  

What precautions need to be taken before working inside the computer case?  

__________________________________________________________________ 

__________________________________________________________________ 

The student verifies the soundcard has been properly inserted and has good 
connections. It appears to be properly inserted. Experience has taught the student to 
check for obvious solutions first. If the problem still exists, move onto the second aspect 
of the solution, which is to check if there are any system resource conflicts. 

The user is running Windows 98 and the student checks resource conflicts in the Device 
Manager. 

In the Device Manager for Windows 98, what will indicate a system resource conflict?  

__________________________________________________________________ 

__________________________________________________________________ 

The student does not notice any problems and moves on to updating or installing the 
device driver for the sound card. In order to get the latest device driver for the sound 
card, the student visits the website for the sound card manufacturer. The student 
conducts a search for the sound card driver and locates a new driver. This driver is 
different from the one the user installed because it includes a Windows 98 patch that 
resolves known compatibility issues. The student installs the new driver and then reboots 
the machine. 

Step 6 

The fifth step is determining if the problem has been solved. If the problem appears to be 
solved, than the troubleshooting process has been successfully completed. If the problem 
is not fixed, then the student will be required to return to previous steps and continue the 
troubleshooting process. Sometimes, it might be necessary to undo changes made to the 
system and revert to the old configuration. In either case, be certain to properly document 
the results. Documenting the results will help work productivity in the future. 
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After bootup, play an audio file and hear sound out of the speakers. The problem has 
been resolved and the troubleshooting cycle has come to an end.  

Troubleshooting 

What are the steps in the troubleshooting cycle?  

Step 1 - ___________________________________________________________ 

Step 2 - ___________________________________________________________ 

Step 3 - ___________________________________________________________ 

Step 4 - ___________________________________________________________ 

Step 5 - ___________________________________________________________ 

Step 6 - ___________________________________________________________ 

Reflection 

It has been stated that troubleshooting is cyclical. What does this mean?  

__________________________________________________________________ 

__________________________________________________________________ 

Why are the steps in the troubleshooting cycle useful for solving computer problems?  

__________________________________________________________________ 

__________________________________________________________________ 

What is the most important step in the troubleshooting cycle, and why is it so important?  

__________________________________________________________________ 

__________________________________________________________________ 

If the problem exists after the solution has been implemented what steps should be 
taken?  

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 13.2.2:  Identifying POST Errors 

Estimated Time: 20 Minutes 

Objective 

Upon completion of this lab, the student will be able to identify common POST errors. 
The ability to identify POST errors is essential for troubleshooting computers. 

Equipment 

In order to complete this lab, the student will need: 

• An operating computer 

• A mouse 

• A keyboard 

Scenario 

The student is working as a technician for a small medical billing office. The office has 
just bought new computers. The newly purchased computers are all the same make and 
model. The students are to familiarize themselves with the computer and document the 
POST error for the major components. 

Procedures 

To become familiar with POST errors, remove several key components from the 
computer system and then listen for the audible POST errors. POST errors are a series 
of beeps that indicate a failure during startup. If a POST error is heard, the student will 
then document the findings.  

Note: POST errors are dependent on the BIOS. POST errors are not the same 
universally. 

Step 1 

First, remove the keyboard connector from the back of the computer case and reboot the 
system. Listen for any abnormal beeps during startup. 

Was any POST error heard?  

__________________________________________________________________ 

If a POST error was heard, what was the pattern of the beep?  

__________________________________________________________________ 

Note: If one beep is heard during startup this indicates normal operation.  
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Step 2 

Plug the keyboard connector back into the back of the computer case. Next, unplug the 
computer and remove the computer case to expose the internal components. Identify the 
RAM on the motherboard and remove the RAM stick(s). Reboot the machine and listen 
for POST errors. 

Was any POST error heard?  

__________________________________________________________________ 

If a POST error was heard, what was the pattern of the beep?  

__________________________________________________________________ 

Step 3 

Reinstall the RAM and reboot the machine. One beep should be heard, which indicates 
normal operation during the boot process. If any POST errors are heard, verify the RAM 
was properly replaced and try again. 

Step 4 

After the machine boots normally, turn the power off and unplug the computer. Identify 
and disconnect the floppy drive. Remove the connectors for both the ribbon cable and the 
power supply that connect to the floppy drive. Reboot the machine and listen for POST 
errors. 

Was any POST error was heard?  

__________________________________________________________________ 

If a POST error was heard, what was the pattern of the beep?  

__________________________________________________________________ 

Step 5 

Unplug the computer and reattach the floppy drive connectors and reboot the machine. 
One beep, which indicates normal operation, during the boot process, should be heard. If 
any POST errors are heard, verify the floppy drive has been properly connected and try 
again.  

Step 6 

After the machine boots normally, turn the power off and unplug the computer. Identify 
and remove the video card from the motherboard. Reboot the machine and listen for 
POST errors. 

Was any POST error heard?  

__________________________________________________________________ 
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If a POST error was heard, what was the pattern of the beep?  

__________________________________________________________________ 

Step 7 

Unplug the computer, replace the video card, and reboot the machine. One beep should 
be heard, which indicates normal operation during the boot process. If one beep is heard, 
replace the computer case. If a POST error is heard, verify the video card was properly 
replaced and try again. 

Troubleshooting 

Computer technicians need to be familiar with POST errors and their implications. 
Technicians need to be aware of any unusual sounds during the boot process because it 
could be an indication of a failure during initial diagnostic tests. In many cases, these 
unusual sounds are the first sign that a failure has occurred.  

Reflection 

When will POST errors occur?  

__________________________________________________________________ 

What sound is made during a normal boot process?  

__________________________________________________________________ 

Are POST errors dependant on the BIOS installed?  

__________________________________________________________________ 
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Lab 14.7.4:  Booting into Safe Mode 

Estimated Time: 25 Minutes 

Objective 

Upon completion of this lab, the student will be able to boot the PC utilizing the advanced 
troubleshooting options of Windows 2000. 

Equipment 

The following equipment is required for this exercise: 

• An operational computer that is running Windows 2000. 

Scenario 

The student is the system administrator for the XYZ Company, and upon arriving at work 
in the morning there is a call from an end user stating that a “system boot failure” error 
message is being displayed. 

Procedures 

Booting the computer into Safe Mode, bypasses the normal startup sequence of 
Windows. Part of this process involves timing. When the black and white Starting 
Windows bar is on the screen, press the F8 key before the system begins loading 
Windows. 

Step 1 

Power-on the computer. 

Step 2 

When the computer is running through the boot process, a series of different startup 
screens are displayed. In order to get into Safe Mode in Windows 2000, press F8 while 
the black and white Starting Windows bar appears at the bottom of the screen. The 
Starting Windows bar will display after the BIOS has been loaded. 

What is the name of the menu that displays?  

__________________________________________________________________ 

What are the options that are available on this menu?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Step 3 

Next, select the Safe Mode option by using the arrow keys up or down and press Enter. 
Windows will load to the Safe Mode environment. Read the window carefully and press 
OK. 

Step 4 

Windows loads into the Safe Mode desktop environment. However, since Windows only 
loads basic drivers in Safe Mode, the graphics will be in VGA mode. 

Does the desktop appear to be in VGA mode? _______________________________ 

How are the video settings checked? 

__________________________________________________________________ 

__________________________________________________________________ 

Step 5 

Access the Device Manager to check the loaded drivers. To access the Device Manager, 
click on Start > Settings > Control Panel > System > Hardware > Device Manager. 
The Device Manager will open displaying the hardware components.   

Step 6 

After the Device Manager is open, check to see if any devices are conflicting. Conflicting 
devices will have a yellow exclamation point next to them. 

Are there any conflicting devices? ________________________________________ 

Step 7 

Verify that no network drivers have been installed. To verify the network drivers, click on 
the “plus (+)” sign next to Network Adapters. A list of devices should display. Right-click 
on a device, select Properties, and a Device Properties window will appear. 

What does the Device Properties window display for Device Status? 

__________________________________________________________________ 

__________________________________________________________________ 

Troubleshooting 

Booting a PC into Safe Mode is often used by computer technicians when they are 
troubleshooting a problem. Safe Mode helps technicians identify and diagnose problems. 
If the problem is not present in Safe Mode, then it is probably related to settings or 
drivers.  

Safe Mode loads only generic drivers during the loading of the OS. It will load basic 
drivers for the mouse, video display, mass storage, keyboard, and the default services. 
Booting a PC into Safe Mode does not load network devices or connections by default. 
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However, the PC can be booted using the “Safe Mode with Networking” to establish a 
network connection.  

Reflection 

What key is pushed to enter into Safe Mode in Windows 2000?  

__________________________________________________________________ 

What is the main difference between Safe Mode and normal operation?  

__________________________________________________________________ 

Why might Safe Mode be an effective troubleshooting tool?  

__________________________________________________________________ 
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Lab 14.7.5:  Using the Windows 2000 Recovery Console 

Estimated time: 30 Minutes 

Objective 

In this lab, the student will learn how to use and implement the Windows 2000 Recovery 
Console.  

Equipment 

The following equipment is required for this exercise: 

• A computer system running Windows 2000 

Scenario 

The student is the system administrator for the XYZ Company, and upon arriving at work 
in the morning there is a call from an end user stating that a “system boot failure” error 
message is being displayed. To fix the problem, run the Windows 2000 Recovery 
Console to repair any boot file that may be damaged. 

Procedures 

In the first step of this lab, the system boot failure will need to be created. In the second 
step of the lab, the Recovery Console will be used to repair the system boot failure that 
was created in the first step. In the third part of the lab, the Recovery Console will be 
installed and some of the Recovery Console commands will be utilized. 

Step 1 

First, turn off/disable system protection. Double-click My Computer, then select Tools> 
Folder Options. 

In the Folders Options display box, click on the View tab. 

With the View tab selected, change the defaults for viewing hidden and system files. To 
do this, click the Show hidden files and folders radio button. Also, uncheck Hide 
protected operating system files (Recommended). 

Next, rename the Ntldr file to Oldntldr. To do this, click on Start >Search >for Files and 
Folders. In the Search for files and folders named: field type ntldr. 

When the file shows up on the right screen, right-click on the file and select Rename. 
Rename it to Oldntldr.  

Restart the computer. An error message should be received when the computer is 
restarted.  

Step 2 

Make sure that the Windows 2000 installation CD is in the CD-ROM drive and then 
restart the computer. Change the BIOS settings to boot from the CD-ROM. 

When the Setup Notification message appears, Setup will now display the Welcome To 
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Setup screen. 

Press R to repair a Windows 2000 installation using the recovery console. The Windows 
2000 Repair Options screen displays. 

Press C to start the Recovery Console. Next, type 1 and then press Enter. At the prompt, 
enter the administrator’s password and then press Enter.  

A C:\Winnt command prompt appears. Type cd .. then press Enter. This will change 
to the root folder (C:\). 

Type copy Oldntldr Ntldr at the command prompt and press Enter.  

Type exit and press Enter. The computer will reboot and should start normally. 

Step 3 

Log on to the system with the Administrator account.  

Insert the Windows 2000 Professional CD into the CD-ROM drive. Close the Windows 
2000 window when it displays.  

Go to Start > Run and in the box type D:\i386\winnt32 /cmdcons and then click 
OK. The Windows 2000 Setup message box will display. Note that the CD-ROM drive 
letter might vary depending on the system configuration. 

Click Yes to install the Windows 2000 Recovery Console. Windows 2000 Setup installs 
the Windows 2000 Recovery Console to the hard disk. 

Click OK to close Setup dialog box. 

Step 4 

Restart the computer and select “Microsoft Windows 2000 Recovery Console” from the 
boot loader menu.  

The Windows 2000 Recovery Console will start up and prompt for the Windows 2000 
installation to log on to. There should only be one choice to choose from at this point. 
Enter the administrator password when prompted and then press Enter.  

Type help and press Enter to see the list of available commands. Find the Listsvc 
command and use it to view all of the available services. 

Type Listsvc at the command prompt (at the end of the list) and press Enter to view a 
list of available services. Press Esc to stop.  

Type disable /? and then press Enter. This command disables any Windows system 
service or driver. 

Type disable alerter and then press Enter.  

The Alerter Service will now be disabled. Note the lines of text advising that the “Alerter 
service” has been changed. Type exit and then press Enter to restart the computer. 
Boot into Windows 2000. 
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Now that the Alerter Service has been disabled, it will need to be restarted. 

Log on to the system with the Administrator account.  

Navigate to the Computer Management window. There are two ways to access the 
Computer Management window: 

Go to Start > Programs > Administrative Tools >Computer Management.  

OR 

Go to Start > Settings > Control Panel > Administrative Tools >Computer 
Management. 

Next, expand “Services And Applications” by clicking the plus (+) sign and then click 
Services. 

Double-click Alerter, change the “Startup Type” option to “Automatic”, and then click OK.  

Right-click Alerter, and then click Start. Close the Computer Management window. 

Troubleshooting 

The recovery console is a very useful tool when troubleshooting problems. If the system 
stops responding or will not boot properly, it is a good place to go while troubleshooting 
the issue. 

Reflection 

Give an example of a problem that could be solved using the recovery console: 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Lab 14.10.3:  Windows Registry Backup and Recovery 

Estimated time: 20 Minutes 
 
Objective 

In this lab, the student will learn how to back up and perform a recovery of the registry. 
These files are also referred to as the System State files.  

Equipment 

The following equipment is required for this exercise: 

• A computer system running Windows 2000 

Scenario 

As the system administrator for the XYZ Company, a new software package is to be 
deployed onto a manager’s system. This software has not been tested, however it is 
known that it will make changes to the registry. The first step is making a backup of the 
system state files in case the software corrupts the system. 

Procedures 

The first step is to use the Windows Back Up Wizard to select the files that are to be 
backed up and then to perform the back up. Second, modify the registry. It is possible 
that the system will not work after these changes to the registry are made. Lastly, use the 
backup to restore the system state and registry files. 

Step 1 

Log on to the Server with the Administrator account  

When the systems boots up, Click Start, and then click Run.  

In the Run dialog box, type ntbackup and then click OK. The Backup dialog box should 
appear. 

Take a minute to read the three descriptions under the Welcome tab, and then click the 
Backup Wizard button. The Backup Wizard should start. 

Click Next, to display the What To Back Up screen. Select the type of backup to be 
performed. 

Click the Only back up the System State data button, and then click Next. At this point, 
the Where to Store the Backup screen will display. Select a place to save the file when 
prompted. This should be a pre-designated folder for backup files.  

The Completing The Backup Wizard screen should display. This screen shows the 
details of the backup that will be performed. At this point, additional changes can be 
made. Click the Advanced button. 

When the Type Of Backup screen appears, make sure that Normal is selected and that 
the Backup Migrated Remote Storage Data box is not checked. 
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Click Next. The How To Backup screen should display. Verify the backed up data after 
performing the backup. 

Select the Verify Data After Backup check box, and then click Next. 

The Media Options page will display. Specify whether to append this backup job to 
existing media or overwrite existing backup data on the destination media at the prompt. 
Click the Replace The Data On The Media With This Backup button.  

Click Next. Now the Backup Label screen displays. Supply a label for the backup job and 
for the backup media. Windows will supply a backup label and media label by using the 
current date and time by default. 

In the Backup Label text box, type System State set created on xxx (where xxx is 
today's date and time). Do not change anything in the Media Label text box. Click Next. 

When the When To Back Up screen displays, choose whether to run the backup job now 
or schedule this backup job. For this lab, select the Now radio button. Click Next.  

When the Completing The Backup Wizard screen displays, click Finish to start the 
backup job. 

Windows Backup will display the Selection Information dialog box, indicating the 
estimated amount of data for the backup and the time to complete it. 

The Windows Backup displays the Backup Progress dialog box, which shows the status 
of the backup operation, statistics on estimated and actual amount of data being 
processed, the time that has elapsed, and the estimated time that remains for the backup 
to complete. 

When the backup is complete, click the Report button. A backup report will be displayed. 
The backup report contains key details about the backup operation, such as the time it 
started and how many files were backed up. When finished, close Notepad.  

Close the Backup Progress dialog box and the Backup dialog box as well. 

Step 2 

Go to Start > Run. Type in Regedt32 in the box. The Registry Editor window should 
open.  

Expand the HKEY_LOCAL _MACHINE Registry Key. 

Right-click the Hardware Folder and select Edit, then Delete. 

Close the Registry Editor Box. The system is officially broken. In reality, only a virus 
would be able to damage the registry like this. The point is that changes to the system 
can result in changes to the registry. With the backup, the system can be restored.  

Step 3 

Locate the Backup file that was saved in Step 1 of this lab. 

Double-click on that file. The Backup Utility Wizard displays.  
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Click on the Restore Wizard button. The Welcome to the Restore Wizard screen 
displays. Click Next. 

The What to Restore wizard screen will displays. Expand the File. Find the backup file 
that was created with the proper date and time and expand that as well. Click on the 
System State check box. Click Next. 

On the Completing the Restore Wizard screen click on Advanced. 

On the Where to Restore screen, make sure that original location is selected. Click Next. 
If the Restoring System State will always overwrite files unless restored to a different 
location screen displays. Click OK. 

Click on the Replace existing files if they are older than the backup files radio button. 
Click Next.  

Verify that all three radio buttons are selected, then click Next, then click Finish.  

The restore will begin by coping the files back to the system showing the progress 
results.  

When the restore wizard completes, the report can be viewed by clicking the Report 
button. Then click Close. 

When prompted to restart the system, click Yes. The system will restart. 

Troubleshooting 

Always back up the registry when installing new software. If something is changed or 
removed in the registry that affects the system, using the backup to fix it can save hours 
of troubleshooting. 

Reflection 

How can backing up the system state files save time?  

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 

__________________________________________________________________ 
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Worksheets 

Worksheet 1.3.8:  Windows Navigation and Settings 

1. It is extremely important not to power off the computer while the operating system is 
still running using the ________________ _______________. 

2. The main display screen in Windows is known as the ________________. 

3. The ________________ contains the start button, quick launch buttons, and the 
clock. 

4. The ________________ menu allows you to access virtually every program and 
function on the PC. 

5. To adjust the date and time, double-click on the ________________ on the right 
side of the________________ . 

6. Most applications have three tiny icons in the upper right corner of the screen that are 
used to ________________ the screen, ________________ the screen, or 
________________ the application. 

7. To adjust the screen display, first________________ all windows that are open. 
Right-click on an empty space on the ________________ and choose properties. 

8. To access the volume control, click on the ________________ icon on the right 
side of the ________________. 

9. To move a desktop icon to another position on the desktop, click on it and then 
________________ it to the desired location. 

10. Once highlighted, you can rename icons, like folders, by clicking on the 
________________ and then typing in a new one. 

11. To create a new folder, ________________ the desktop and then select New > 
Folder. 

12. The ___________________ bar displays the name of the document and application. 

13. The ___________________ bar contains menus for manipulating the document, such 
as creating new documents, copying text, inserting images, and so on. 

14. The ___________________ bar shows useful information, such as page number, 
whether the file is being saved, how to access the Help feature, and so on. 

15. The ___________________ bars appear when the document is too large for it to fit on 
the screen and are used for moving the image or text through the window. 
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Worksheet 1.5.9:  Number Systems Exercises  

1. Define the following: 

Decimal:  _______________________________________________________ 

Binary:  ________________________________________________________ 

Hexadecimal:  ___________________________________________________ 

2. Explain how binary and hexadecimal numbers are used with computers. 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

3. Without using a calculator, convert the binary numbers into decimal numbers. 

A. 01111011  ________________ B. 00000111  ________________ 

C. 11110000  ________________ D. 10101010  ________________ 

E. 01010101  ________________ F. 10010011  ________________ 

G. 00111001  ________________ H. 11111111  ________________ 

I. 11010101   ________________ J. 10000000  ________________ 

 

4. Convert the decimal numbers into binary numbers.  

A. 23 ________________ B. 131  ________________ 

C. 3  ________________ D. 234  ________________ 

E. 79  ________________ F. 199  ________________ 
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5. Convert the decimal numbers into hexadecimal numbers.  

A. 16 ________________ B. 131  ________________ 

C. 3  ________________ D. 234  ________________ 

E. 65 ________________ F. 255  ________________ 

 

6. Convert the hexadecimal numbers into decimal numbers.  

A. 27   ________________ B. AA  ________________ 

C. 3     ________________ D. F1  ________________ 

E. 241  ________________ F. 255  ________________ 
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Worksheet 1.6.6:  Lab Safety Checklist 

Fill in the blanks in the following lines: 

1. The workspace for an IT technician should be large enough to accommodate the:  

a. _____________________________________________________________ 

b. _____________________________________________________________ 

c. _____________________________________________________________ 

d. _____________________________________________________________ 

Near the workbench, power outlets should be available to accommodate the system 
unit power and the power needs of other electrical devices. 

2. The workspace should maintain a humidity level of _______________ percent to 
reduce the likelihood of ESD. 

3. The workbench should be a _______________________ surface. Additionally, it 
should have a flat cleanable surface. 

4. The workspace should be distant from areas of heavy ______________ equipment 
or concentrations of ________________. 

5. The workspace should be free of _________________. __________________ 
can contaminate the workspace, causing premature damage to computer 
components. The work area should have a filtered air system to reduce _________ 
and contaminants. 

6. Lighting should be adequate to see small details. Two different illumination forms are 
preferred, such as an adjustable ________ with a shade and ______________ 
lighting. 

7. Extreme variations of ____________________ can affect a computer's 
components. ________________ should be maintained consistent with the 
components' specifications. 

8. Properly ___________ AC electrical current is essential. Power outlets should be 
tested with an outlet tester for proper grounding. 
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Worksheet 2.3.2:  PC Power Supply 

1. The most basic function of the PC power supply is to convert ____________ current 
to _____________ current.  

2. What is the purpose of the cover panels?  

_______________________________________________________________ 

_______________________________________________________________ 

3. Drives, like CD-ROMs and DVD-ROMs, are inserted into bays or racks that are 
typically _________inches wide.  

4. What are some factors to consider when purchasing a computer case? 

a. _____________________________________________________________ 

b. _____________________________________________________________ 

c. _____________________________________________________________ 

d. _____________________________________________________________ 

e. _____________________________________________________________ 

f. _____________________________________________________________ 

g. _____________________________________________________________ 

5. In Europe, the standard outlet delivers ________________Volts AC, while in North 
America the standard wall outlet delivers ________________Volts AC. 

6. What rating do computer power supplies have?  

____________________________________________________________________ 

____________________________________________________________________ 

7. What are the two most common power supply types?  

a. _____________________________________________________________ 

b. _____________________________________________________________ 

8. What is the importance of the power supply fan?  

_______________________________________________________________ 

_______________________________________________________________
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Worksheet 2.3.8:  BIOS/ROM  

0. The BIOS serves as the interface between the ___________________ and the 
________________________. 

0. The detailed instructions needed for system start-up are stored in 

______________________________________________________________ . 

0. What does BIOS stand for? 

_______________________________________________________________ 

0. What does ROM stand for? 

_______________________________________________________________ 

0. What special characteristic do EPROM, EEPROM, and Flash ROM have? 

_______________________________________________________________ 

_______________________________________________________________ 

0. What differentiates RAM from ROM?  

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 
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Worksheet 2.3.9:  Expansion Slots 

0. What are expansion slots? 

_______________________________________________________________ 

0. Expansion bus is also referred to as a (an)? _________________________ or 
____________________. 

0. An expansion bus is used to add _______________________ to existing systems.  

0. List five different types of expansion slots:  

a. _____________________________________________________________ 

b. _____________________________________________________________ 

c. _____________________________________________________________ 

d. _____________________________________________________________ 

e. _____________________________________________________________ 

0. Define the term “Plug and Play”. 

_______________________________________________________________ 

_______________________________________________________________ 

0. Name three common types of expansion cards: 

a. _____________________________________________________________ 

b. _____________________________________________________________ 

c. _____________________________________________________________ 

0. Name the three bus types: 

a. _____________________________________________________________ 

b. _____________________________________________________________ 

c. _____________________________________________________________ 

0. An ISA bus was developed with both _________ bit and _________ bit bus speeds. 

0. Which bus type supports bi-directional communication? 

_______________________________________________________________ 
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0. What does PCI stand for? ___________________________________________ 
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Worksheet 2.4.2:  RAM and RAM Sockets 

1. Memory chips in a computer system are referred to as _________________.  

2. RAM is the industry standard abbreviation for ________________________ . 

3. Define volatile as it applies to RAM:  

______________________________________________________________ 

______________________________________________________________ 

______________________________________________________________ 

4. Name the two basic types of RAM: ________________, ________________ 

5. Which type of RAM needs to be re-energized constantly in order to retain its 
contents? _________________________________ 

6. Define RAM parity: ________________________________________________ 

______________________________________________________________ 

7. _______________________ refers to the process by which the computer rewrites 
data to RAM.  

8. Describe the physical difference between a SIMM and DIMM chip: 

_______________________________________________________________ 

_______________________________________________________________ 

9. Define memory caching: 

_______________________________________________________________ 

_______________________________________________________________ 
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Worksheet 2.5.2:  Video Cards 

1. A video card converts a ________________________ signal into a 
_________________ signal.  

2. Video cards are also known as __________________ or __________________.  

3. The video card receives its data from the _________________ and sends it to the 
_______________. 

4. __________________ provides video during boot up until the necessary video 
drivers can take over. 

5. The abbreviation “CRT” stands for  ___________________________________. 

6. List the three colors mixed together within the CRT to produce all other colors:  

a. _____________________________________________________________ 

b. _____________________________________________________________ 

c. _____________________________________________________________ 

7. How closely the pixels are grouped, which translates to how sharp the picture 
appears, is referred to as ________________________.  

8. VGA and SVGA video adapters use a standard ______________-pin connector to 
connect to the monitor. 

9. The term “pixel” stands for 

______________________________________________________________ 

10. The term “VGA” stands for 

______________________________________________________________ 
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Worksheet 2.7.1:  Floppy Drive 

1. Explain what a floppy drive is used for in a computer: 

_______________________________________________________________ 

____________________________________________________________________ 

2. Define the following parts of a floppy disk drive: 

a. Read/Write Head- 
____________________________________________________________ 

____________________________________________________________ 

b. Logic Board- 
____________________________________________________________ 

____________________________________________________________ 

c. Stepper Motor- 
____________________________________________________________ 

____________________________________________________________ 

d. Case-  
____________________________________________________________ 

____________________________________________________________ 

e. Hub-  
____________________________________________________________ 

____________________________________________________________ 

f. Lever-  
____________________________________________________________ 

____________________________________________________________ 

1. List the different parts of a floppy disk: 

a.____________________________________________________________ 

b.____________________________________________________________ 

c.____________________________________________________________ 

d.____________________________________________________________ 
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2. What type of cable is used to connect the floppy drive to the motherboard? 

_______________________________________________________________ 

3. How many floppy drives can a computer support on a ribbon cable? ____________ 

4. What type of power supply connector is used to supply power to the floppy drive? 

_______________________________________________________________ 
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Worksheet 2.7.2:  Hard Drive Identification 

1. Explain what a hard drive is used for in a computer 

_______________________________________________________________ 

2. Define the following parts of a Hard Drive: 

a. Cover mounting screw holes- 
____________________________________________________________ 

____________________________________________________________ 

b. Spindle- 
____________________________________________________________ 

____________________________________________________________ 

c. Read/Write heads- 
____________________________________________________________ 

____________________________________________________________ 

d. Platter- 
____________________________________________________________ 

____________________________________________________________ 

e. Actuator- 
____________________________________________________________ 

____________________________________________________________ 

f. Actuator Arm - 
____________________________________________________________ 

____________________________________________________________ 

g. Base Casting- 
____________________________________________________________ 

____________________________________________________________ 

h. Disk Platters- 
____________________________________________________________ 

____________________________________________________________ 

1. In revolutions per minute (rpm), how fast do hard drives spin? 

_______________________________________________________________ 
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2. Flux is the ______________  ______________  ______________ in the media. 

3. What is RLL?  

_______________________________________________________________ 

_______________________________________________________________ 
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Worksheet 2.7.3:  CD-ROM Identification 

0. Explain how a CD-ROM is used:  

_______________________________________________________________ 

_______________________________________________________________ 

0. List and define the following components of a CD-ROM: 

 . Spindle- 
____________________________________________________________ 

____________________________________________________________ 

 . Tray Motor- 
____________________________________________________________ 

____________________________________________________________ 

 . Laser Lens- 
____________________________________________________________ 

____________________________________________________________ 

 . Spindle Motor- 
____________________________________________________________ 

____________________________________________________________ 

 . Tracking Drive- 
____________________________________________________________ 

____________________________________________________________ 

 . Laser Pickup Assembly- 
____________________________________________________________ 

____________________________________________________________ 

0. List three common CD-ROM speeds found in computers and identify their transfer 
rate. 

a. ____________________________________________________________ 

b. ____________________________________________________________ 

c. ____________________________________________________________ 

0. What type of power connection is used on a CD-ROM drive? __________________ 
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0. What is the audio out cable on a CD-ROM connected to in the computer? 

______________________________________________________________ 

0. How much information can be stored on a CD-ROM? _______________________ 

0. Which type of interface controllers used by CD-ROM is capable of faster transfer 
rates – IDE or SCSI? __________________________________________ 
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Worksheet 3.3.4:  Power Supplies 

1. Depending on the type of case and motherboard selected, the power supply must 
adhere to the same ________ ___________ requirements in order to fit inside the 
case and correctly power the motherboard and other devices. 

2. Some fans can change direction to allow air to be blown directly on the ________ 
and to regulate the quality of the air entering the case. 

3. The two basic types of power supplies are  ________  and  ________ 

4. Match each component with the voltage from the power supply unit that it uses. 

1.  ____  Motherboard    a.  –5V 

2.  ____  Disk Drives    b.  +3.3V 

3.  ____  Serial Port Circuits   c.    0V 

4.  ____  ISA bus cards    d.  +12V 

5.  ____  Most newer CPUs    e.  +5V 

6.  ____  Ground     f.  –12V 

5. An AT power supply produces how many different levels of DC voltage? 

_______________________________________________________________ 

An ATX power supply produces how many different levels of DC voltage? 

_______________________________________________________________ 

6. Match each voltage with the correct color wire. 

1.  ____  Yellow     a.  0V 

2.  ____  Red     b.  –5V 

3.  ____  Blue     c.  +3.3V 

4.  ____  White     d.  +12V 

5.  ____  Black     e.  +5V 

6.  ____  Orange     f.  –12V 

7. Never attempt to repair a defective power supply.  _______________ inside a 
power supply box store electricity and will discharge through  the body if touched. 

8. The ATX motherboard is a _____-pin keyed connector. 
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9. The AT motherboard has two _____-pin connectors. 

10. The ATX motherboard directs air _________________ of the computer case. 

11. The AT motherboard directs air ________________of the computer case.  

 

 



194 - 228 IT Essentials I v3.1 - Worksheet 3.9.1 Copyright © 2004, Cisco Systems, Inc. 

Worksheet 3.9.1:  What is BIOS? 

1. The acronym BIOS stands for _______________________________________ 

2. The BIOS code is typically embedded in a ________ chip on the motherboard. 

3. ____________ BIOS allows the upgrade of the BIOS software from a disk provided 
by the manufacturer without replacing the chip. 

4. Configuration of the BIOS on a computer is called the __________ or 
___________. 

5. Without the correct code and_____________  _______________, the system will 
either not boot properly or work inconsistently with frequent errors. 

6. The acronym POST stands for  _______________________________________ 

7. Any problems during the POST are indicated by the BIOS displaying 

_______________________________________________________________ 

8. BIOS initially runs basic device test programs and then seeks to _______________ 
these devices. 

9. Circle all that are correct: 

0. BIOS contains the software required to test hardware at boot up. 

0. BIOS contains the software required to execute windows applications and access 
user files. 

0. BIOS contains the software required to support the transfer of data between 
hardware components. 

0. BIOS contains the software required to support hard drive and floppy drive data 
storage. 

0. BIOS contains the software required to start up the operating system. 

10. BIOS is saved in the chip on the motherboard (even when the power is turned off) by 
a ______________. 

 



195 - 228 IT Essentials I v3.1 - Worksheet 4.1.3 Copyright © 2004, Cisco Systems, Inc. 

Worksheet 4.1.3:  Operating System Fundamentals 

Answer the following true or false questions: 

1. ______ Two or more users running programs and sharing peripheral devices, such 
as a printer, at the same time is known as multitasking. 

2. ______ Multitasking is a computer’s capability to run multiple applications at the 
same time. 

3. ______ When a computer has two or more CPUs (Central Processing Unit) that 
programs share, it is known as multiprocessing. 

4. ______ Multithreading is not the capability for a program to be broken into smaller 
parts that can be loaded as needed by the operating system. 

5. ______ Multithreading allows individual programs to be multitasked. 

6. ______ UNIX has been around since the 1960s. 

7. ______ Computers that are not capable of handling concurrent users and multiple 
jobs are often called “network servers” or simply “servers”. 

8. ______ The file management system is what the OS uses to organize and manage 
files. 
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Worksheet 4.2.3: DOS Commands 

Match each command with the function it performs. 

1. ____DIR   a.  Copies a file 

2. ____CD   b.  Displays memory properties 

3. ____MD   c.  Displays the status of a disk 

4. ____RD   d.  Changes the attributes of a file 

5. ____DEL   e.  Copies one floppy disk to another 

6. ____REN   f.   Formats a disk 

7. ____SET   g.  Displays the contents of a directory 

8. ____MEM   h.  Sets the system time 

9. ____COPY   i.   Prints a text document 

10. ____TYPE   j.   Opens a file for editing 

11. ____FDISK   k.  Removes a directory 

12. ____TIME   l.   Deletes a file 

13. ____DATE   m. Creates a new directory 

14. ____CHKDSK  n.  Renames a file 

15. ____DISKCOPY  o.  Displays the contents of the environment variables 

16. ____EDIT   p.  Changes to a specified directory 

17. ____FORMAT  q.   Program used to format and partition fixed disks 

18. ____PRINT  r.   Displays the contents of a text file 

19. ____ATTRIB  s.   Sets the system date 
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Worksheet 4.2.7:  DOS 

True or False: 

1. ____  DOS is an acronym for Data Operating Service. 

2. ____  All generations of Windows to date support DOS commands. 

3. ____  DOS is user friendly. 

4. ____  DOS can only run a single program at a time. 

5. ____  DOS can run very large programs. 

6. ____  DOS is an essential tool used extensively for troubleshooting. 

7. ____  DOS files on a disk are stored in what are known as “folders”. 

8. ____  DOS records the location of every directory and file on a disk in a table 
called the “FAT”. 

9. ____  DOS files are referred to by filenames comprising up to 8 characters and 
an extension. 

10. ____  DOS filenames and their extensions are separated by a dash (-). 

11. ____  DOS has a main directory on the disk known as the “tree directory”. 

12. ____  The root of the C drive is represented by “C:\”. 

13. ____  The directory name and filename are separated by a slash (/). 
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Worksheet 5.1.10:  Windows Files and Folders 

1. A _________________ and a _______________ are equivalent terms for the 
same concept. They are places to store files. 

2. The __________ directory is the master folder that contains all the other folders. 

3. Names of early Windows 3.1 and DOS filenames are limited to _____ letters plus a 
______ letter extension, but Windows 98 and later allow extended filenames of up to 
________ characters. 

4. Drive letters use the 26 letters of the alphabet followed by a colon.  _____ and 
_____ are reserved for floppy drives, while _____ is for the hard drive. 

5. By _________-clicking on an item on the desktop or in Explorer, options will appear 
such as Copy, Move, or Create Shortcuts. 

6. _______________ give immediate clues as to the creation or last modified date of a 
file or folder, type of item, and size of the file. 

7. To highlight several files at one time, hold down the ______ key and click on those 
files you want to select. 

8. To unselect a file within a group of selected files, hold the ______ key and then click 
on the highlighted file you want to de-select. 

9. To select all files, select __________ from the menu on the toolbar, and click Select 
All. 

10. _______________-click on a file to open it. 

11. To copy a file or folder onto a floppy disk, _____________-click on the file and 
click____________ ______, then click 3 ½ Floppy. 

12. Until you ____________ the Recycle Bin, the files are still in the folder on the hard 
drive. 

13. Files can be _________________ from the Recycle Bin to the original folder that 
stored the file. 

14. ____________-clicking on the Recycle Bin brings up a menu, which allows easy 
emptying. 
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Worksheet 5.2.2:  Managing Printers 

1. To add a new printer, you will need to click on the Start button, go to Settings, 
choose Printers, and then select______________________________. 

2. The six steps to adding the local printer using the Add Printer Wizard in Windows 98 
are: 

Step 1 Select ___________ printer. 

Step 2 Locate the __________________ on the manufacturer and model list. 

Step 3 Select the printer ____________. 

Step 4 _____________ the new printer, especially if there are many printers being 
used. 

Step 5 If you wish, you can set this printer to be the __________________ printer, 
if it is the one most commonly used printer. 

Step 6 Print a ____________ page. 

3. You can access the print manager by clicking on the _______________ icon on the 
right side of the taskbar. 

4. You can access the print manager by going to the ________________ folder under 
Settings on the Start menu, then _______________-click on the printer you are 
using. 

5. Sometimes you will encounter a printer ________________. Then a pop-up 
________________ appears to let you know what it is. 
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Worksheet 5.4.2:  Preparing the Hard Drive  

Match each vocabulary word with its correct definition. 

1. _____ Primary Partition  . This is the collective name for all tracks having 
the same number in a hard disk drive when 
several disks are stacked and rotate on a 
common spindle. 

2. _____ Extended Partition  . The area on each logical DOS disk where the 
information to boot the operating system is 
recorded. 

3. _____ Active Partition  . A special file that is created and located in the 
disk’s sector 0 where DOS stores information 
about the disk’s directory structure. 

4. _____ Logical Drive  . The first partition on a DOS disk (usually 
contains an operating system). 

5. _____ FDISK  . A 512 byte “chunk” of space on a DOS disk. 

6. _____ Boot Sector  . The partition DOS refers to at boot up. 

7. _____ Partition Table  . The process that creates a blank File Allocation 
Table and root directory structure on a DOS 
disk. 

8. _____ Track  . A physical separation of information within an 
extended partition. 

9. _____ Sector  . The process that marks off the disk into sectors 
and cylinders, and defines their placement on 
the disk. 

10. _____ Cluster  . The partitioning program for MS-DOS. 

11. _____ Cylinder  . The partition that is normally assigned all the 
available space left on a DOS drive. 

12. _____ FAT  . Concentric circles on the disk surface created by 
formatting a hard drive. 

13. _____ Low-level Format  . Two or more sectors on a single track. 

14. _____ High-level Format a. A record of the starting point of each logical 
drive, active partition, and master boot record. 
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Worksheet 5.6.6:  Troubleshooting Windows Installation 

1. Isolate the problem as either ____________________or ___________________ 
related. 

2. If, after installing the OS and not receiving a successful boot, first attempt to restart 
the machine using the ______________________ button. 

3. To learn more about setup errors, refer to the__________________.TXT file that 
comes with the Windows installation disks or CD. 

4. The computer’s System Properties gives __________ categories of information, 
each represented by a tab. 

5. The ___________________   ______________________ in Windows provides a 
graphical interface representation of the devices configured in the system. 

6. A device ___________________ is software specially designed to enable the 
computer to use the hardware or devices installed within the system. 

7. What is a Windows startup disk? 

_______________________________________________________________ 

_______________________________________________________________ 

8. To create a Windows 98 startup disk, double-click on___________________ from 
the control panel window. 

9. In addition to the critical operating system files copied to the Windows 98 startup disk 
during creation, what three important disk utilities for troubleshooting are added? 

 ____ Scandisk.exe ____ Msd.exe  ____ Mem.exe  

 ____ Win.com  ____ Autoexec.bat ____ Format.exe 

 ____ Win.ini  ____ System.ini ____ Fdisk.exe 

 ____ Config.sys  ____ Bootlog.txt ____ Setup.txt 

10. When the “Save Uninstall Information” option is selected during Windows 98 setup, 
setup creates the __________________ .dat and __________________ .ini files 
that contain the uninstall information. 
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Worksheet 8.1.6:  Multimedia Devices 

Match each device with its appropriate description: 

_____Video Card A. Transforms digital information into analog 
signals and applies them to an audio 
preamplifier. 

_____Microphone B. Takes pictures and movies that can be 
broadcast on the Internet or sent to someone 
through email. 

_____Speakers C. An interface used by a computer to 
communicate with a musical instrument. 

_____Web Cam D. A device used to read and write data to 
compact disks. 

_____DVD E. A device used to input and record sounds to 
a computer. 

_____Video Capture Card F. An integrated circuit card in a computer or, in 
some cases, a monitor that provides digital-
to-analog conversion. 

_____Sound Card G. Changes analog signals into sound waves. 

_____MIDI H. An optical recording media used for storing 
enormous amounts of data. 

_____CD-RW Drive I. A device used to record from video sources 
outside the computer. 
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Worksheet 8.2.5:  Video Accelerators 

1. RAMDAC is an acronym for: 

_______________________________________________________________ 

_______________________________________________________________ 

2. The RAMDAC converts _______________ signals into ____________________ 
signals. 

3. The video card receives data from the ____________ and sends it to the 
__________. 

4. CRT is an acronym for 

_______________________________________________________________ 

5. A CRT uses ____________, __________________, and __________________ 
to produce all other colors. 

6. VGA is an acronym for: 
_______________________________________________________________ 

7. AGP is an acronym for: 

_______________________________________________________________ 

8. The AGP interface is a variation of the __________ bus design that has been 
modified to handle the larger data throughput associated with three-dimensional 
__________________  

9. What is refresh rate?  

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 
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Worksheet 8.3.3:  Sound Cards 

1. The RAMDAC receives the processed __________________ information and 
converts it to an __________________ signal 

2. Two computer peripheral devices that send a signal to the sound card are the 
______________________ and the ________________________ . 

3. The quality of the sound card depends on the number of _________ used to hold 
each sound sample, or the sample size. 

4. Sound cards generally have sampling rates from about ______________ to 
___________________ samples per second. 

5. Two of the methods used to convert digitally stored sound into realistic analog sound 
are _____________________  _________________________ synthesis and 

 _____________________ synthesis. 
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Worksheet 8.4.7:  CD and DVD Terminology 

1. CD-ROM is an acronym for _____________________  _______________ 
______________  ________________  ____________________________. 

2. DVD is an acronym for _______________________.  _____________________  
__________________. 

3. With a CD-R, data is written _______________ on a light-sensitive material by a 
powerful, highly focused _________________  _______________. 

4. Single-speed drives transfer data at a rate of __________ kb per second. 

5. A CD-RW drive labeled 48x24x16 ______________data at 48x, ______________ 
data at 24x and ______________data at 16x. 

6. A typical DVD has a capacity that ranges from _______ GB to _________ GB. 

7. Match each recording format with its media. 

1. ____ Yellow Book   a.  Interactive CD 

2. ____ Red Book    b.  Enhanced CDs 

3. ____ Orange Book   c.  Digital Computer Data 

4. ____ Green Book   d.  Digital Music CD 

5. ____ Blue Book    e.  Magneto Optical, Write Once, and  
                                                                      Re-writable drives  

 

 

 



206 - 228 IT Essentials I v3.1 - Worksheet 9.1.4 Copyright © 2004, Cisco Systems, Inc. 

Worksheet 9.1.4:  RAID 

1. What is hardware based RAID? 

_______________________________________________________________ 

_______________________________________________________________ 

2. What is software based RAID? 

_______________________________________________________________ 

_______________________________________________________________ 

3. Below each of the pictures that follow, indicate if it is: RAID 0, RAID 1 mirroring, 
RAID 1 Duplexing, RAID 5, RAID 1/0. 

 

___________________________________ 
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___________________________________ 

 

 

___________________________________ 
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___________________________________ 
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Worksheet 9.4.3:  Adding Processors 

1. How do you check the motherboard to see if it can support a faster clock speed? 

_______________________________________________________________ 

2. To add another processor to a multiprocessor-capable network server, the new 
processor must meet what criteria? 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

3. The seven steps for adding additional processors: 

Step 1 _________________________________________________________ 

Step 2 _________________________________________________________ 

Step 3 _________________________________________________________ 

Step 4 _________________________________________________________ 

Step 5 _________________________________________________________ 

Step 6 _________________________________________________________ 

Step 7 _________________________________________________________ 

4. On a Windows NT and Windows 2000 Server the _____________ has to be 
updated before multiple processors are added. 

5. What number from the processor label can you use to look up Intel web sites to 
identify the processor currently in your network server? ____________ 

6. When upgrading a single processor to a faster single processor, may the BIOS need 
to be upgraded? True / False  ____________ 

7. What two ways is the processor identification utility available? 

_______________________________________________________________ 

_______________________________________________________________ 

8. Can Novell support multiple processors? ________________________ 
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9. What are the steps taken to enable multiple processors in Novell? 

_______________________________________________________________ 

_______________________________________________________________ 

10. What must be done in Linux to be able to support multiple processors? 
_____________ 

11. What command will show you the current processor information? 
_________________ 
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Worksheet 10.2.5:  Types of Networks 

1. What is the definition of a network? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

2. What is the definition of a computer network? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

3. Provide a brief definition for each of the terms: 
 

LAN:  __________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

WAN: __________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Circuit-switched network: ____________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Packet-switched network:  ___________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Client/Server Network: _____________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 
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Peer to Peer:  ____________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Hybrid network:   __________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

4. On a LAN, what are the rules for coordinating the use of the medium called? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

5. Define CSU/DSU: 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

6. A data channel, over which data can be sent, can operate in one of three ways, 
name them: 
_______________________________________________________________ 

_______________________________________________________________ 
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Worksheet 10.4.2:  Network Topology 

1. What is the difference between physical topology and logical topology: 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

2. Describe the following topology: 
 

Bus:  __________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Star: ___________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Extended Star:  ___________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Ring:  __________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Mesh:   _________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Hybrid: _________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 
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3. What is the definition of networking media? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

4. What does the term “architecture” refer to? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

5. In a Token Ring implementation, what is the purpose of the “monitor of the ring”? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 
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Worksheet 10.6.5:  OSI Model, TCP/IP, Protocols 

1. What does OSI stand for? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

2. How does the OSI model work and include an example: 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

3. Explain the purpose of each of the seven layers of the OSI model: 
 

Application:  _____________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Presentation:  ____________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Session: ________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Transport:   ______________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Network: ________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

Data Link: _______________________________________________________ 
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_______________________________________________________________ 

_______________________________________________________________ 

Physical:  _______________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

4. What is a protocol? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

5. For what purpose was the original TCP/IP designed? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

6. How does TCP/IP differ from the OSI Model? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

7. Explain application protocols:  
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

8. Explain transport protocols:  
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

9. Explain network protocols:  
_______________________________________________________________ 

_______________________________________________________________
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Worksheet 10.8.7:  Connecting to the Internet 

1. Explain the difference between synchronous and asynchronous: 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

2. What is the definition of a modem? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

3. List the four main types of modems: 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

4. There are three activities that occur during the local command and online state of a 
modem. List them: 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

5. What are AT commands? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

6. What does ISP stand for and what role does an ISP play in the Internet?  
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 
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7. What does vBNS stand for and what role does the vBNS play in the Internet?  
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

8. Explain the major differences between DSL and cable modems:  
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 
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Worksheet 11.6.1:  Paper Jams 

True or False 

1. ____ Fragments of paper that are torn in the printing process often must be 
removed from the paper path. 

2. ____ Failing parts that drive paper movement may cause paper to crumple or z-
fold in the process of moving through the path. 

3. ____ Paper clumping is when one page sticks to another because the toner was 
not fused to the paper correctly. 

4. ____ A paper jam cannot occur when the wrong type of paper is used because 
the printer will not accept it through the registration rollers. 

5. ____ Most of the problems in laser printers that require service are rooted in the 
paper dust that is accumulated in the paper path. 

6. ____ Because there are static charges present in the laser printing process, dust 
will not accumulate outside the paper path. 

7. ____ If there is toner residue on the printer, use a wet towel to clean the affected 
area. 

8. ____ Stepper motors are usually trouble free. 

9. ____ Poor solder connections on stepper motors have been known to cause 
intermittent operations. 

10. ____ Very few paper jams are caused by improper paper type or weight. 
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Worksheet 12.1.4:  Environmental Considerations 
 

1. Explain why batteries need special disposal guidelines. 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

2. Explain why monitors need special disposal guidelines. 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

3. Explain why chemical solvents and aerosol cans need special disposal guidelines. 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

4. Inkjet printer cartridges and laser printer toner cartridges can be _______________ 
and  ________________. 

5. MSDS is an acronym for? 

_______________________________________________________________ 

6. What is the MSDS used for? 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

7. MSDS contains information on: 

 . ____________________________________________________________ 

 . ____________________________________________________________ 

 . ____________________________________________________________ 

 . ____________________________________________________________
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Worksheet 12.2.1:  Electrostatic Discharge (ESD) 

1. ESD is an acronym for  _________________  _________________ . 

2. Most computer chips run on less than ________ volts of electricity. 

3. Always use _________________ _________________ to temporarily store 
computer parts and components until they are ready to be reinstalled. 

4. Devices such as grounding _____________ __________ form a connection 
between a person and to the earth, which gives a place for the static to go before it 
attacks a sensitive computer component. 

5. When the humidity is _________ the potential for ESD increases dramatically. 

6. If the temperature is cool or if there is carpeting on the floor, there is a ___________   
_________________ potential for static electricity. 

7. When working on a computer, one of the first things a person should do when the 
case has been opened is to _________________ themselves to the case by 
touching an exposed unpainted metal part of the computer case. 

8. A good working area should have a climate control system that maintains the relative 
humidity between ________ % and ________ %. 

9. When working on high voltage equipment, such as a power supply or a CRT monitor, 
a ______________ ______________ should NOT be used. 
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Worksheet 12.3.5:  Preventive Maintenance for Components 

1. The majority of preventive maintenance is  _______________________  . 

2. A problem with dust is its capability to be  _______________  charged. 

3. If the wrong types of cleaners are used, damage from  _________________  could 
occur over time. 

4.  ____________  __________  can be a very useful tool to quickly and easily clean 
out a dusty computer. 

5. To fully protect your files from virus infection, the virus  _________________ list 
must be up to date. 

6. If you are going to work on a laser printer that has been in use, let it ____________ 
for a while before coming in contact with the internal components. 

7. Define the following terms: 

 . blackout –  

____________________________________________________________ 

____________________________________________________________ 

 . brownout –  

____________________________________________________________ 

____________________________________________________________ 

 . electrical noise –  

____________________________________________________________ 

____________________________________________________________ 

 . spike –  

____________________________________________________________ 

____________________________________________________________ 

 . surge –  

____________________________________________________________ 

____________________________________________________________ 
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 . surge suppressor –  

____________________________________________________________ 

____________________________________________________________ 

 . standby power supply –  

____________________________________________________________ 

____________________________________________________________ 

 . uninterruptible power supply –  

____________________________________________________________ 

____________________________________________________________ 
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Worksheet 13.1.2:  Troubleshooting Basics 

1. Troubleshooting is a process of diagnosing a ___________ and finding and 
implementing the correct ___________ , which results in restoring the system to its 
original operational state. 

2. The Troubleshooting Cycle 

 . _______ the problem  

 . Gather  _______ 

 . _______ a solution 

 . _______ a solution 

 . Is the problem solved? 

• Yes – Document your observations and results 

• No – undo changes and  _______ steps a-d 

 . ___________ 

3. Why is using the structured approach provided by the troubleshooting cycle beneficial 
in solving computer related problems? 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 
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Worksheet 13.3.2:  Troubleshooting Printers 

True or False: 

1. ____ Problems with dot-matrix printers related to the print quality are some of 
the most difficult to identify. 

2. ____ Because dot-matrix printers are relatively simple devices, there are only a 
few problems that usually arise. 

3. ____ With dot-matrix printers, a common cause of a paper jam is a piece of 
paper that has torn off and lodged in the paper path. 

4. ____ Stepper motors are not sensitive to stray voltages. 

5. ____ In a dot-matrix printer, lines of print will be unevenly spaced if the main 
motor is damaged. 

6. ____ Print quality is the most common problem associated with ink jet printers. 

7. ____ Black lines present in every line of text on a printed page are caused by a 
plugged hole in at least one of the small, pinhole ink nozzles in the print 
cartridge. 

8. ____ Failure of the high-voltage power supply (HVPS) is not the cause of a laser 
printer printing blank pages. 

9. ____ If there is toner inside the toner cartridge you will be able to hear it when it 
is shaken. 

10. ____ The corona wire (or roller) is an inexpensive part and can be easily 
replaced. 

11. ____ Because the drum is grounded, it has no charge and nothing with a charge 
(like toner) will stick to it. 

12. ____ Toner spilled inside the printer or by a crack or chip in the EP drum may 
cause repetitive marks. 

13. ____ Foreign matter caught on the transfer corona wire causes vertical white 
lines running down the printed page. 

14. ____ Image smudging is caused by a fuser problem. 
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Worksheet 13.3.4:  Troubleshooting Hardware  

1. What is a Field Replaceable Unit (FRU)? 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

2. What is POST used for? 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

3. Describe what Beep Codes indicate: 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

4. Explain one main reason for a CPU failure: 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

5. What is the first place you should check when troubleshooting memory? 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

6. How can you tell if you have a motherboard problem? 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 
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7. List two types of video problems: 

_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

8. The first three steps when diagnosing any disk drive problems are:  

a. Check the _______ cable. 

b. Check the  _______ cable. 

c. Check the device _______. 

9. Most sound card problems are __________________ conflicts. 
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Worksheet 14.4.5:  Troubleshooting Software 

Match each term with its description 

____ 1. Clean Boot a.  A file that has a list of DOS statements that are executed 
when the computer is first started 

____ 2. Patch b.  An error that occurs when two programs that are running at 
the same time try to use the same area in memory 

____ 3. Boot Disk c.  Software that is still in the initial phase of testing within the 
software production house 

____ 4. CONFIG.SYS d.  A diagnostic state of Windows that allows you to fix 
problems that prevents you from starting Windows normally 

____ 5. AUTOEXEC.BAT e. Software used to “quick-fix” a bug in a program 

____ 6. REM f.  Memory and hard drive space used by Windows 

____ 7. Safe Mode g.  A disk containing a rudimentary operating system used to 
start a computer 

____ 8. Registry h.  A way of starting a computer with a minimal set of drivers 
and programs 

____ 9. Device Manager i.  The second release of a program intended for the public to 
test 

____ 10. Resources j.  A file that contains statements for loading memory drivers 
and that tells the operating system where key DOS files are 
located 

____ 11. GPF k.  A command used to make remarks in DOS startup files 

____ 12. Beta Release l.  Files that contain information about user settings and 
configuration information for applications 

____ 13. Alpha Release m. A part of Windows that provides you with a visual 
presentation of physical devices that are used in your 
system 

 

 


	Labs
	Lab 1.3.8:  Getting to Know Windows
	Lab 1.5.3:  Boolean Operations
	Lab 1.5.9:  Converting Numbers Overview
	Lab 2.3.6:  Motherboard Identification
	Lab 2.3.8:  Identifying ROM and BIOS Chips
	Lab 2.3.9:  Identifying Computer Expansion Slots
	Lab 2.4.2:  Identifying RAM and RAM Sockets
	Lab 2.5.2:  Video Card Identification
	Lab 3.3.4:  The Computer Case and Power Supply
	Lab 3.5.3:  Motherboard Installation
	Lab 3.6.4:  Floppy Drive, Hard Drive, DVD, and CD-ROM Instal
	Lab 3.7.1:  Video Card Installation and System Booting
	Lab 4.2.3:  Basic DOS Commands
	Lab 4.2.4:  Creating a DOS Boot Disk
	Lab 5.1.6:  Changing File Views in Windows (showing file ext
	Lab 5.1.7:  Text Editing and File Management
	Lab 5.4.2:  Hard Drive Preparation Using FDISK and FORMAT
	Lab 5.5.5:  Windows OS Installation
	Lab 5.6.1:  Troubleshooting 101
	Lab 5.6.4:  Installing a Driver
	Lab 5.6.5:  Create a Startup Disk
	Lab 6.2.1a:  Creating Users Accounts in Windows 2000
	Lab 6.2.1b:  Assigning Permissions in Windows 2000
	Lab 6.2.4:  Creating an Emergency Repair Disk in Windows 200
	Lab 6.4.3:  Installation Demonstration of Windows 2000
	Lab 7.3.2:  Installation Demonstration of Windows XP
	Lab 7.5.2:  Using Simple File Sharing to Share Files
	Lab 7.5.3a:  Remote Desktop Connection
	Lab 7.5.3b:  Internet Connection Firewall
	Lab 7.5.5:  Using the Windows XP Start Menu and Windows Expl
	Lab 8.2.3:  Upgrading the Video Accelerator
	Lab 8.3.4:  Sound Card Installation
	Lab 9.1.2:  Basic Disk to Dynamic Disk Conversion
	Lab 10.3.1:  NIC Installation
	Lab 10.3.3:  Configuring the NIC to Work with a DHCP Server
	Lab 10.7.2:  Troubleshooting a NIC Using the Ping Command
	Lab 11.3.7:  Adding an Inkjet Printer to a Computer
	Lab 11.4.4:  Setting Up Print Sharing Capabilities
	Lab 11.5.4:  Managing Files in a Printer Queue
	Lab 12.1.2:  Using a Digital Multimeter
	Lab 12.3.5:  Cleaning Computer Components
	Lab 12.4.1:  Using the Scandisk and Defrag Utilities
	Lab 13.1.7:  The Steps of the Troubleshooting Cycle
	Lab 13.2.2:  Identifying POST Errors
	Lab 14.7.4:  Booting into Safe Mode
	Lab 14.7.5:  Using the Windows 2000 Recovery Console
	Lab 14.10.3:  Windows Registry Backup and Recovery
	Worksheets
	Worksheet 1.3.8:  Windows Navigation and Settings
	Worksheet 1.5.9:  Number Systems Exercises
	Worksheet 1.6.6:  Lab Safety Checklist
	Worksheet 2.3.2:  PC Power Supply
	Worksheet 2.3.8:  BIOS/ROM
	Worksheet 2.3.9:  Expansion Slots
	Worksheet 2.4.2:  RAM and RAM Sockets
	Worksheet 2.5.2:  Video Cards
	Worksheet 2.7.1:  Floppy Drive
	Worksheet 2.7.2:  Hard Drive Identification
	Worksheet 2.7.3:  CD-ROM Identification
	Worksheet 3.3.4:  Power Supplies
	Worksheet 3.9.1:  What is BIOS?
	Worksheet 4.1.3:  Operating System Fundamentals
	Worksheet 4.2.3: DOS Commands
	Worksheet 4.2.7:  DOS
	Worksheet 5.1.10:  Windows Files and Folders
	Worksheet 5.2.2:  Managing Printers
	Worksheet 5.4.2:  Preparing the Hard Drive
	Worksheet 5.6.6:  Troubleshooting Windows Installation
	Worksheet 8.1.6:  Multimedia Devices
	Worksheet 8.2.5:  Video Accelerators
	Worksheet 8.3.3:  Sound Cards
	Worksheet 8.4.7:  CD and DVD Terminology
	Worksheet 9.1.4:  RAID
	Worksheet 9.4.3:  Adding Processors
	Worksheet 10.2.5:  Types of Networks
	Worksheet 10.4.2:  Network Topology
	Worksheet 10.6.5:  OSI Model, TCP/IP, Protocols
	Worksheet 10.8.7:  Connecting to the Internet
	Worksheet 11.6.1:  Paper Jams
	Worksheet 12.1.4:  Environmental Considerations
	Worksheet 12.2.1:  Electrostatic Discharge (ESD)
	Worksheet 12.3.5:  Preventive Maintenance for Components
	Worksheet 13.1.2:  Troubleshooting Basics
	Worksheet 13.3.2:  Troubleshooting Printers
	Worksheet 13.3.4:  Troubleshooting Hardware
	Worksheet 14.4.5:  Troubleshooting Software

